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Εισαγωγή στο FrontPage 

Τι Μπορείτε και Τι ∆εν Μπορείτε να Κάνετε Κατά τη Σχεδίαση Ιστοσελίδων 
 

Όταν σχεδιάζετε την τοποθεσία σας στο Web, θα πρέπει να λαµβάνετε υπόψη το γεγονός ότι έχετε στη 

διάθεση σας δύο περίπου δευτερόλεπτα για να προσελκύσετε την προσοχή των αναγνωστών. Αυτό είναι κοινό 

µυστικό στον της κατασκευής ιστοσελίδων. ∆εν πρόκειται να χάσετε εάν ακολουθήσετε τις υποδείξεις που 

παρουσιάζονται στη συνέχεια για τη σχεδίαση ελκυστικών και εύχρηστων ιστοσελίδων: 

 

• Κάντε τον τίτλο σύντοµο, περιγραφικό και ακριβή, µε διατύπωση παρόµοια µε αυτή των σλόγκαν.  

• Στην κορυφή της σελίδας σας θα πρέπει να παρέχετε ορισµένα στοιχεία σχετικά µε το περιεχόµενο της- 

µην περιµένετε ότι οι επισκέπτες της θα έχουν τον χρόνο - ή τη διάθεση - να τη διαβάσουν από την αρχή 

µέχρι το τέλος. 

• Εάν η ιστοσελίδα σας είναι µεγαλύτερη από τρεις "σελίδες οθόνης", χωρίστε την σε περισσότερες από µια 

ιστοσελίδες. 

• Η αίσθηση της ισορροπίας είναι σηµαντική· µην αφήσετε τη σχεδίαση της σελίδας σας να γίνει 

ασύµµετρη. Εξισορροπήστε τον κενό χώρο, τις µεγάλες και µικρές εικόνες, τα διαφορετικά σχήµατα και τις 

ενότητες κειµένου για να προσδώσετε µεγαλύτερο ενδιαφέρον και οπτική ποικιλία στη σελίδα σας. 

• ∆ε θεωρείται σωστό το να παραφορτώνετε τη σελίδα σας µε πλεονάζοντα, άχρηστα συνήθως στοιχεία. 

• χρησιµοποιήστε χρώµατα για το κείµενο και τους δεσµούς τα οποία θα εναρµονίζονται µε το φόντο. 

• ∆ιασφαλίστε ότι οποιοδήποτε αντικείµενο δείχνει σαν κουµπί, συµπεριφέρεται κιόλας σαν τέτοιο. 

• Μην δηµιουργήσετε δυο δεσµούς µε το ίδιο όνοµα για τη µετάβαση σε δύο διαφορετικά µέρη, ή δύο 

δεσµούς µε διαφορετικά ονόµατα για τη µετάβαση στο ίδιο µέρος. Επίσης, θα πρέπει να παρέχετε στους 

επισκέπτες σας έναν τρόπο για να επιστρέφουν από έναν σύνδεσµο που ακολούθησαν στην προηγούµενη 

σελίδα, εάν ο σύνδεσµος αυτός οδηγεί σε κάποιο άλλο σηµείο της τοποθεσίας σας. 

• Οι σύνδεσµοί σας θα πρέπει να είναι περιγραφικοί- αποφύγετε το γενικευµένο κείµενο του στυλ "Κάντε 

Κλικ Εδώ!", το οποίο δεν κατατοπίζει σε τίποτα τον αναγνώστη. 

• Χρησιµοποιήστε εικόνες µε σωστό σχήµα συµπίεσης. 

• Χρησιµοποιήστε µικρογραφίες εικόνων σαν συνδέσµους προς τη µεγαλύτερη έκδοση των εικόνων. 

• Να θυµάστε ότι οι άνθρωποι θα προσπελάζουν τις ιστοσελίδες σας χρησιµοποιώντας διαφορετικές 

εφαρµογές browser, µε διαφορετικές δυνατότητες. 

• Κρατήστε τα ονόµατα αρχείων µικρά και οµοιόµορφα. 

• Πληροφορήστε τους επισκέπτες για το µέγεθος οποιωνδήποτε αρχείων περιλαµβάνετε στην τοποθεσία 

σας, έτσι ώστε να µπορούν να αποφασίσουν εάν θα τα µεταφέρουν στους υπολογιστές τους ή όχι. 

 

 

• Ζητήστε άδεια πριν χρησιµοποιήσετε κείµενο ή εικόνες οι οποίες έχουν δηµιουργηθεί από κάποιον άλλο. 
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• ∆ηµιουργήστε έναν σύνδεσµο προς τη διεύθυνση ηλεκτρονικού ταχυδροµείου του επόπτη (Webmaster) 

του διακοµιστή στον οποίο στεγάζεται η τοποθεσία σας. 

 

Ακολουθώντας τις παραπάνω υποδείξεις θα κάνετε µια πάρα πολύ καλή αρχή. Στη συνέχεια θα εξετάσουµε 

ορισµένα επιτυχηµένα δείγµατα τοποθεσιών και Ιστοσελίδων. 

 

Σύντοµη Ξενάγηση σε Επιτυχηµένες Ιστοσελίδες 
 

Ο καλύτερος τρόπος για να πάρετε ιδέες και για να δηµιουργήσετε µια επιτυχηµένη ιστοσελίδα είναι 

µελετώντας υπάρχοντα παραδείγµατα. Για τον λόγο αυτό θα ολοκληρώσουµε το παρόν κεφάλαιο ρίχνοντας µια 

µατιά σε ορισµένες ιδιαίτερα καλοσχεδιασµένες ιστοσελίδες, προσπαθώντας να επισηµάνουµε τι είναι αυτό 

που τις κάνει τόσο ξεχωριστές. Οι περισσότερες από τις ιστοσελίδες που επιλέξαµε χρησιµοποιούν σχετικά 

απλό HTML κώδικα για να επιτύχουν πραγµατικά εντυπωσιακά αποτελέσµατα. Έχουµε επίσης συµπεριλάβει 

ορισµένες σελίδες οι οποίες χρησιµοποιούν πιο πολύπλοκα και δύσκολα εφέ - πίνακες, πλαίσια και φόρµες 

(στοιχεία τα οποία καλύπτονται στο δεύτερο µέρος αυτού του βιβλίου) - για να σας δώσουµε µια γεύση του τι 

θα πρέπει να περιµένετε στο µέλλον. 
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 Σ' αυτό το κεφάλαιο θα ξεκινήσουµε εξετάζοντας το Frontpage µέσα στο µεγαλύτερο σκηνικό της 

διαδικασίας δηµοσίευσης υλικού (ή περιεχοµένου, όπως συνηθίζεται να λέγεται) στο Web. Κατ' αρχήν θα σας 

παρουσιάσουµε τα βασικά στοιχεία του Frontpage. Κατόπιν θα επικεντρωθούµε στο θέµα της δηµιουργίας 

τοποθεσιών (sites) στο Web 

Πολλοί χρήστες αντιµετωπίζουν το Web σαν ένα τεράστιο, αχανή χώρο, και η δηµοσίευση µιας τοποθεσίας 

στο Web µπορεί να φαίνεται εκφοβιστική εργασία. Φυσικά, το Web δεν είναι χώρος µε την πραγµατική έννοια 

του όρου· στην πραγµατικότητα δεν είναι τίποτα περισσότερο από τεράστια ποσά πληροφοριών οι οποίες είναι 

αποθηκευµένες σε υπολογιστές - τους αποκαλούµενους διακοµιστές του Web (Web servers). Όλοι αυτοί οι 

υπολογιστές είναι συνδεδεµένοι µεταξύ τους µέσω τηλεφωνικών γραµµών και άλλων µορφών σύνδεσης. Όταν 

"σερφάρετε" (surf) στο Web χρησιµοποιώντας µία εφαρµογή εξερεύνησης του Web - ή εφαρµογή ανάγνωσης 

Ιστοσελίδων όπως λέγεται συνήθως (Web browser) - όπως για παράδειγµα το Netscape Navigator ή τον 

Internet Explorer της Microsoft, µπορείτε να προσπελάζετε όλα τα αρχεία που είναι αποθηκευµένα σ' αυτούς 

τους υπολογιστές-διακοµιστές. 

 

Τα Βασικά των Ιστοσελίδων 

 
Τα µεµονωµένα αρχεία που προσπελάζετε µε την εφαρµογή browser που χρησιµοποιείτε αποκαλούνται 

σελίδες του Web, ή ιστοσελίδες. Οι ιστοσελίδες περιέχουν το κείµενο, τις εικόνες και τα άλλα στοιχεία που 

βλέπετε όταν εξερευνάτε το Web. Μία τοποθεσία του Web (Web site) είναι απλά µία συλλογή 

διασυνδεδεµένων Ιστοσελίδων οι οποίες περιέχουν σχετιζόµενες πληροφορίες. 

Το πρώτο σας βήµα για τη δηµιουργία µιας δικής σας τοποθεσίας στο Web είναι η δηµιουργία µιας ή 

περισσότερων Ιστοσελίδων. Εάν έχετε ακολουθήσει τις γενικές οδηγίες που αναφέραµε στο προηγούµενο 

κεφάλαιο για τον αρχικό σχεδιασµό, την οργάνωση, και την επίτευξη οµοιόµορφης "εµφάνισης και αίσθησης" 

για την τοποθεσία σας, θα πρέπει τώρα να είστε έτοιµοι να πιάσετε δουλειά! 

Είναι σηµαντικό να θυµάστε ότι µέχρι πρόσφατα η δηµιουργία Ιστοσελίδων για το Web ήταν µία εργασία 

την οποία µπορούσαν να διεκπεραιώσουν αποκλειστικά και µόνο άτοµα τα οποία είχαν πολλές τεχνικές 

γνώσεις. Γιατί; Επειδή κάτω από τις γεµάτες µε κείµενο και εικόνες σελίδες που βλέπετε στην οθόνη σας 

κρύβεται το θεµελιώδες σύστηµα που υποστηρίζει κάθε ιστοσελίδα: η Γλώσσα Χαρακτηρισµού Υπερκειµένου 

(Hypertext Markup Language), ή HTML, όπως συνηθίζουµε να την αποκαλούµε. 
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Η HTML χρησιµοποιεί ειδικούς κωδικούς, τα επονοµαζόµενα tags (χαρακτηρισµοί), οι οποίοι ορίζουν πώς 

θα δείχνουν οι ιστοσελίδες και επιτρέπουν στις εφαρµογές browser να τις διερµηνεύουν έτσι ώστε να τις 

βλέπετε εσείς µε το ωραίο κείµενο και τα γραφικά τους στην οθόνη σας. Για παράδειγµα, ένα tag της HTML, 

το <Β>, δηµιουργεί κείµενο µε έντονη γραφή, ενώ ένα άλλο tag της HTML, το <IMG>, εισάγει µία εικόνα σε 

µία σελίδα. Όταν εµφανίζετε µία ιστοσελίδα στο παράθυρο µιας εφαρµογής browser, η εφαρµογή µεταφράζει 

τα tags της HTML (Εικόνα 2.1) σε ελκυστικές, καλοσχεδιασµένες σελίδες (όπως βλέπετε στην Εικόνα 2.2). 

Στο απλούστερο επίπεδο της, η HTML δεν είναι δύσκολη στην εκµάθηση, αλλά η βαθιά γνώση της 

γλώσσας και η επιδεξιότητα στη χρήση της θα απαιτήσει αρκετό καιρό. Όπως ξέρουµε όλοι, ο χρόνος είναι ένα 

αγαθό που σχεδόν ποτέ δε µας περισσεύει, κυρίως όταν αντιµετωπίζουµε σηµαντικά έργα τα οποία πρέπει να 

ολοκληρωθούν µέχρι το τέλος της ηµέρας. 

Για τον λόγο αυτό, πολλοί άνθρωποι αποθαρρύνονται από την ιδέα της εκµάθησης της HTML, και 

αντ'αυτής βασίζονται σε άλλους ανθρώπους για τη δηµιουργία των Ιστοσελίδων τους. 

Εάν αφιερώσατε χρόνο για το προκαταρκτικό σχεδιασµό της τοποθεσίας σας, αναµφισβήτητα θα θέλετε να 

δείτε πώς θ' αρχίσει να παίρνει σχήµα και µορφή. ∆εν χρειάζεται να προσλάβετε κάποιον επαγγελµατία του 

χώρου, επειδή το Frontpage µπορεί να σας βοηθήσει να κατασκευάσετε τη δική σας τοποθεσία στο Web µε 

µεγάλη ευκολία, ακόµη κι αν δε γνωρίζετε τίποτα για την HTML. 
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ΕΙΚΟΝΑ 2.1 

Πίσω από κάθε ιστοσελίδα κρύβεται ο "σκελετός" του Web:η γλώσσα HTML. 

 

 Ο λόγος γι' αυτό είναι απλός: η HTML σας παρέχει αυξηµένο επίπεδο ελέγχου και µεγαλύτερες δυνα-

τότητες αντιµετώπισης προβληµάτων, πράγµα το οποίο θα µπορείτε να κάνετε πολύ καλύτερα εάν ξέρετε πώς 

να προσπελάζετε τα παρασκήνια για να διορθώνετε τα πιθανά προβλήµατα. 

 

 

Τι Είναι το Frontpage; 

 
Υπάρχει λοιπόν το Web, το οποίο είναι γεµάτο µε τοποθεσίες, οι οποίες απαρτίζονται από ιστοσελίδες, οι 

οποίες µε τη σειρά τους δηµιουργούνται µε τη γλώσσα HTML. Πώς συνδέεται το Frontpage µε όλα αυτά; To 

Frontpage είναι ένα τυπικό παράδειγµα µιας νέας γενιάς εφαρµογών, οι οποίες συλλογικά αποκαλούνται 

"εφαρµογές συγγραφής ή δηµοσίευσης περιεχοµένου στο Web". Οι εφαρµογές δηµοσίευσης περιεχοµένου στο 

Web καθιστούν προσιτή σε όλους τους χρήστες τη διαδικασία δηµιουργίας τοποθεσιών στο Web - 

συµπεριλαµβανοµένων και των χρηστών που δε θέλουν (ή δεν έχουν τον χρόνο) να µάθουν τη γλώσσα HTML. 

To Frontpage σας δίνει τη δυνατότητα να δηµιουργείτε ιστοσελίδες χρησιµοποιώντας ένα οικείο και φιλικό 

σύστηµα επικοινωνίας, παρόµοιο µε αυτό των επεξεργαστών κειµένου: Προσθέτετε και µορφοποιείτε το 

κείµενο, τις εικόνες και το άλλο περιεχόµενο που θέλετε να έχει η ιστοσελίδα σας χρησιµοποιώντας τις εντολές 

των µενού και τα κουµπιά των γραµµών εργαλείων στο παρασκήνιο, το Frontpage παράγει τα αντίστοιχα tags 

της HTML. Αυτή η µέθοδος είναι γνωστή µε τον χαρακτηρισµό WYSIWYG (αυτό είναι το ακρωνύµιο της 

φράσης "What-You-See-ls-What-You-Get", η οποία, σε ελεύθερη απόδοση, σηµαίνει "αυτό που βλέπετε είναι 

αυτό που παίρνετε"). To Frontpage δε σας βοηθά απλώς στη δηµιουργία Ιστοσελίδων σας βοηθά να συντηρείτε 

αποτελεσµατικά τη διαρκώς µεταβαλλόµενη δοµή και το περιεχόµενο της τοποθεσίας σας, σαν σύνολο. 

Μία από τις συναρπαστικές προσθήκες στην έκδοση 2000 του Frontpage, σε σύγκριση µε τις προγενέστερες 

εκδόσεις του προγράµµατος, είναι η δυνατότητα που σας επιτρέπει να έχετε άµεσα στη διάθεση σας όλη την 

ισχύ ενός WYSIWYG συντάκτη της HTML, σε συνδυασµό µε απόλυτο έλεγχο πάνω στις ανάγκες 

επεξεργασίας του περιεχοµένου των Ιστοσελίδων. Αυτό σηµαίνει ότι µπορείτε να µεταβαίνετε στην προβολή 

HTML του προγράµµατος και να κάνετε οποιεσδήποτε αλλαγές θέλετε στον HTML κώδικα µιας σελίδας. Στο 

παρελθόν, το Frontpage θα έκανε τις δικές του αλλαγές στις τροποποιήσεις σας· τώρα ο έλεγχος βρίσκεται 

µόνο στα χέρια σας. Η έκδοση 2000 του Frontpage περιλαµβάνει και άλλες φανταστικές λειτουργίες, οι οποίες 
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καθιστούν το Frontpage 2000 ένα από τα καλύτερα προγράµµατα τόσο για τους αρχάριους, όσο και για τους 

έµπειρους χρήστες, θα εξετάσουµε τις λειτουργίες αυτές σ' αυτό και στα επόµενα κεφάλαια του βιβλίου. 

 

 

 

Ένα Εργαλείο ∆ηµιουργίας Τοποθεσιών στο Web 

 
Μπορείτε να χρησιµοποιείτε το Frontpage για να δηµιουργείτε πολλά είδη τοποθεσιών στο Web, 

συµπεριλαµβανοµένων των: 

 

Προσωπική Τοποθεσία στο Web Ένας εξαιρετικά δηµοφιλής τύπος "δηµόσιας χρήσης" τοποθεσίας του 

Internet, η προσωπική τοποθεσία στο Web (Personal Web Site) είναι κάτι το οποίο µπορείτε να 

εκµεταλλευτείτε και να απολαύσετε άµεσα. Μία προσωπική τοποθεσία στο Web µπορεί να περιλαµβάνει 

πληροφορίες για τα ενδιαφέροντα σας, τους φίλους σας και την οικογένεια σας, καθώς και συνδέσµους προς 

άλλες τοποθεσίες του Web. Μπορείτε να γίνετε όσο δηµιουργικοί θέλετε! Μία προσωπική τοποθεσία στο Web 

είναι ένα πειραµατικό έδαφος, πάνω στο οποίο κάνουν τα πρώτα βήµατα τους πολλοί µελλοντικοί 

επαγγελµατίες του Web. To Frontpage µπορεί να σας βοηθήσει να δηµιουργήσετε µία θαυµάσια προσωπική 

τοποθεσία - είναι γρήγορο και φιλικό για τον χρήστη, πράγµα το οποίο το καθιστά ιδανική επιλογή γι' αυτές τις 

µικρές µεν, αλλά οπωσδήποτε ενδιαφέρουσες τοποθεσίες. 

 

Μία Τοποθεσία για µία Μικρή Επιχείρηση Εάν έχετε µία µικρή επιχείρηση µε περιορισµένο 

προϋπολογισµό για τη διαφήµιση, µία τοποθεσία στο Web είναι συχνά ένας θαυµάσιος τρόπος για να 

διαφηµίσετε το προϊόν ή τις υπηρεσίες σας σε µεγάλο αριθµό ανθρώπων. To Frontpage µπορεί να σας 

βοηθήσει να δηµιουργήσετε µία τοποθεσία στο Web για τη µικρή επιχείρηση σας. ∆ιαθέτει θαυµάσια πρότυπα 

τα οποία µπορούν να σας βοηθήσουν να στήσετε ένα "εικονικό κατάστηµα" χωρίς να χρειάζεται να ξοδέψετε 

πολύ χρόνο για να µάθετε τεχνικές και' τεχνολογίες. 

 

Μία Εταιρική Τοποθεσία στο Web Οι µεγαλύτερες εταιρείες χρειάζονται "δηµόσιας χρήσης" τοποθεσίες 

στο Internet, µέσω των οποίων θα µπορούν να παρέχουν πληροφορίες για τα προϊόντα τους, υποστήριξη στους 

πελάτες τους, πληροφορίες για τις σχέσεις τους µε τους καταναλωτές, ή ακόµη και δυνατότητα online αγορών. 

To Frontpage είναι ιδιαίτερα χρήσιµο σε µία τέτοια εταιρεία επειδή διαθέτει ισχυρές λειτουργίες 

παρακολούθησης/καταγραφής, επιτρέποντας σε περισσότερα από ένα άτοµα να κάνουν αλλαγές και 

ενηµερώσεις στις ιστοσελίδες της τοποθεσίας. Επιπλέον, η συµβατότητα και η καλή επικοινωνία του Frontpage 

µε άλλα προϊόντα λογισµικού το καθιστούν ένα εξαιρετικά ισχυρό εργαλείο για τους επαγγελµατίες. 
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Ένα Εταιρικό ∆ίκτυο σε Μορφή Ιστού (δίκτυο Intranet) Ένα intranet είναι ένα δίκτυο το οποίο 

"στήνεται" σε µία εταιρεία για την κάλυψη των εσωτερικών της αναγκών και βασίζεται στην ίδια ακριβώς 

τεχνολογία µε το Internet. Ένα δίκτυο intranet λειτουργεί παρόµοια µε το Web, εκτός από το γεγονός ότι είναι 

διαθέσιµο µόνο στους χρήστες που µπορούν να το προσπελάζουν. Επειδή ένα δίκτυο intranet είναι εκ φύσεως 

προστατευµένο από τους διάφορους περίεργους που σερφάρουν στο Web, οι εµπιστευτικές πληροφορίες της 

εταιρείας στην οποία εγκαθίσταται (π .χ. στοιχεία πωλήσεων, στοιχεία ανθρώπινων πόρων, κ.λ.π.) µπορούν να 

διακινούνται σε όλο το εύρος της εταιρείας µε σχετική ασφάλεια. To Frontpage διαθέτει εργαλεία τα οποία σας 

επιτρέπουν να δηµιουργείτε τοποθεσίες ιστού σε δίκτυα intranet, όπως θα δείτε παρακάτω και σε επόµενα 

κεφάλαια. 

 

To Frontpage Ευνοεί τη Συνεργασία 
 

To Frontpage µπορεί να διεκπεραιώσει µε επιτυχία τόσο τις µικρές, όσο και τις µεγάλες και πολύπλοκες 

εργασίες που του αναθέτετε επειδή διαιρεί κάθε εργασία στα συστατικά της µέρη. Και το σηµαντικότερο είναι 

ότι το Frontpage δε σας παρέχει απλά και µόνο τα δικά του εργαλεία· µπορείτε να το χρησιµοποιείτε σε 

συνεργασία µε µία ποικιλία άλλων εφαρµογών της Microsoft, συµπεριλαµβανοµένων των ακόλουθων: 

 

Microsoft Office 2000 To Frontpage 2000 µοιράζεται ορισµένα µενού και γραµµές εργαλείων µε τις 

υπόλοιπες εφαρµογές του Office, πράγµα το οποίο επιτρέπει την υποστήριξη και την απρόσκοπτη ενοποίηση 

πολλών εγγράφων του Office, συµπεριλαµβανοµένων των εγγράφων που δηµιουργήτε  στο Word, στο Excel 

και στο PowerPoint. Επιπλέον, οι χρήστες των εφαρµογών του Office µπορούν να εξάγουν τη δουλειά τους από 

τις εφαρµογές αυτές σε έναν ιστό (web) του Frontpage. 

 

Visual Studio και Visual Source Safe (VSS) To Visual Studio είναι ένα πακέτο εργαλείων λογισµικού για 

τους επαγγελµατίες που ασχολούνται µε την ανάπτυξη εφαρµογών διαχείρισης βάσεων δεδοµένων και 

εφαρµογών για περιβάλλοντα δικτύου. To VSS επιτρέπει σε πολλαπλούς χρήστες να διαχειρίζονται µεγάλες 

τοποθεσίες του Web, µε πολλά αρχεία. To VSS παρέχει επίσης δυνατότητες χαρακτηρισµού των σελίδων µε 

ηµεροµηνία, ώρα και όνοµα για σκοπούς παρακολούθησης. 

 

Visual Interdev To Visual Interdev είναι ένα εξαιρετικά ισχυρό εργαλείο λογισµικού για την ανάπτυξη 

εφαρµογών βάσεων δεδοµένων, το οποίο χρησιµοποιείται συχνά σαν "πυρήνας" σε τεχνολογικά εξελιγµένες 

τοποθεσίες του Web. Οι επαγγελµατίες που ασχολούνται µε την ανάπτυξη εξαιρετικά προηγµένων εφαρµογών 
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χρησιµοποιούν το Visual Interdev για τη διαχείριση των τοποθεσιών τους, ενσωµατώνοντας σ' αυτές 

"παρασκηνιακές" λειτουργίες διεξαγωγής αναζητήσεων, διαλογικής επικοινωνίας µε τον χρήστη, και εκτέλεσης 

script αρχείων. 

 

PhotoDraw Μπορείτε να χρησιµοποιείτε αυτό το νέο µέλος της οµάδας εφαρµογών του πακέτου Office σε 

συνεργασία µε το Frontpage 2000 για να δηµιουργείτε ελκυστικά γραφικά για το Web. θα µάθετε περισσότερα 

για το PhotoDraw στο Κεφάλαιο 9 αυτού του βιβλίου. 

 

Microsoft Internet Explorer Μπορείτε να χρησιµοποιείτε αυτή την ισχυρότατη εφαρµογή εξερεύνησης του 

Web/ανάγνωσης Ιστοσελίδων (browser) για να "σερφά-ρετε" στο Web και να εξετάζετε σε προεπισκόπηση την 

τοποθεσία που δηµιουργείτε πριν τη θέσετε στη διάθεση του κοινού. 

Η δυνατότητα του Frontpage 2000 να συνεργάζεται µε άλλα προγράµµατα είναι ένα από τα ισχυρότερα 

χαρακτηριστικά του. Αυτή η δυνατότητα απρόσκοπτης επικοινωνίας και συνεργασίας καθιστά το Frontpage 

κάτι περισσότερο από ένα εργαλείο παραγωγής HTML κώδικα ή δηµιουργίας τοποθεσιών του Web, 

προάγοντας το σε µία απόλυτα επαγγελµατική εφαρµογή - εάν αυτό χρειάζεστε. Αυτός ο συνδυασµός ευελιξίας 

και ισχύος είναι που κάνει το Frontpage 2000 τόσο ελκυστικό για µία ευρεία γκάµα ανθρώπων, τόσο ιδιωτών, 

όσο και επαγγελµατιών. 

 

Εισαγωγή στη ∆ηµιουργία Ιστοσελίδων µε το Frontpage 

 
Πιστεύουµε ότι ο καλύτερος τρόπος για να µάθετε ένα νέο πράγµα - ανεξάρτητα από το εάν πρόκειται για µία 

εφαρµογή λογισµικού ή οτιδήποτε άλλο - είναι η πράξη!. ∆εδοµένου ότι γνωρίζετε ήδη πώς λειτουργεί το Web 

και κατανοείτε πόσο ισχυρό  εργαλείο είναι το Frontpage, είστε έτοιµοι να προχωρήσετε στην πράξη. 

Στη συνέχεια θα ανοίξετε το Frontpage και θα ξεκινήσετε τη δηµιουργία µιας νέας τοποθεσίας για το Web.  

Στην πορεία θα γνωρίσετε το σύστηµα επικοινωνίας του Frontpage µε τον χρήστη και θα µάθετε πώς να 

προσθέτετε νέες σελίδες στην τοποθεσία σας, οποτεδήποτε θέλετε. 

 

Σε όλη την έκταση του βιβλίου θα αναφερόµαστε συχνά στις τοποθεσίες που δηµιουργείτε ή συντηρείτε µε 

το Frontpage χρησιµοποιώντας τον όρο ιστός (web) του Frontpage. Οι ιστοί του Frontpage είναι το ισοδύναµο 

των τοποθεσιών του Web σε ένα τοπικό σύστηµα υπολογιστή, δεδοµένου ότι αποτελούνται από ιστοσελίδες 

και γράφονται µε τη γλώσσα HTML. Ωστόσο, το Frontpage µπορεί να ξεχωρίζει τους δικούς του ιστούς από τις 

τοποθεσίες του Web που δηµιουργούνται µε άλλες εφαρµογές (ή γράφονται "µε το χέρι", χρησιµοποιώντας 

απλά και µόνο την HTML). To Frontpage κρύβει απλώς τις δυσκολίες της HTML πίσω από ένα εύχρηστο και 
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φιλικό σύστηµα επικοινωνίας µε τον χρήστη. Για να εκµεταλλευτείτε πλήρως τις ισχυρότατες λειτουργίες του 

Frontpage, µπορείτε να δηµιουργείτε ιστούς χρησιµοποιώντας το Frontpage ή να ενηµερώνετε/συντηρείτε 

υπάρχουσες τοποθεσίες του Web εισάγοντας τες (import) στο πρόγραµµα. 

 

Στο σηµείο αυτό είναι καιρός ν' αφήσουµε τη θεωρία και να ξεκινήσουµε τη δηµιουργία ενός νέου ιστού 

(web) στο Frontpage, θα κάνουµε τα πράγµατα εύκολα για εσάς, χρησιµοποιώντας ένα από τα 

προκατασκευασµένα πρότυπα (templates) που διαθέτει το Frontpage. 

 

Εκκίνηση του Frontpage 

 
Η εκκίνηση του Frontpage δεν διαφέρει από την εκκίνηση των περισσότερων άλλων Windows εφαρµογών. 

Για να ξεκινήσετε το Frontpage εύκολα και γρήγορα, από το µενού Start των Windows, επιλέξτε Programs > 

Microsoft Frontpage. To Frontpage θα ξεκινήσει και θα εµφανιστεί στην οθόνη σας (δείτε την Εικόνα 2.3). 

 

Εάν έχετε χρησιµοποιήσει προγενέστερες εκδόσεις του Frontpage, θα παρατηρήσετε κάτι αρκετά 

διαφορετικό εδώ - δεν υπάρχει αρχικό παράθυρο διαλόγου κατά το άνοιγµα της εφαρµογής! Αυτό οφείλεται 

στο γεγονός ότι το Frontpage 2000 ενσωµατώνει τις µονάδες Explorer και Editor του Frontpage 98. Ολόκληρο 

το σύστηµα επικοινωνίας της εφαρµογής µε τον χρήστη βασίζεται πλέον σε ένα κύριο παράθυρο επεξεργασίας, 

το οποίο είναι επίσης γνωστό σαν προβολή Σελίδας (Page view). Αυτό το νέο σύστηµα επικοινωνίας της 

εφαρµογής µε τον χρήστη διευκολύνει σηµαντικά τη χρήση του Frontpage, αλλά θα πρέπει να µάθετε τις νέες 

διαδικασίες εκκίνησης της εφαρµογής.  

 

Για τους αρχάριους χρήστες του Frontpage 2000, αυτό σηµαίνει ότι θα έχουν λίγα λιγότερα να µάθουν - και 

θα µπορέσουν να ξεκινήσουν τη δηµιουργία της πρώτης τοποθεσίας τους στο Web πολύ γρηγορότερα. Στις 

ακόλουθες ενότητες του κεφαλαίου θα σας καθοδηγήσουµε σε όλα όσα πρόκειται να δείτε στην οθόνη και θα 

σας εξηγήσουµε τις βασικές διαδικασίες διαχείρισης των ιστών, περιλαµβάνοντας αναφορές για τα πρότυπα, τη 

χρήση των οδηγών και τη δηµιουργία σελίδων "εκ του µηδενός". 
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ΕΙΚΟΝΑ 2.3 

(Το σύστηµα επικοινωνίας του Frontpage     µε τον χρήστη µετά    από την εκκίνηση της εφαρµογής.) 

 

Βοήθεια από TO Frontpage 

 

Για να ζητήσετε βοήθεια από το Frontpage, θα πρέπει να απευθυνθείτε στο σύστηµα Βοήθειας (Help) της 

εφαρµογής. Το σύστηµα Βοήθειας επεξηγεί τη λειτουργία των εντολών των µενού και των κουµπιών των 

γραµµών εργαλείων, ενώ σας παρέχει επίσης γενικές περιγραφές και βήµα προς βήµα οδηγίες για τις 

λειτουργίες του Frontpage. Για να προσπελάσετε το σύστηµα Βοήθειας του Frontpage, επιλέξτε Help > 

Microsoft Frontpage Help. Για να ζητήσετε βοήθεια σχετική µε την τρέχουσα εργασία σας, κάντε κλικ στο 

κουµπί Βοήθειας (Help) που είναι διαθέσιµο σε πολλά παράθυρα διαλόγου του Frontpage, ή πατήστε 

Shift+F11 και κατόπιν κάντε κλικ στο στοιχείο για το οποίο θέλετε να µάθετε περισσότερα. 
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∆ηµιουργία Τοποθεσίας µε Πρότυπα 

 
Εάν δεν είστε σίγουροι για το πώς πρέπει να ξεκινήσετε την κατασκευή της δικής σας τοποθεσίας στο Web, 

ή εάν χρειάζεστε µια ολοκληρωµένη τοποθεσία στο Web όσο το δυνατόν πιο γρήγορα, το Frontpage σας 

παρέχει άφθονη βοήθεια µε τη µορφή των προτύπων. Τα πρότυπα (templates) είναι προκατασκευασµένες 

σελίδες στις οποίες το µόνο που χρειάζεται να κάνετε εσείς είναι να προσθέσετε κείµενο (και, εάν θέλετε, να 

τροποποιήσετε τα γραφικά που περιέχουν). 

To Frontpage διαθέτει µία ποικιλία προτύπων για πολλές τυπικές κατηγορίες τοποθεσιών του Web: ένα 

πρότυπο για µία τοποθεσία υποστήριξης πελατών (Customer Support Web), ένα πρότυπο για µία προσωπική 

τοποθεσία (Personal Web), και ένα πρότυπο για µία τοποθεσία η οποία ασχολείται µε ένα έργο (Project Web). 

Υπάρχει επίσης ένα πρότυπο µε τίτλο One Page Web (µία σελίδα) το οποίο µπορείτε να χρησιµοποιείτε για να 

δηµιουργείτε µεµονωµένες ιστοσελίδες, καθώς και µία επιλογή για τη δηµιουργία ενός κενού ιστού (Empty 

Web) η οποία σας παρέχει πολύ περισσότερο έλεγχο πάνω στο περιεχόµενο των σελίδων του ιστού σας. 

Μπορείτε επίσης να δηµιουργήσετε δικά σας πρότυπα είτε τροποποιώντας τα υπάρχοντα, είτε δηµιουργώντας 

νέα πρότυπα εκ του µηδενός.  

Τα πρότυπα παράγουν µία συλλογή διασυνδεδεµένων σελίδων οι οποίες περιέχουν πλασµατικό, 

γενικευµένο κείµενο. Μπορείτε να προσαρµόσετε τις σελίδες αυτές ανάλογα µε το δικό σας περιεχόµενο και 

την επιθυµητή σχεδίαση. Για να δηµιουργήσετε έναν ιστό - µία τοποθεσία για το Web - χρησιµοποιώντας ένα 

προκατασκευασµένο πρότυπο, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Ξεκινήστε το Frontpage όπως περιγράψαµε στην προηγούµενη ενότητα. Από τη γραµµή των µενού 

επιλέξτε την εντολή File > New >· Web (δηµιουργία νέου ιστού).  
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ΕΙΚΟΝΑ 2.4 

Χρησιµοποιώντας τα µενού για τη δηµιουργία ενός νέου ιστού στο Frontpage 
 

2.      θα εµφανιστεί το παράθυρο διαλόγου New, το οποίο παρουσιάζει τα διαθέσιµα πρότυπα (Εικόνα 2.5). 

θα δείτε επίσης εικονίδια τα οποία αντιπροσωπεύουν αρκετούς οδηγούς (wizards), αλλά θα 

αναλύσουµε περισσότερο αυτό το θέµα παρακάτω. Για το παράδειγµα αυτής της ενότητας, το 

εικονίδιο Personal Web (ιστός προσωπικής τοποθεσίας) είναι µία καλή επιλογή. Το εικονίδιο αυτό θα 

σας επιτρέψει να δηµιουργήσετε έναν ιστό ειδικά σχεδιασµένο ώστε να δίνει έµφαση στα προσωπικά 

σας ενδιαφέροντα. 
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ΕΙΚΟΝΑ 2.5 

(Τα πρότυπα και οι οδηγοί στο παράθυρο διαλόγου New) 

 

 

3. Επιλέξτε το εικονίδιο Personal Web. Στη δεξιά πλευρά του παραθύρου διαλόγου θα σας ζητηθεί να 

καθορίσετε µια θέση για τον ιστό που δηµιουργείτε. Μπορείτε να αποδεχτείτε τη θέση που προτείνει το 

Frontpage, ή να δηµιουργήσετε έναν νέο φάκελο στον σκληρό σας δίσκο για την αποθήκευση όλων των 

αρχείων του νέου ιστού (δείτε την ακόλουθη υπόδειξη). 

 

 

4. Κάντε κλικ στο OK. To Frontpage θα δουλέψει µόνο του για λίγο και µπορεί να χρειαστεί ένα-δϋο λεπτά 

πριν σας ειδοποιήσει ότι ο νέος ιστός που δηµιουργείτε είναι έτοιµος. 
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Στην επόµενη ενότητα θα σας παρουσιάσουµε τις προβολές (views) του Frontpage, κάθε µία εκ των οποίων 

έχει σαν στόχο να σας βοηθά σε µία διαφορετική άποψη της διαδικασίας δηµιουργίας, διαχείρισης και 

συντήρησης τοποθεσιών. Για την ώρα εξετάστε απλώς την αριστερή περιοχή του παραθύρου επεξεργασίας, 

στην οποία εµφανίζεται µία λίστα των διάφορων προβολών που µπορείτε να χρησιµοποιείτε: Folders 

(φάκελοι), Reports (αναφορές), Navigation (πλοήγηση) και Hyperlinks (δεσµοί υπερκειµένου). Για 

παράδειγµα, επιλέξτε την καταχώριση Navigation για να δείτε µία ιεραρχική διάταξη του προσωπικού ιστού 

που δηµιουργείτε (Εικόνα 2.6). 

 

 

ΕΙΚΟΝΑ 2.6 

(Η προβολή πλοήγησης για την προσωπική τοποθεσία που δηµιουργείτε) 

 

Για να εµφανίσετε τη νέα σας σελίδα µπορείτε να µεταβείτε σε προβολή Φακέλων (Folders) και κατόπιν να 

κάνετε διπλό κλικ στο αρχείο µε όνοµα default.htm. Η σελίδα φορτώνεται στο κύριο παράθυρο του 

προγράµµατος (Εικόνα 2.7). 
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Παρατηρήστε ότι τα ονόµατα αρχείων που παράγει το Frontpage έχουν την επέκταση .htm αντί της πιο 

γνωστής επέκτασης .html. Επιπρόσθετα, το Frontpage δίνει στην αρχική σελίδα το όνοµα default.htm αντί για 

το πιο γνωστό index.html. Αυτή είναι απλώς µία ευκολία για το πρόγραµµα· όταν θα στείλετε πραγµατικά τα 

αρχεία στον διακοµιστή για να τα δηµοσιοποιήσετε, τα ονόµατα τους θα αλλάξουν αυτόµατα σε οποιαδήποτε 

ονόµατα είναι κατάλληλα για τον συγκεκριµένο διακοµιστή που χρησιµοποιείτε. 

 

 

ΕΙΚΟΝΑ 2,7 

(Μια νέα, έτοιµη για τροποποίηση ιστοσελίδα, η οποία βασίζεται στο προτυπο Personal Web) 

θα ασχοληθούµε πολύ περισσότερο µ' αυτό το θέµα σε επόµενα κεφάλαια. Για την ώρα θα µάθετε 

ορισµένους άλλους τρόπους µε τους οποίους µπορείτε να εµφανίζετε και να χρησιµοποιείτε τους ιστούς σας 

στο Frontpage 2000. 
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∆ηµιουργία Τοποθεσίας µε Οδηγούς 
To Frontpage διαθέτει οδηγούς (wizards) για δύο από τα πιο πολύπλοκα πρότυπα του - τα Corporate 

Presence Web (ιστός εταιρικής παρουσίας) και Discussion Web (ιστός τοποθεσίας συζητήσεων). Ένας οδηγός 

είναι ένα µικρό πρόγραµµα το οποίο λειτουργεί µέσα στο περιβάλλον του Frontpage και σας καθοδηγεί βήµα 

προς βήµα στη διαδικασία δηµιουργίας της τοποθεσίας που χρειάζεστε. Ο οδηγός Corporate Presence Web σας 

καθοδηγεί βήµα προς βήµα στη διαδικασία κατασκευής µιας ολόκληρης εταιρικής τοποθεσίας, απευθύνοντας 

σας ερωτήσεις για πράγµατα όπως το είδος των πληροφοριών που θέλετε να περιέχει η τοποθεσία. Αφού πείτε 

στον οδηγό τι ακριβώς θέλετε, ο οδηγός παράγει την τοποθεσία. Ο οδηγός Discussion Web δηµιουργεί µία 

οµάδα συζήτησης (discussion group) - µία τοποθεσία ιστού η οποία στεγάζει ένα φόρουµ για την επικοινωνία 

µεταξύ των χρηστών . Υπάρχει επίσης ο οδηγός Εισαγωγής Ιστών (Import Web Wizard), αλλά θα µιλήσουµε 

γι' αυτόν παρακάτω σ' αυτό το κεφάλαιο. 

 

Για να δηµιουργήσετε έναν ιστό (µια τοποθεσία για το Web) χρησιµοποιώντας έναν οδηγό, ακολουθήστε τα 

παρακάτω βήµατα: 

1. Ξεκινήστε το Frontpage όπως περιγράψαµε παραπάνω σ' αυτό το κεφαλαίο. 

Κατόπιν επιλέξτε την εντολή File >· New > Web. 

 

 2. Όταv εµφανιστεί τo παpάθυpo διαλόγου New επιλέξτε είτε τo εικovίδιo Corporate 

Presence Web Wizard, είτε το εικονίδιο Discussion Web Wizard. Κάντε κλικ στο ΟΚ. θα εµφανιστεί ο 

οδηγός δηµιουργίας του κατάλληλου ιστού (Εικόνα 2.8). 
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3. Αφού διαβάσετε την εισαγωγή του οδηγού, κάντε κλικ στο Next για να προχωρήσετε στο επόµενο 

παράθυρο, στο οποίο µπορείτε να καθορίσετε ποιες σελίδες θέλετε να συµπεριλάβετε στον ιστό που 

δηµιουργείτε. Μπορείτε να επιλέξετε όποιες σελίδες θέλετε µαρκάροντας ή ξεµαρκάροντας τις κατάλληλες 

περιγραφές σελίδων. Όταν ολοκληρώσετε αυτό το βήµα, κάντε κλικ στο Next. 

 

4. θα σας ζητηθεί ένας τίτλος (Title) για τον ιστό σας. Εισάγετε έναν περιγραφικό τίτλο - κάτι το οποίο θα 

σχετίζεται µε το θέµα του ιστού που δηµιουργείτε. 

 

5. Σε κάθε επόµενο παράθυρο του οδηγού, διαβάστε και ακολουθήστε τις οδηγίες που παρουσιάζονται. Για 

να προχωρήσετε στο επόµενο παράθυρο, κάντε κλικ στο Next. Για να οπισθοχωρήσετε σε ένα προηγούµενο 

παράθυρο, κάντε κλικ στο Back 

.                                                                        

6. Όταν φτάσετε στο τελευταίο παράθυρο του οδηγού, το κουµπί Next εµφανίζεται αµυδρό (µη-διαθεσιµο). 

Για να ολοκληρώσετε την δηµιουργία του ιστού, κάντε κλικ στο Finish. Ο οδηγός θα χρησιµοποιήσει τις 

πληροφορίες που του παρείχατε για να παράγει τον ιστό. 

Όταν ολοκληρωθεί η παραγωγή του ιστού, µπορείτε να τον ανοίξετε και να τον εξετάσετε σε προβολή 

Σελίδας επιλέγοντας το εικονίδιο Folders και κάνοντας κλικ στην καταχώριση του αρχείου default.htm  
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Αφού ο οδηγός δηµιουργήσει τον ιστό σας, µπορείτε να ανοίξετε τις σελίδες του ιστού για να καθορίσετε 

και να προσαρµόσετε το περιεχόµενο τους. 

 

∆ηµιουργία Νέας Σελίδας "Έκτου Μηδενός" 

 
Εάν δεν ξέρετε από πού ακριβώς πρέπει να ξεκινήσετε, ή εάν θέλετε να δείτε παραδείγµατα του τρόπου µε 

τον οποίο έχουν δηµιουργηθεί τυπικές τοποθεσίες του Web, τα πρότυπα και οι οδηγοί του Frontpage µπορούν 

να σας βοηθήσουν σηµαντικά. Ωστόσο, εάν έχετε έστω και την παραµικρή ιδέα σχετικά µε την εµφάνιση που 

θέλετε να έχουν οι ιστοσελίδες της τοποθεσίας σας, ίσως το βρείτε ευκολότερο να ξεκινήσετε την κατασκευή 

της τοποθεσίας σας "εκ του µηδενός", χωρίς την βοήθεια των οδηγών και των προτύπων. Σ' αυτή την 

περίπτωση µπορείτε να ξεκινήσετε µε µία κενή ιστοσελίδα, στην οποία θα προσθέσετε το περιεχόµενο σας. 

Στην συνέχεια µπορείτε να δηµιουργήσετε και άλλες νέες σελίδες, προσθέτοντας τες στον ίδιο ιστό και γεµίζο-

ντας τες σταδιακά µε περιεχόµενο, µέχρι να ολοκληρώσετε την τοποθεσία σας. (Τουλάχιστον στον βαθµό που 

µπορεί να θεωρηθεί ολοκληρωµένη µία τοποθεσία του Web - ένα από τα σηµαντικότερα και ελκυστικότερα 

χαρακτηριστικά του Web είναι το γεγονός ότι τα πάντα µεταβάλλονται διαρκώς. 

Για να δηµιουργήσετε µία σελίδα εκ του µηδενός, ανοίξτε απλώς το Frontpage. Βεβαιωθείτε ότι είναι 

επιλεγµένο το εικονίδιο Page (σελίδα) στην στήλη εικονιδίων Views (προβολές). Στην δεξιά περιοχή του 

παραθύρου, θα πρέπει να βλέπετε µία κενή σελίδα - τον άγραφο πίνακα πάνω στον οποίο θ' αρχίσετε την 

σχεδίαση της σελίδας σας. 

Προσθέστε κείµενο, γραφικά - οτιδήποτε θέλετε σ' αυτή την πρώτη σελίδα, θα επαναλάβω ξανά ότι η 

διαδικασία αυτή είναι καταλληλότερη για τους αναγνώστες οι οποίοι γνωρίζουν ήδη αρκετά πράγµατα έτσι 

ώστε να µπορούν να συναρµολογήσουν µία σελίδα. Εάν είστε αρχάριοι στο Frontpage και γενικότερα στον 

τοµέα της δηµιουργίας υλικού για το Web, ανατρέξτε στο Κεφάλαιο 4, στο οποίο ασχολούµαστε διεξοδικά µε 

την σχεδίαση Ιστοσελίδων. Αφού συναρµολογήσετε την σελίδα, επιλέξτε απλώς File >· Save As για να την 

αποθηκεύσετε στον επιθυµητό φάκελο µε το όνοµα default.htm. 

Μπορείτε τώρα να προσθέσετε και άλλες σελίδες στον ιστό της τοποθεσίας σας. Οι σελίδες που 

δηµιουργείτε θα πρέπει να βασίζονται στο πλάνο σας. Επαναλάβετε τη διαδικασία που περιγράψαµε παραπάνω 

σ' αυτή την ενότητα για να δηµιουργήσετε όλες τις σελίδες της τοποθεσίας σας. 

Μπορείτε επίσης να δηµιουργήσετε έναν δικό σας ιστό στο Frontpage, ξεκινώντας µε το πρότυπο Empty 

Web (κενός ιστός), αν και ελάχιστους λόγους θα έχετε για να χρησιµοποιήσετε αυτή την επιλογή όταν ξεκινάτε 

τη δηµιουργία σελίδων "εκ του µηδενός". Αυτό το πρότυπο δεσµεύει χώρο για έναν νέο ιστό, αλλά δεν περιέχει 

αρχικές σελίδες. 
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 Επειδή το πρώτο σας βήµα (προφανώς) θα είναι η προσθήκη µιας αρχικής σελίδας (home page) στον κενό 

ιστό, θα µπορούσατε κάλλιστα να χρησιµοποιήσετε αντ' αυτού το πρότυπο One Page Web. Ωστόσο, µπορεί να 

προτιµήσετε τη χρήση του προτύπου Empty Web δεδοµένου ότι παρέχει µία βολική θέση για την εισαγωγή 

υπαρχουσών Ιστοσελίδων. ∆είτε την ενότητα που ασχολείται µε την εισαγωγή υπαρχουσών Ιστοσελίδων 

παρακάτω σ' αυτό το κεφάλαιο. 

 

Εισαγωγή Υπάρχουσας Τοποθεσίας στο Frontpage 

 
Για να χρησιµοποιήσετε το Frontpage για την ενηµέρωση µιας υπάρχουσας τοποθεσίας! του Web, θα πρέπει 

πρώτα να εισάγετε την τοποθεσία αυτή στο Frontpage (µετασχηµατίζοντας τη σε έναν ιστό του Frontpage). 

Αυτό γίνεται χρησιµοποιώντας τον Οδηγό  Εισαγωγής (Import Web Wizard), ο οποίος µπορεί να εισάγει 

αρχεία τοποθεσιών του Web τα οποία είναι επί του παρόντος αποθηκευµένα στον υπολογιστή σας, στο τοπικό 

δίκτυο µε το οποίο συνδέεστε και/ ή στον παγκόσµιο ιστό του World Wide Web. 

 

Για να εισάγετε µία υπάρχουσα τοποθεσία στο Frontpage, ακολουθήστε τα παρακάτω βήµατα:                                 

 

1. Ξεκινήστε το Frontpage όπως περιγράψαµε στην πρώτη ενότητα αυτού του κεφαλαίου. Επιλέξτε την 

εντολή File >· New >- Web. 

 

2. Απο το παράθυρο διαλόγου που εµφανίζεται, επιλέξτε την καταχώριση Import Web Wizard. Κάντε κλικ 

στο ΟΚ. θα εµφανιστεί το παράθυρο του Οδηγού Εισαγωγής, το οποίο σας ζητά να καθορίσετε τη θέση της 

τοποθεσίας που θέλετε να εισάγετε (Εικόνα 2.10). 
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3. Σ' αυτό το παράθυρο διαλόγου καθορίστε την τρέχουσα θέση της τοποθεσίας που θέλετε να εισάγετε. Εάν 

η τοποθεσία είναι επί του παρόντος αποθηκευµένη σε έναν φάκελο στον δικό σας υπολογιστή, ή στο τοπικό 

δίκτυο σας, κάντε κλικ στο στρογγυλό κουµπί From A Source Directory Of Files On A Local Computer Or 

Network. Στο πεδίο location πληκτρολογήστε τη διαδροµή προς αυτό τον φάκελο η κάντε κλικ στο κουµπί 

Browse για να επιλέξετε έναν φάκελο από τη λίστα των φακέλων του υπολογιστή και του τοπικού δικτύου σας. 

Για να εισάγετε τα αρχεία που είναι αποθηκευµένα στους υποφακέλους της τοποθεσίας, µαρκάρετε το πλαίσιο 

ελέγχου include subfolders. Εαν  η τοποθεσία είναι διαθέσιµη στο World Wide Web, κάντε κλικ στο κουµπί 

From A World Wide Web Site και στο πεδίο Location πληκτρολογήστε τη διεύθυνση URL της τοποθεσίας. 

 

4. Κάντε κλικ στο Next. To παράθυρο διαλόγου που θα εµφανιστεί στη συνέχεια εξαρτάται από την 

τρέχουσα θέση των αρχείων της τοποθεσίας. Εάν η τοποθεσία είναι αποθηκευµένη στον υπολογιστή ή στο 

τοπικό δίκτυο σας, θα εµφανιστεί το παράθυρο διαλόγου Import Web Wizard - Edit File List. Εάν η τοποθεσία 

είναι αποθηκευµένη στο Web, θα εµφαvlστεί τo παpάθυpo διαλόγoυ lmport Web Wizard - Choose Download 

Amount. 

 

5. Στο παράθυρο διαλόγου Import Web Wizard - Edit File List, το πλαίσιο λίστας αναφέρει όλα τα αρχεία 

της τοποθεσίας που περιέχονται στη θέση την οποία καθορίσατε. Για να εξαιρέσετε ένα ή περισσότερα από 

αυτά τα αρχεία, κρατήστε πατηµένο το πλήκτρο Ctrl ενώ κάνετε κλικ στα ονόµατα των αρχείων και κατόπιν 
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κάντε κλικ στο κουµπί Exclude. Για να ξεκινήσετε από την αρχή µε µία πλήρη λίστα αρχείων, κάντε κλικ στο 

κουµπί Refresh. Εναλλακτικά, 

Στο παράθυρο διαλόγου Import Web Wizard - Choose Download Amount καθορίστε τις επιλογές 

µεταφοράς (download) που θέλετε να χρησιµοποιήσει ο οδηγός. Αυτό το παράθυρο διαλόγου σας επιτρέπει να 

ελέγξετε το πλήθος των επιπέδων (το βάθος των διαδοχικών υποφακέλων) που θέλετε να εισάγετε, καθώς και 

το συνολικό µέγεθος των εισαγόµενων αρχείων. Μπορείτε επίσης να ζητήσετε εισαγωγή µόνο των αρχείων των 

Ιστοσελίδων και των εικόνων της τοποθεσίας. 

 

6. Σε οποιοδήποτε από τα δύο παράθυρα διαλόγου, κάντε κλικ στο Next για να συνεχίσετε, θα εµφανιστεί το 

παράθυρο διαλόγου Import Web Wizard - Finish. 

 

7. Κάντε κλικ στο κουµπί Finish. Ο οδηγός εισάγει τα επιλεγµένα αρχεία στον νέο ιστό του Frontpage (αυτό 

µπορεί να απαιτήσει λίγο χρόνο, κυρίως εάν εισάγετε µία µεγάλη τοποθεσία). Όταν ολοκληρωθεί η διαδικασία 

εισαγωγής, ο οδηγός Εισαγωγής (Import Web Wizard) τερµατίζει τη λειτουργία του και µπορείτε πλέον να 

εξετάσετε τον ιστό χρησιµοποιώντας οποιαδήποτε από τις διαθέσιµες προβολές, όπως θα περιγράψουµε 

παρακάτω σ' αυτό το κεφάλαιο. 

Μπορείτε τώρα να χρησιµοποιήσετε το Frontpage για να ενηµερώσετε και να συντηρήσετε τον νέο ιστό. 

Όταν είστε έτοιµοι να ξεκινήσετε την εργασία σας µ' αυτό τον ιστό, ανατρέξτε στο Κεφάλαιο 3 για 

περισσότερες πληροφορίες. 

Σ ΠΛΗΡΟΦΟΡΙΕΣ 

Οι Προβολές του Frontpage 
 

Όπως ισχύει και στις περισσότερες άλλες µοντέρνες εφαρµογές, το Frontpage είναι σχεδιασµένο ώστε να 

χρησιµοποιεί µία στάνταρ, "κορυφαίου επιπέδου" γραµµή εργαλείων πλοήγησης η οποία περιλαµβάνει αρκετές 

εντολές διαχείρισης αρχείων, καθώς επίσης και συγκεκριµένα εργαλεία για την επεξεργασία και τροποποίηση 

των σελίδων. Υπάρχει επίσης µία γραµµή καταστάσεων τοποθετηµένη στο κάτω άκρο του παραθύρου της 

εφαρµογής, η οποία σας παρέχει χρήσιµες πληροφορίες. 

 

Αφού ανοίξετε τον ιστό σας στο παράθυρο του Frontpage, µπορείτε να τον εξετάσετε χρησιµοποιώντας µία 

από τις προβολές (views) του Frontpage, τις οποίες προσπελάζετε µέσω των εικονιδίων της γραµµής εργαλείων 

πλοήγησης, στην αριστερή πλευρά της οθόνης. Για να ενεργοποιήσετε µία προβολή, κάνετε απλώς κλικ στο 

εικονίδιο της. 
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Κάθε προβολή παρουσιάζει διαφορετικούς τύπους πληροφορίας για τον ιστό σας και σας δίνει τη 

δυνατότητα να χειριστείτε την τοποθεσία σας µε µία ποικιλία τρόπων. Σ' αυτή την ενότητα θα εξετάσουµε κάθε 

µία από αυτές τις προβολές και θα εξηγήσουµε τις χρήσεις όλων των διαθέσιµων προβολών. 

 

Η Προβολή Σελίδας 

 
Μπορείτε να θεωρήσετε την προβολή Σελίδας (Page view) σαν το ισοδύναµο του "συντάκτη" του 

Frontpage. Η προβολή Σελίδας εµφανίζει τη συγκεκριµένη σελίδα µε την οποία δουλεύετε την τρέχουσα 

στιγµή , επιτρέποντας σας να κάνετε αλλαγές ή προσαρµογές στα στοιχεία που περιέχει αυτή η σελίδα. 

 

Όταν βρίσκεστε στην προβολή Σελίδας, µπορείτε να επεξεργαστείτε τα στοιχεία της τρέχουσας σελίδας 

κάνοντας κλικ µε το δεξιό πλήκτρο του ποντικιού πάνω στα διάφορα αντικείµενα που περιλαµβάνει η σελίδα. 

Μπορείτε επίσης να χρησιµοποιείτε τις γραµµές εργαλείων που εµφανίζονται στην πάνω πλευρά του 

παραθύρου για να προσθέτετε ή να αλλάζετε τις πληροφορίες µορφοποίησης. 
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Μία από τις ισχυρότερες απόψεις της προβολής Σελίδας είναι το γεγονός ότι σας επιτρέπει να 

χρησιµοποιείτε τις καρτέλες που εµφανίζονται στο κάτω άκρο της οθόνης για να εναλλάσσεστε µεταξύ των 

καταστάσεων επεξεργασίας του προγράµµατος. 

 

 

 
 

 

 

Οι καταστάσεις επεξεργασίας είναι: 

 

Normal Αυτή είναι η στάνταρ κατάσταση επεξεργασίας - είναι ο οπτικός συντάκτης που παρουσιάζει µία 

σελίδα χωρίς να εµφανίζει τον HTML κώδικα που κρύβεται πίσω από αυτή.  

 

HTML Σ' αυτή την κατάσταση επεξεργασίας µπορείτε να προσπελάσετε την ουσία του θέµατος: τον HTML 

κώδικα που κρύβεται πίσω από µία σελίδα. Μπορείτε να κάνετε αλλαγές απευθείας στον κώδικα, ή να δείτε 

πώς έχει τροποποιηθεί ο κώδικας από τις αλλαγές που έχετε κάνει στον οπτικό συντάκτη. 

Preview Μ' αυτή την κατάσταση µπορείτε να εξετάσετε σε προεπισκόπηση τη σελίδα σας, όπως ακριβώς θα 

δείχνει αφού τη δηµοσιεύσετε! Η κατάσταση αυτή παρουσιάζει τα τελικά αποτελέσµατα των αλλαγών που 

έχετε κάνει στη σελίδα, χωρίς να εµφανίζει τον κώδικα ή οποιουσδήποτε άλλους ενδείκτες επεξεργασίας. 

 

Η προβολή Σελίδας είναι ιδιαίτερα χρήσιµη όχι µόνο επειδή σας επιτρέπει να κάνετε αλλαγές µε οπτικό 

τρόπο, αλλά επίσης επειδή σας επιτρέπει να δουλεύετε απευθείας µε τον HTML κώδικα και κατόπιν να 

ελέγχετε την επίδραση των αλλαγών σας στην εµφάνιση της σελίδας, σε κατάσταση προεπισκόπησης. Σ' αυτή 

την προβολή θα περνάτε τον περισσότερο χρόνο κατά την εργασία σας µε το Frontpage· για τον λόγο αυτό θα 

πρέπει οπωσδήποτε να εξοικειωθείτε µε τη χρήση αυτής της προβολής. 

 

Η Προβολή Φακέλων 
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Η προβολή Φακέλων (Folders view), την οποία βλέπετε στην Εικόνα 2.14, χωρίζει το παράθυρο του 

Frontpage σε δυο περιοχές. Η αριστερή περιοχή παρουσιάζει µία ιεραρχική λίστα των φακέλων του τρέχοντος 

ιστού. Η δεξιά περιοχή παρουσιάζει µία αναλυτική λίστα των σελίδων και των αρχείων που περιέχονται στον 

επιλεγµένο φάκελο. 

 

 
ΕΙΚΟΝΑ 2,14 

(Η προβολή φακέλων του FrontPage) 

 

θα χρησιµοποιείτε αυτή την προβολή για εργασίες διαχείρισης αρχείων όπως η µετονοµασία των αρχείων, η 

δηµιουργία νέων φακέλων και η µεταφορά σελίδων σε υποφακέλους. Όταν αλλάζετε το όνοµα ή τη θέση 

οποιουδήποτε αρχείου ενός ιστού, το Frontpage ενηµερώνει αυτόµατα τους σχετιζόµενους µε αυτό το αρχείο 

συνδέσµους σε όλη την έκταση της τρέχουσας τοποθεσίας. 

Κάθε ιστός του Frontpage διαθέτει δύο στάνταρ φακέλους: τον φάκελο Private και τον φάκελο Images. 

Αφού δηµοσιευτεί η τοποθεσία, οι σελίδες που είναι αποθηκευµένες στον φάκελο Private παραµένουν κρυφές 

από τις εφαρµογές browser (πράγµα το οποίο καθιστά τον φάκελο αυτό µία ιδανική θέση αποθήκευσης για τις 

σελίδες που δε θέλετε να βλέπουν οι άλλοι άνθρωποι - π.χ. για τις σελίδες που βρίσκονται ακόµη σε εξέλιξη 

και δεν έχουν ολοκληρωθεί). Μπορείτε επίσης να χρησιµοποιείτε τον φάκελο Private για να προστατεύετε τις 

σελίδες σας από την λειτουργία καταχώρισης λέξεων κλειδιών σε ευρετήρια· η λειτουργία αυτή δουλεύει σε 

συνδυασµό µε το συστατικό Search Form για την υλοποίηση της δυνατότητας διεξαγωγής αναζητήσεων µε 
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λέξεις κλειδιά. (Τα συστατικά του Frontpage είναι προκατασκευασµένα στοιχεία µε διαλογικά χαρακτηριστικά, 

τα οποία µπορείτε να προσθέτετε σε µία τοποθεσία χωρίς να χρειάζεστε γνώσεις προγραµµατισµού. 

 

Ο φάκελος Images είναι η ιδανική θέση για την αποθήκευση των γραφικών που χρησιµοποιεί η τοποθεσία 

σας. ∆ιατηρώντας τα αρχεία των Ιστοσελίδων και τα αρχεία των γραφικών σε ξεχωριστές θέσεις θα µπορείτε 

να διαχειρίζεστε πιο εύκολα αυτά τα στοιχεία της τοποθεσίας σας. 

Ακολουθεί µία συνοπτική περιγραφή ορισµένων από τις εργασίες διαχείρισης αρχείων που θα εκτελείτε 

όταν χρησιµοποιείτε την προβολή Φακέλων: 

 

Για να δείτε τα περιεχόµενα ενός φακέλου... Κάντε διπλό κλικ στο όνοµα του φακέλου. 

 

Για να µετονοµάσετε ένα αρχείο... Στη δεξιά περιοχή του παραθύρου, κάντε κλικ µε το δεξιό πλήκτρο 

του ποντικιού στο αρχείο που σας ενδιαφέρει και από τη γραµµή των µενού επιλέξτε Rename. 

Πληκτρολογήστε ένα νέο όνοµα και πατήστε Enter. To αρχείο σας θα εµφανιστεί µε το νέο όνοµα του. 

 

Για να δηµιουργήσετε έναν νέο φάκελο... Από τη γραµµή των µενού του Frontpage, επιλέξτε File >· New 

>· Folder. Μία νέα καταχώριση φακέλου θα εµφανιστεί και στις δύο περιοχές του παραθύρου, ενώ το όνοµα 

του φακέλου εµφανίζεται µε τονισµό στη δεξιά περιοχή. Πληκτρολογήστε το επιθυµητό όνοµα για τον νέο 

φάκελο και πατήστε Enter. 

 

Για να µετακινήσετε µία σελίδα σ' έναν φάκελο... Σύρετε την καταχώριση της σελίδας στον φάκελο 

προορισµού (σε οποιαδήποτε από τις δύο περιοχές του παραθύρου) και κατόπιν ελευθερώστε το πλήκτρο του 

ποντικιού. Η σελίδα µετακινείται στη νέα της θέση. 

 

Για να ταξινοµήσετε τη λίστα αρχείων στη δεξιά περιοχή του παραθύρου... Κάντε κλικ σε µία από τις 

επικεφαλίδες των στηλών στην κορυφή αυτής της περιοχής του παραθύρου. Για παράδειγµα, εάν θέλετε να 

ταξινοµήσετε τη λίστα αρχείων κατά όνοµα, κάντε κλικ στην επικεφαλίδα Name. 

 

Για να διαγράψετε ένα αρχείο... Κάντε κλικ στο όνοµα του αρχείου και πατήστε το πλήκτρο Delete, θα 

εµφανιστεί το παράθυρο διαλόγου Confirm Delete (επιβεβαίωση διαγραφής), το οποίο σας ζητά να 

επιβεβαιώσετε τη διαγραφή. Κάντε κλικ στο Yes και το αρχείο σας θα είναι πλέον παρελθόν. 
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Για να ανοίξετε ένα αρχείο... Κάντε διπλό κλικ στο όνοµα του αρχείου. Το αρχείο ανοίγει σε προβολή 

Σελίδας (εάν είναι ένα HTML αρχείο), ή στο Image Composer (εάν είναι ένα αρχείο γραφικού). 

 

Για να εµφανίσετε τις ιδιότητες ενός αρχείου... Κάντε κλικ µε το δεξιό πλήκτρο του ποντικιού στο 

αρχείο που σας ενδιαφέρει και από το µενού συντόµευσης που εµφανίζεται, επιλέξτε την εντολή Properties, 

θα εµφανιστεί το παράθυρο διαλόγου Properties µε τις ιδιότητες του επιλεγµένου αρχείου. 

 

 

 

 

 

 

 

Η Προβολή Αναφορών 

 
Η προβολή Αναφορών (Reports view) χρησιµοποιείται σαν βοήθηµα για τη διαχείριση των σελίδων του 

τρέχοντος ιστού. Να θυµάστε ότι όταν δουλεύετε µε ιστούς, το Frontpage αντιµετωπίζει ολόκληρο το έργο 

σας σαν µία µεµονωµένη οντότητα (έναν ιστό), η οποία αποτελείται από µικρότερα διακριτά µέρη (τα 

αρχεία). Η προβολή Αναφορών σας παρέχει µία ευρεία γκάµα πληροφοριών για τα αρχεία που περιέχονται 

στον τρέχοντα ιστό (Εικόνα 2.15). 
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EIKONA 2,15 

 
(Η προβολή αναφορών εµφανίζει πληροφορίες για τα µεµονωµένα αρχεία που περιέχοντια σε έναν ιστό) 

 
 

Στην προβολή Αναφορών µπορείτε να εµφανίζετε συνοπτικές πληροφορίες για κάθε αρχείο που περιέχεται σ' έναν ιστό: 

 

• Στήλη Name: Εδώ αναφέρεται ο τύπος των αρχείων, όπως π.χ. Pictures (εικόνες), Linked Files 

(διασυνδεδεµένα αρχεία) και Slow Pages ("αργές" σελίδες). 

 

• Στήλη Count: To πλήθος των αρχείων ενός τύπου (σύµφωνα µε τη στήλη Name). 

 

• Στήλη Size: To συνολικό µέγεθος του αρχείου, συµπεριλαµβανοµένων και οποιωνδήποτε εξαρτηµένων 

αρχείων (π.χ. γραφικά). 

 

• Στήλη Description: Στη στήλη αυτή περιγράφονται αναλυτικά το όνοµα ή ο τύπος των αρχείων που 

εξετάζετε. Στην ορολογία του Web, αυτό στο οποίο το Frontpage αναφέρεται µε τον όρο "size" (µέγεθος) 
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αποκαλείται επίσης "βάρος σελίδας" (page weight): το µέγεθος των εξαρτώµενων αρχείων ενός ιστού, σε 

kilobytes. 

 

Η Προβολή Πλοήγησης 
 

Η προβολή Πλοήγησης (Navigation view), σας βοηθά να αντιληφθείτε πώς ακριβώς θα βρίσκουν τον 

δρόµο τους οι επισκέπτες της τοποθεσίας σας. ∆ηµιουργώντας µία δοµή πλοήγησης στο παράθυρο αυτής της 

προβολής, δηµιουργείτε ουσιαστικά τη βάση για τις γραµµές εργαλείων πλοήγησης (navigation bars) της 

τοποθεσίας σας. Οι γραµµές εργαλείων πλοήγησης περιλαµβάνουν δεσµούς υπερκειµένου ή κουµπιά πάνω 

στα οποία µπορούν να κάνουν κλικ οι επισκέπτες για να µεταβούν σε µία διαφορετική σελίδα. Η κάτω 

περιοχή περιλαµβάνει µία λίστα αρχείων παρόµοια µε αυτή που συναντά κανείς στην προβολή Φακέλων.  

 Προβολή ∆εσµών Υπερκειµένου 

 
Η προβολή ∆εσµών Υπερκειµένου (Hyperlinks view), την οποία βλέπετε στην Εικόνα 2.17, σας παρέχει µία 

εποπτική άποψη όλων των δεσµών υπερκειµένου (ή συνδέσµων) που περιλαµβάνονται στον τρέχοντα ιστό. Οι 

ιστοί που δηµιουργούνται χρησιµοποιώντας τα πρότυπα ή τους οδηγούς του Frontpage περιλαµβάνουν εξαρχής 

δεσµούς υπερκειµένου οι οποίοι συνδέουν τις σελίδες της τοποθεσίας µεταξύ τους και, σε ορισµένες 

περιπτώσεις, µε σελίδες άλλων τοποθεσιών του Web. Ωστόσο, όταν κατασκευάζετε µία τοποθεσία "εκ του 

µηδενός", θα πρέπει να εισάγετε µόνοι σας τους απαραίτητους δεσµούς υπερκειµένου. 
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Στην προβολή ∆εσµών Υπερκειµένου, η αριστερή περιοχή του παραθύρου περιλαµβάνει την ιεραρχική 

διάρθρωση (το δέντρο) όλων των στοιχείων της τοποθεσίας σας, µε τις σελίδες κορυφαίου επιπέδου (συνήθως 

την αρχική σελίδα της τοποθεσίας) στην κορυφή. Η δεξιά περιοχή του παραθύρου παρουσιάζει ένα πιο 

αναλυτικό διάγραµµα της σελίδας που έχετε επιλέξει στην αριστερή περιοχή. Οι "εισερχόµενοι" δεσµοί 

υπερκειµένου παρουσιάζονται στ' αριστερά, ενώ οι "εξερχόµενοι" δεσµοί υπερκειµένου παρουσιάζονται στα 

δεξιά. 

Για να κινηθείτε σ' αυτή την προβολή, δείξτε απλώς στο επιθυµητό στοιχείο και κάντε κλικ. Για 

παράδειγµα, κάνοντας κλικ σε οποιαδήποτε σελίδα της διάρθρωσης εµφανίζονται οι σελίδες που συνδέονται 

µέσω δεσµών µ' αυτή, ακριβώς από κάτω της. Κάντε κλικ σε οποιαδήποτε άλλη σελίδα της διάρθρωσης για να 

εµφανίσετε τους συνδέσµους αυτής της σελίδας στη δεξιά περιοχή του παραθύρου, στη θέση των 

προηγούµενων. Κάντε κλικ στο µικρό σύµβολο συν που βλέπετε δίπλα σε οποιαδήποτε σελίδα του 

διαγράµµατος και το διάγραµµα θα επεκταθεί από αυτή τη σελίδα. 

 

 

Η Προβολή Εργασιών 
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Στην προβολή Εργασιών (Tasks view), µπορείτε να διατηρείτε µία τρέχουσα λίστα των εργασιών που 

χρειάζεται να ολοκληρώσετε για τη δηµιουργία της τοποθεσίας σας. Η προβολή Εργασιών είναι ιδιαίτερα 

χρήσιµη εάν συνεργάζεστε µε άλλους ανθρώπους για την κατασκευή της τοποθεσίας, επειδή ολόκληρη η 

οµάδα των συνεργατών µπορεί να µοιράζεται τα στοιχεία της λίστας, θα µάθετε περισσότερα για την προβολή 

Εργασιών.  

 

Προσθήκη Σελίδων σε έναν Ιστό του Frontpage 

 
Αφού δηµιουργήσετε έναν ιστό στο Frontpage (κυρίως εάν πρόκειται για έναν ιστό µε µία µόνο σελίδα), 

αναµφίβολα θα θελήσετε να προσθέσετε νέες σελίδες στην τοποθεσία που αντιπροσωπεύει αυτός ο ιστός, θα 

διεξάγετε το µεγαλύτερο µέρος των εργασιών ; 

δηµιουργίας σελίδων στην προβολή Σελίδας . Ωστόσο, εάν, απλά θέλετε να "κολλήσετε" µία-δύο νέες κενές 

σελίδες στον ιστό σας, ή εάν θέλετε να εισάγετε µία υπάρχουσα σελίδα σε µία τοποθεσία, µπορείτε να 

εκτελέσετε τις εργασίες αυτές αρκετά εύκολα. 

 

 

∆ηµιουργία Νέας Ιστοσελίδας 

 
To Frontpage σας επιτρέπει να προσθέτετε κενές σελίδες σε έναν ιστό, τις οποίες µπορείτε να ανοίξετε ανά 

πάσα στιγµή για να τις γεµίσετε µε περιεχόµενο. Για να δηµιουργήσετε µία νέα κενή σελίδα σε έναν ιστό του 

Frontpage, είναι προτιµότερο να βρίσκεστε στην προβολή Φακέλων. 

 

1. Με ανοικτό τον ιστό που σας ενδιαφέρει σε προβολή Φακέλων, επιλέξτε την εντολή File >· New >- 

Page. Εναλλακτικά, από τη Βασική γραµµή εργαλείων κάντε κλικ στο κουµπί New Page, ή πατήστε Ctrl + Ν. 

 

2. Πληκτρολογήστε ένα όνοµα αρχείου για τη νέα σελίδα και πατήστε Enter. To όνοµα αρχείου θα πρέπει να 

είναι σύντοµο, περιγραφικό, ευκολοµνηµόνευτο και µε επέκταση .htm ή .him Ι. 

 

Εισαγωγή Υπαρχουσών Ιστοσελίδων 
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Εάν έχετε δηµιουργήσει ήδη ορισµένες ιστοσελίδες, ή εάν έχετε πρόσβαση σε ιστοσελίδες άλλων και θέλετε 

να τις προσαρτήσετε στον ιστό που δηµιουργείτε µε το Frontpage, µπορείτε εύκολα να τις εισάγετε. Μπορείτε 

να εισάγετε µεµονωµένα αρχεία ή ολόκληρους φακέλους αποθηκευµένους στον υπολογιστή σας, στο τοπικό 

δίκτυο σας, ή στο World Wide Web. 

 

1. Επιλέξτε την εντολή File >· Import από την γραµµή των µενού, θα εµφανιστεί το παράθυρο διαλόγου 

Import File To Frontpage Web. 

 

2.   Μπορείτε να εισάγετε µεµονωµένα αρχεία ή τα αρχεία ενός ολόκληρου φακέλου είτε από µία τοπική 

πηγή, είτε από το World Wide Web. Για να εισάγετε ένα ή περισσότερα αρχεία τα οποία είναι αποθηκευµένα 

στον υπολογιστή σας ή στο τοπικό δίκτυο σας, στο παράθυρο διαλόγου Import File To Frontpage Web κάντε » 

κλικ στο κoυµπί Add File. θα εµφανιστεί το παράθυρο διαλόγου Add File To Import List. 

Εναλλακτικά, 

 

Για να εισάγετε έναν ολόκληρο φάκελο αποθηκευµένο στον υπολογιστή σας ή στο τοπικό δίκτυο σας, στο 

παράθυρο διαλόγου Import File To Frontpage Web κάντε κλικ στο κουµπί Add Folder, θα εµφανιστεί το 

παράθυρο διαλόγου Browse For Folder. 

Εναλλακτικά, 

Για να εισάγετε ένα αρχείο ή έναν φάκελο ο οποίος επί του παρόντος βρίσκεται στο World Wide Web, στο 

παράθυρο διαλόγου Import File To Frontpage Web κάντε κλικ στο κουµπί From Web. θα εµφανιστεί το 

παράθυρο διαλόγου Import Web Wizard - Choose Source. (Για περισσότερη βοήθεια σχετικά µε την χρήση του 

Οδηγού Εισαγωγής, Import Web Wizard, ανατρέξτε σε µία προηγούµενη ενότητα αυτού του κεφαλαίου). 

 

3. Εάν εισάγετε µεµονωµένα αρχεία, στο παράθυρο διαλόγου Add File To Import List επιλέξτε το αρχείο ή 

τα αρχεία που θέλετε να εισάγετε. Κατόπιν κάντε κλικ στο Open. To παράθυρο διαλόγου θα κλείσει, ενώ τα 

επιλεγµένα αρχεία εµφανίζονται στη λίστα εισαγωγής του παραθύρου διαλόγου Import File To Frontpage Web. 

Εναλλακτικά, 

Εάν εισάγετε έναν ολόκληρο φάκελο, στο παράθυρο διαλόγου Browse For Folder επιλέξτε τον φάκελο που 

θέλετε να εισάγετε και κατόπιν κάντε κλικ στο ΟΚ. Το παράθυρο διαλόγου θα κλείσει, ενώ τα αρχεία που 

περιέχονται στον επιλεγµένο φάκελο θα εµφανιστούν στη λίστα εισαγωγής του παραθύρου διαλόγου Import 

File To Frontpage Web. 
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4. Στο παράθυρο διαλόγου Import File To Frontpage Web, κάντε κλικ στο ΟΚ. To Frontpage εισάγει τα 

αρχεία που επιλέξατε. Όταν η διαδικασία εισαγωγής ολοκληρωθεί, το παράθυρο διαλόγου θα κλείσει. 

 

Άνοιγµα Υπάρχοντος Ιστού του Frontpage 

 
Μπορείτε να χρησιµοποιείτε το Frontpage για τη δηµιουργία και συντήρηση πολλοί ιστών στον ίδιο 

υπολογιστή, αλλά µπορείτε να ανοίγετε και να δουλεύετε µόνο µε εν ιστό ανά πάσα στιγµή. Για να ανοίξετε 

έναν υπάρχοντα ιστό του Frontpage, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Από τη γραµµή των µενού του Frontpage, επιλέξτε την εντολή File > Open We (άνοιγµα ιστού). 

 

2.  Στη λίστα του παραθύρου διαλόγου Open Web, κάντε κλικ στον ιστό που θέλετε να ανοίξετε και 

κατόπιν κάντε κλικ στο Open. 

 

Εάν έχετε δουλέψει πρόσφατα µε τον ιστό τον οποίο θέλετε να ανοίξετε, µπορείτε να χρησιµοποιήσετε την 

εντολή File > Recent Webs και να επιλέξετε τον ιστό που σας ενδιαφέρει από το υποµενού αυτής της εντολής. 

 

∆ιαγραφή ενός Ιστού του Frontpage 

 
Εάν ασχολείστε πολύ µε τη δηµοσίευση υλικού στο Web, η εγκατάσταση του Frontpage στον υπολογιστή 

σας θ' αρχίσει σύντοµα να αντικατοπτρίζει τα αποτελέσµατα της εργασίας σας: πολλούς - πιθανώς υπερβολικά 

πολλούς - ιστούς του Frontpage. Φυσικά, µπορείτε να διαγράφετε τους ιστούς που έχουν καταστεί 

απαρχαιωµένοι ή άχρηστοι για οποιονδήποτε λόγο. Για τον σκοπό αυτό, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Στο Frontpage, ανοίξτε τον ιστό που θέλετε να διαγράψετε και από τη γραµµή των µενού επιλέξτε την 

εντολή File >· Delete Web. θα εµφανιστεί το παράθυρο διαλόγου Confirm Delete, το οποίο σας παρέχει δύο 

επιλογές. 
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2. Για να διαγράψετε τον ιστό αλλά να διατηρήσετε τα αρχεία του, κάντε κλικ στο κουµπί της επιλογής 

Remove Only Frontpage Information From This Web, Preserving All Other Files And Folders, και κατόπιν 

κάντε κλικ στο OK. To παράθυρο διαλόγου θα κλείσει και το Frontpage θα διαγράψει τις πληροφορίες ιστού 

από τα αρχεία. 

 

3. Για να διαγράψετε ολοκληρωτικά τον ιστό από τον σκληρό σας δίσκο, κάντε κλικ στο κουµπί της 

επιλογής Remove This Web Entirely By Deleting All Of Its Files And Folders. Κάντε κλικ στο OK και ο ιστός 

θα εξαφανιστεί ολοκληρωτικά. 

 

ΠΡΟΣΟΧΗ    

Αφού διαγράψετε έναν ιστό, αυτός χάνεται οριστικά. To  Frontpage δεν περιλαµβάνει λειτουργίες 

αναίρεσης (Undo) ή αναίρεσης διαγραφής  (Undelete) µε τις οποίες θα µπορούσατε να αναιρέσετε τα 

αποτελέσµατα µιας  ενδεχοµένως  καταστροφικής ενέργειας  διαγραφής.  

Προφανώς, θα  πρέπει να είστε ιδιαίτερα προσεκτικοί όταν   διαγράφετε έναν ιστό. Εάν διαγράψετε  έναν 

ιστό κατά λάθος,  είστε υποχρεωµένοι   να ξεκινήσετε τη  δηµιουργία του από την αρχή. 

 

 

 

 

 

 

 

Έξοδος από το FrontPage 

 
Για να βγείτε από το Frontpage, κλείστε κατ' αρχήν οποιαδήποτε ανοικτά παράθυρα διαλόγου και κατόπιν 

κάντε τα ακόλουθα: 

1.   Από τη γραµµή των µενού του Frontpage, επιλέξτε την εντολή File >· Exit, ή πατήστε Alt+F4. 
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2.    To Frontpage θα κλείσει και θα επανεµφανιστεί η επιφάνεια εργασίας των Windows. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Στο προηγούµενο Κεφάλαιο  σας κάναµε µία µικρή ξενάγηση στο σύστηµα επικοινωνίας του Frontpage µε 

τον χρήστη  τον χώρο κατασκευής και στέγασης των Ιστών" (τοποθεσιών/ Ιστοσελίδων) που θα δηµιουργείτε 

µ' αυτό το πρόγραµµα. Εξετάσαµε επίσης εν συντοµία την προβολή Σελίδας (Page view). Στο παρόν κεφάλαιο 
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θα εξετάσουµε αναλυτικά την προβολή Σελίδας, δεδοµένου ότι είναι το κέντρο εντολών για σχεδόν όλες τις 

εργασίες που θα εκτελείτε στο Frontpage 2000. Στην προβολή Σελίδας θα δηµιουργείτε, θα τροποποιείτε και θα 

εξετάζετε σε προεπισκόπηση τις µεµονωµένες σελίδες ενός ιστού. 

Σ' αυτό το κεφάλαιο θα γνωρίσετε τις βασικές λειτουργίες και τα χαρακτηριστικά της προβολής Σελίδας. Σε 

επόµενα κεφάλαια θα µάθετε πώς να χρησιµοποιείτε τα εργαλεία δηµιουργίας σελίδων του Frontpage. 

 

Γνωριµία µε την Προβολή Σελίδας 

 

Μπορείτε να θεωρήσετε την προβολή Σελίδας του Frontpage σαν ένα πρόγραµµα ενσωµατωµένο µέσα σ' 

ένα άλλο πρόγραµµα. Το κύριο πρόγραµµα σ' αυτή την περίπτωση είναι το ίδιο το Frontpage· αυτό χειρίζεται 

όλες τις εργασίες που σχετίζονται µε τους ιστούς του Frontpage, όπως η δηµιουργία τους, η εισαγωγή τους, η 

εµφάνιση τους, κ.λ.π. Η προβολή Σελίδας λειτουργεί µέσα στην εφαρµογή Frontpage, επικεντρωµένη κυρίως 

σε εργασίες οι οποίες σχετίζονται µε τις µεµονωµένες σελίδες που απαρτίζουν έναν ιστό - µία τοποθεσία του 

Web. Μπορείτε να χρησιµοποιείτε την προβολή Σελίδας για τη ν προσθήκη και µορφοποίηση κειµένου, τη 

δηµιουργία δεσµών υπερκειµένου, την εισαγωγή γραφικών και τη διαχείριση όλων των άλλων στοιχείων που 

θα περίµενε κανείς να βρει σε µία ιστοσελίδα. 
 

Οι άλλες προβολές του Frontpage, για τις οποίες µιλήσαµε εν συντοµία στο Κεφάλαιο αυτό - Φακέλων 

(Folders), Αναφορών (Reports), Πλοήγησης (Navigation), ∆εσµών Υπερκειµένου (Hyperlinks) και Εργασιών 

(Tasks) - συνεργάζονται απρόσκοπτα µε την προβολή Σελίδας. Καθώς τροποποιείτε και αποθηκεύετε τις 

σελίδες µιας τοποθεσίας, µπορείτε να εναλλάσσεστε µεταξύ των διάφορων προβολών για να βλέπετε πώς 

επηρεάζουν οι αλλαγές που κάνετε σε µία σελίδα το υπόλοιπο της τοποθεσίας σας. Για παράδειγµα, αφού 

δηµιουργήσετε έναν δεσµό υπερκειµένου χρησιµοποιώντας την προβολή Σελίδας, µπορείτε να µεταβείτε σε 

προβολή ∆εσµών Υπερκειµένου για να εξακριβώσετε πόσο καλά λειτουργεί αυτός ο δεσµός σε σχέση µε το 

υπόλοιπο της τοποθεσίας. 
 

Μετακινούµενοι µεταξύ των διάφορων προβολών του προγράµµατος καθώς δηµιουργείτε τους ιστούς που 

απαρτίζουν την τοποθεσία σας, µπορείτε να φροντίζετε για τις σχεδιαστικές λεπτοµέρειες διατηρώντας 

ταυτόχρονα µία γενική άποψη της τοποθεσίας σας. 

 

Όπως θα διαπιστώσετε, στο Frontpage θα εκτελείτε την πλειονότητα των εργασιών δηµιουργίας ιστών κατ' 

αυτό τον τρόπο - χρησιµοποιώντας την προβολή Σελίδας για να δουλέψετε µε τις σελίδες που ανήκουν στον 

τρέχοντα ανοικτό ιστό. Ωστόσο, ορισµένες φορές θα θέλετε να ανοίξετε κάποια ιστοσελίδα η οποία δεν ανήκει 
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σε έναν ιστό του Frontpage. Αυτό δεν αποτελεί πρόβληµα. To Frontpage µπορεί να σας υποστηρίξει σε πολλά 

διαφορετικά σενάρια και καταστάσεις, όπως θα δείτε σύντοµα. Και οι χρήστες προγενέστερων εκδόσεων του 

Frontpage θα διαπιστώσουν σύντοµα ότι ο Συντάκτης (Editor) και το βοήθηµα Εξερεύνησης (Explorer) του 

Frontpage 98 έχουν πλέον συγχωνευτεί µε την προβολή Σελίδας, πράγµα το οποίο σηµαίνει ότι η προβολή 

Σελίδας είναι πλέον το επιχειρησιακό κέντρο όλων των εργασιών που θα εκτελείτε για τη δηµιουργία 

τοποθεσιών του Web.        

 

 

Ξεκινώντας 

 
Για ν' αρχίσετε να δουλεύετε στην προβολή Σελίδας, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Ξεκινήστε το Frontpage.  

 

2. Ξεκινήστε τη δηµιουργία ενός νέου ιστού στο Frontpage, επιλέγοντας την εντολή File >· New > Web, ή 

ανοίξτε έναν υπάρχοντα ιστό. Ο ιστός θα εµφανιστεί στην προβολή Σελίδας του Frontpage. 

 

Για να ανοίξετε το αρχείο µιας ιστοσελίδας, βεβαιωθείτε ότι χρησιµοποιείτε την προβολή Φακέλων 

(Folders), Πλοήγησης (Navigation), ή ∆εσµών Υπερκειµένου (Hyperlinks). Κάντε διπλό κλικ στο εικονίδιο 

που αντιπροσωπεύει τη σελίδα την οποία θέλετε να ανοίξετε. To Frontpage θα εµφανίσει τα περιεχόµενα της 

επιλεγµένης σελίδας στο παράθυρο επεξεργασίας. 

Εάν ο τρέχων ιστός του Frontpage δηµιουργήθηκε µε βάση ένα -πρότυπο ή έναν οδηγό, η σελίδα που 

ανοίγει θα περιέχει ενδεικτικό (πλασµατικό) κείµενο και πιθανώς ορισµένα σχεδιαστικά στοιχεία, όπως π. χ. 

ένα γραφικό στο φόντο, ή µία γραµµή εργαλείων πλοήγησης. Εάν δηµιουργείτε µία τοποθεσία για το Web "εκ 

του µηδενός", η σελίδα που ανοίγει θα είναι κενή. 

Αφιερώστε λίγο χρόνο για να εξετάσετε το σύστηµα επικοινωνίας του προγράµµατος µε τον χρήστη. Το 

πιθανότερο είναι ότι θα αναγνωρίσετε ορισµένα κουµπιά και εργαλεία, κυρίως εάν χρησιµοποιείτε ήδη τις 

εφαρµογές του πακέτου Microsoft Office. To Frontpage δουλεύει παρόµοια µε ένα πρόγραµµα επεξεργασίας 

κειµένου, µε την τρέχουσα σελίδα ορατή σε προβολή Σελίδας. 

∆υο από τις διαθέσιµες γραµµές εργαλείων - Βασική (Standard) και Μορφοποίησης (Formatting) – 

παρουσιάζονται παρακάτω. Συνολικά το πρόγραµµα διαθέτει έξι γραµµές εργαλείων, οι περισσότερες εκ των 

οποίων σχετίζονται µε τις εργασίες που θα κάνετε σε προβολή Σελίδας. Για να κάνετε ορατή µία γραµµή 

εργαλείων ανοίξτε το µενού View, επιλέξτε την εντολή Toolbars και κατόπιν επιλέξτε το όνοµα της γραµµής 

εργαλείων που θέλετε να εµφανίσετε. 
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 Ακολουθεί µία σύντοµη περιγραφή των διαθέσιµων γραµµών εργαλείων: 

 

Βασική (Standard) γραµµή εργαλείων Αυτή η γραµµή εργαλείων περιέχει κουµπιά για πολλές από τις 

στάνταρ λειτουργίες του προγράµµατος, συµπεριλαµβανοµένων των ακόλουθων: δηµιουργία, άνοιγµα, 

αποθήκευση και εκτύπωση σελίδων. Επιπρόσθετα θα βρείτε κουµπιά για την εκτέλεση εργασιών οι οποίες 

σχετίζονται µε τη δηµοσίευση περιεχοµένου στο Web, όπως η δηµιουργία δεσµών υπερκειµένου και η 

εισαγωγή εικόνων σε ιστοσελίδες. 

 

 

Γραµµή εργαλείων Μορφοποίησης (Formatting) Αυτή η γραµµή εργαλείων περιέχει κουµπιά και 

αναδιπλούµενες λίστες για τις πιο κοινές εργασίες µορφοποίησης κειµένου. Το Κεφάλαιο 4 θα εξηγήσει τη 

χρήση πολλών εργαλείων αυτής της γραµµής εργαλείων. 

 

Γραµµή εργαλείων DHTML Η γραµµή εργαλείων DHTML σας επιτρέπει να προσθέτετε ειδικά εφέ, όπως 

π.χ. τα κουµπιά που αλλάζουν εµφάνιση όταν τοποθετείτε τον δείκτη του ποντικιού πάνω τους (mouse over), 

στη σελίδα σας. 

 

 

Γραµµή εργαλείων Πλοήγησης (Navigation) Αυτή η γραµµή εργαλείων είναι ιδιαίτερα χρήσιµη όταν 

µεταβαίνετε σε προβολή Πλοήγησης. Σας επιτρέπει να εµφανίσετε και να τροποποιήσετε τους δεσµούς 

υπερκειµένου του τρέχοντος ιστού. 
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Γραµµή εργαλείων Εικόνας (Picture) Αυτή η γραµµή εργαλείων σας βοηθά να ελέγξετε την εµφάνιση των 

εικόνων και των άλλων γραφικών που ενσωµατώνετε στις ιστοσελίδες σας. Σας επιτρέπει επίσης να 

µετασχηµατίσετε απλές εικόνες ή άλλα γραφικά σε image map εικόνες (εικόνες οι οποίες περιέχουν πολλές 

ενεργές περιοχές, πάνω στις οποίες µπορούν να κάνουν κλικ οι χρήστες για να µεταβούν σε διαφορετικούς 

προορισµούς).  

 

 

Γραµµή εργαλείων Πινάκων (Tables) Τα κουµπιά αυτής της γραµµής εργαλείων απλοποιούν τη χρήση 

των πινάκων στις ιστοσελίδες. 

 

 

∆ηµιουργία Νέας Σελίδας στην Προβολή Σελίδας 

 
Στο προηγούµενο κεφάλαιο σας δείξαµε τη διαδικασία µε την οποία µπορείτε να προσαρτάτε νέες, κενές 

σελίδες στον ιστό που έχετε ανοικτό την τρέχουσα στιγµή στο Frontpage. Μπορείτε επίσης να χρησιµοποιείτε 

την προβολή Σελίδας για τη δηµιουργία νέων σελίδων. Στην πραγµατικότητα αυτός είναι και ο προτιµότερος 

τρόπος, επειδή θέτει στη διάθεση σας ορισµένα ιδιαίτερα χρήσιµα πρότυπα σελίδων. 

 

Για να δηµιουργήσετε µία νέα σελίδα χρησιµοποιώντας ένα πρότυπο, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Από τη γραµµή των µενού, επιλέξτε την εντολή File >· New > Page (ή πατήστε Ctrl+N). θα εµφανιστεί το 

παράθυρο διαλόγου New (Εικόνα 3.2). Αυτό το παράθυρο διαλόγου περιέχει µία λίστα όλων των διαθέσιµων 

προτύπων Ιστοσελίδων. (Παρατηρήστε ότι επί του παρόντος είναι ορατή η καρτέλα General [γενικά πρότυπα] 

του παραθύρου διαλόγου). 
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Εάν επιλέξετε τις καρτέλες Frames Pages ή Style Sheets θα δείτε λίστες των προτύπων Ιστοσελίδων µε 

πλαίσια και φύλλα στυλ, αντίστοιχα.  

 

EIKONA 3,2 

(Το παράθυρο διαλόγου New σας επιτρέπιει να επιλέξετε οποιοδήποτε απο τα αρκετά πρότυπα ιστοσελίδων 

που σας παρέχει) 

 

2. Από τη λίστα, επιλέξτε το πρότυπο που σας ενδιαφέρει. Μία σύντοµη περιγραφή του επιλεγµένου 

προτύπου θα εµφανιστεί στην περιοχή Description του παραθύρου διαλόγου, ενώ µία µικροσκοπική 

αναπαράσταση του προτύπου εµφανίζεται επίσης στην περιοχή προεπισκόπησης. 

 

3. Αφοϋ βρείτε το επιθυµητό πρότυπο, κάντε κλικ στο ΟΚ. Το παράθυρο διαλόγου New θα κλείσει και η 

νέα, κενή σελίδα θα εµφανιστεί στην οθόνη σας. 

 

Όπως βλέπετε στην, οι νέες σελίδες που δηµιουργούνται µε βάση τα πρότυπα του Frontpage περιέχουν 

"πλασµατικό" κείµενο και σε ορισµένες περιπτώσεις δείγµατα γραφικών µε στόχο να σας δώσουν µία ιδέα 

σχετικά µε την τελική εµφάνιση της σελίδας (εκτός φυσικά από το πρότυπο Normal, το οποίο δηµιουργεί 

 42



Εισαγωγή στο FrontPage 

απλώς µία κενή σελίδα). Στο σηµείο αυτό µπορείτε να αντικαταστήσετε το γενικευµένο, πλασµατικό κείµενο 

µε το δικό σας περιεχόµενο και να κάνετε οποιεσδήποτε άλλες αλλαγές θέλετε στη διάταξη της σελίδας. 

 

 

Οι διάστικτες γραµµές πλέγµατος που περιβάλλουν το κείµενο στα περισσότερα πρότυπα αντικατοπτρίζουν 

τα περιθώρια αόρατων πινάκων (πινάκων οι οποίοι δεν έχουν ορατά περιγράµµατα). Οι αόρατοι πίνακες 

αποτελούν τον σκελετό της διάταξης πολλών σελίδων.. Φυσικά, µπορείτε επίσης να χρησιµοποιείτε την 

προβολή Σελίδας για να δηµιουργείτε νέες, κενές σελίδες. Για τον σκοπό αυτό θα ακολουθείτε την 

προαναφερθείσα διαδικασία, επιλέγοντας απλώς το πρότυπο Normal. Εναλλακτικά, κάντε κλικ στο κουµπί 

New της Βασικής γραµµής εργαλείων. 

 

Άνοιγµα Ιστοσελίδας σε Προβολή Σελίδας 

 

Αφού ξεκινήσετε το Frontpage, µπορείτε να ανοίξετε περισσότερες από µία σελίδες σε προβολή Σελίδας. 

Στις περισσότερες περιπτώσεις θα δουλεύετε µε τις σελίδες που ανήκουν στον τρέχοντα ιστό του Frontpage. 

Μπορείτε επίσης να ανοίγετε ιστοσελίδες αποθηκευµένες στον υπολογιστή ή στο τοπικό δίκτυο σας, οι οποίες 

όµως δεν ανήκουν σε κάποιον ιστό του Frontpage. Τέλος, µπορείτε να ανοίγετε ιστοσελίδες απευθείας από το 

World Wide Web. 

 

Εάν η Σελίδα Ανήκει στον Τρέχοντα Ιστό του Frontpage... 

 
Εάν έχετε δηµιουργήσει την τοποθεσία σας χρησιµοποιώντας ένα από τα πρότυπα ή τους οδηγούς του 

Frontpage (ή εάν έχετε προσθέσει νέες σελίδες σε µία "µονοσέλιδη" τοποθεσία), τότε ο ιστός σας περιέχει ήδη 

αρκετές σελίδες. Για να ανοίξετε µία από τις σελίδες που ανήκουν σε έναν ιστό, ακολουθήστε τα παρακάτω 

βήµατα: 

1. Από τη γραµµή των µενού του Frontpage, επιλέξτε την εντολή File >Open (ή πατήστε Ctrl+0). θα 

εµφανιστεί το παράθυρο διαλόγου Open (Εικόνα 3.4). 
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ΕΙΚΟΝΑ 3,4 

Το παράθυρο διαλόγου Open εµφανίζει τα αρχεία και τους φακέλους για το τρέχοντα ιστό 

 

 

 

2.     To παράθυρο διαλόγου Open παρουσιάζει τα HTML αρχεία και τους φακέλους που απαρτίζουν τον  

τρέχοντα ανοικτό ιστό. Στη λίστα αρχείων του παραθύρου διαλόγου, κάντε διπλό κλικ στο όνοµα του αρχείου 

που θέλετε να ανοίξετε. (Εναλλακτικά, κάντε διπλό κλικ σε έναν φάκελο για να εµφανίσετε τα περιεχόµενα του 

και κατόπιν κάντε διπλό κλικ στο όνοµα του αρχείου που σας ενδιαφέρει). Το παράθυρο διαλόγου θα κλείσει 

και το επιλεγµένο αρχείο θα ανοίξει σε προβολή Σελίδας.  

 

Εάν η Σελίδα Είναι Αποθηκευµένη στον Υπολογιστή ή στο Τοπικό ∆ίκτυο 

σας..  
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Το Frontpage σας επιτρέπει να ανοίγετε οποιαδήποτε ιστοσελίδα αποθηκευµένη στο τοπικό σύστηµα 

αρχείων του υπολογιστή σας, ή στο τοπικό δίκτυο µε το οποίο συνδέεστε, ανεξάρτητα από το εάν αυτή ανήκει 

στον τρέχοντα ιστό ή όχι.  

Για να ανοίξετε µία σελίδα η οποία δεν ανήκει στον τρέχοντα ιστό του Frontpage ακολουθήστε τα 

παρακάτω βήµατα: 

 

1. Από τη γραµµή των µενού, επιλέξτε την εντολή File > Open (ή κάντε κλικ στο κουµπί Ορen της 

Βασικής γραµµή ς εργαλείων, ή πατήστε Ctrl+0). θα εµφανιστεί το παράθυρο διαλόγου Open. 

 

2. Στο παράθυρο διαλόγου Open µπορείτε να ψάξετε στο σύστηµα αρχείων το υπολογιστή ή του δικτύου 

σας για να εντοπίσετε το αρχείο που θέλετε ανοίξετε.  

 

3. Χρησιµοποιώντας αυτό το παράθυρο διαλόγου εντοπίστε το αρχείο της ιστοσελίδας που θέλετε να 

ανοίξετε. Αφού βρείτε το αρχείο της σελίδας, κάντε διπλό κλικ στο εικονίδιο του.  

 

Τα παράθυρα διαλόγου Select File και Open θα κλείσουν ενώ το επιλεγµένο αρχείο θα ανοίξει σε προβολή 

Σελίδας. 

 

 

Εισαγωγή στις Ιδιότητες 
 

Κάθε σελίδα που δηµιουργείτε ή ανοίγετε στο Frontpage περιέχει γενικές ρυθµίσεις οι οποίες ελέγχουν τη 

λειτουργία της και, σε ορισµένες περιπτώσεις, την εµφάνιση της.  

 

To Frontpage αναφέρεται στις ρυθµίσεις αυτές µε τον όρο Properties (ιδιότητες) και οµαδοποιεί τις 

ιδιότητες των σελίδων  στο παράθυρο διαλόγου Page Properties (Εικόνα 3,5) 
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ΕΙΚΟΝΑ 3,5 

(Το παράθυρο διαλόγου Page Properties σας επιτρέπει να ελέγξετε γενικές ρυθµίσεις για τις σελίδες σας) 

 

 

Για να προσπελάσετε το παράθυρο διαλόγου Page Properties από τη γραµµή των µενού επιλέξτε την εντολή 

File > Properties. To παράθυρο διαλόγου Page Properties περιέχει τέσσερις καρτέλες, κάθε µία εκ των οποίων 

ελέγχει µία διαφορετική οµάδα ιδιοτήτων. Οι περισσότερες από τις ιδιότητες θα εξεταστούν αναλυτικά σε 

επόµενα κεφάλαια, αλλά θα βρείτε µία σύντοµη περιγραφή στις ακόλουθες παραγράφους: 

 

Η καρτέλα General εµφανίζει γενικές πληροφορίες για τη σελίδα σας. Η περιοχή αυτή αναφέρει την 

τρέχουσα διεύθυνση URL της σελίδας και σας επιτρέπει να αλλάξετε τον τίτλο της (πεδίο Title) - θα µάθετε 

περισσότερα για τους τίτλους των σελίδων στην επόµενη ενότητα. Στην περιοχή αυτή µπορείτε επίσης να 

καθορίσετε τον προεπιλεγµένο προορισµό για τα πλαίσια (Default Target Frame) µιας σελίδας -µην 
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ανησυχείτε, οι όροι αυτοί θ' αρχίσουν να αποκτούν σηµασία αφού µάθετε περισσότερα για τα πλαίσια. 

Μπορείτε να χρησιµοποιείτε την περιοχή αυτή για να καθορίζετε έναν ήχο παρασκηνίου. Αυτή η καρτέλα 

περιλαµβάνει επίσης ρυθµίσεις για τη χρήση script αρχείων. 

Η καρτέλα Custom περιλαµβάνει επιλογές οι οποίες ελέγχουν την χρήση των tags ΜΕΤΑ σε µία σελίδα. 

Για περισσότερες πληροφορίες σχετικά µε τα tags ΜΕΤΑ. 

 

Η καρτέλα Language περιλαµβάνει επιλογές µε τις οποίες µπορείτε να καθορίσετε το σετ χαρακτήρων που 

θα χρησιµοποιεί η σελίδα σας όταν εµφανίζεται στο παράθυρο µιας εφαρµογής browser. 

 

Η καρτέλα Workgroup περιλαµβάνει επιλογές για µία προχωρηµένη λειτουργία του Frontpage 2000 η 

οποία σας επιτρέπει να διαµορφώσετε µία σελίδα σαν µέρος µιας οµάδας εργασίας (workgroup). Μπορείτε να 

δώσετε ένα όνοµα στην οµάδα εργασίας ή να επιλέξετε µία από τις προκαθορισµένες οµάδες που σας παρέχει 

το πρόγραµµα. Κάθε οµάδα µπορεί να αντιστοιχιστεί σε ένα άτοµο (βάσει ονόµατος) και µπορείτε να 

καθορίσετε την κατάσταση κάθε σελίδας. Σ' αυτή την περίπτωση, ο όρος "κατάσταση" αναφέρεται στο στάδιο 

ανάπτυξης µιας σελίδας. Για παράδειγµα, εάν έχει ολοκληρωθεί η συγγραφή του κώδικα για τη σελίδα, το 

επόµενο λογικό βήµα της διαδικασίας ανάπτυξης είναι συνήθως η επιµέλεια και η διόρθωση. Μπορείτε να 

καθορίσετε τα στοιχεία αυτά σαν κατάσταση για µία σελίδα. 

 

Τα Εργαλεία Επεξεργασίας Κειµένου 

 
Αν και τα γραφικά, τα πολυµέσα και τα διαλογικά χαρακτηριστικά απολαµβάνουν συνήθως τη µεγαλύτερη 

προσοχή των χρηστών, το κείµενο είναι αυτό που κρατά το Web σε συνοχή και σε διαρκή εξέλιξη. Η προβολή 

Σελίδας του Frontpage είναι ουσιαστικά ένας συντάκτης, πράγµα που σηµαίνει ότι περιέχει πολλών ειδών 

εργαλεία για τη διαχείριση του κειµένου. 

 

Όµοια µε τις εφαρµογές του Microsoft Office, το Frontpage περιλαµβάνει ισχυρές λειτουργίες επεξεργασίας 

κειµένου, συµπεριλαµβανοµένων των τυπικών λειτουργιών που θα περίµενε κανείς να βρει σε µία µοντέρνα 

Windows εφαρµογή, όπως η αποκοπή και επικόλληση (Cut/Paste), η µεταφορά και απόθεση (drag-and-drop), η 

εύρεση και αντικατάσταση (Find/Replace), ο έλεγχος ορθογραφίας και η δυνατότητα επιλογής εναλλακτικών 

λέξεων από έναν θησαυρό, θα εξετάσουµε αναλυτικά κάθε µία από αυτές τις λειτουργίες σ' αυτή την ενότητα. 
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Μετακίνηση Κειµένου σε ∆ιαφορετικές θέσεις της Σελίδας 

 
Επειδή ένα µεγάλο µέρος της διαδικασίας δηµοσίευσης υλικού στο Web επικεντρώνεται κυρίως στη 

συγγραφή και σχεδίαση εγγράφων, αναµφίβολα θα χρειαστεί να αναδιατάξετε πολλές φορές το κείµενο σας 

καθώς δηµιουργείτε τις σελίδες για µία τοποθεσία. To Frontpage εκµεταλλεύεται δύο λειτουργίες των 

Windows τις οποίες πιθανότατα γνωρίζετε και αγαπάτε: την αποκοπή και επικόλληση (cut/paste) και τη 

µεταφορά και απόθεση (drag and drop). 

Μπορείτε να χρησιµοποιείτε τις διαδικασίες αποκοπής και επικόλλησης ή µεταφοράς και απόθεσης για να 

µετακινείτε επιλεγµένα αποσπάσµατα κειµένου σε διαφορετικές θέσεις µιας ιστοσελίδας, µεταξύ δύο 

διαφορετικών Ιστοσελίδων σε προβολή Σελίδας, και µεταξύ εφαρµογών. (Για παράδειγµα, θα µπορούσατε να 

αποκόψετε κείµενο από ένα έγγραφο του Microsoft Word και να το επικολλήσετε σε µία ιστοσελίδα). Για την 

αποκοπή και επικόλληση κειµένου, ακολουθήστε τα παρακάτω βήµατα: 

1. Με ανοικτή τη σελίδα που σας ενδιαφέρει σε προβολή Σελίδας, επιλέξτε το κείµενο που θέλετε να 

µετακινήσετε. 

 

2. Από τη γραµµή των µενού, επιλέξτε την εντολή Edit > Cut (για να µετακινήσετε το κείµενο σε µία 

διαφορετική θέση), ή την εντολή Edit > Copy (για να τοποθετήσετε ένα αντίγραφο του επιλεγµένου κειµένου 

σε µία νέα θέση). 

 

3. Τοποθετήστε τον δείκτη στη θέση προορισµού στην οποία θέλετε να εµφανιστεί το κείµενο που επιλέξατε 

παραπάνω. 

 

4. Από τη γραµµή των µενού, επιλέξτε την εντολή Edit > Paste. To κείµενο εµφανίζεται στη νέα του θέση. 

 

 

 

Για τη µεταφορά και απόθεση κειµένου, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ανοικτή µία σελίδα στην προβολή Σελίδας, επιλέξτε το κείµενο που θέλετε να µετακινήσετε. 

 

2. Κάντε κλικ στην επιλεγµένη περιοχή κειµένου και κρατήστε πατηµένο το πλήκτρο του ποντικιού. Σύρετε 

τον δείκτη στην επιθυµητή θέση προορισµού, και κατόπιν ελευθερώστε το πλήκτρο του ποντικιού. Το κείµενο 

εµφανίζεται στη νέα του θέση. 
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Έλεγχος Ορθογραφίας 
 

Για να διασφαλίσετε ότι η τοποθεσία σας θα έχει όσο το δυνατόν πιο επαγγελµατική εµφάνιση, θα πρέπει 

πάντα να ελέγχετε την ορθογραφία των κειµένων σας. Και µε την ισχυρή λειτουργία ελέγχου ορθογραφίας του 

Frontpage, δεν έχετε καµία δικαιολογία για να µην το κάνετε. Ο έλεγχος ορθογραφίας είναι εύκολος, γρήγορος 

και κατά την προσωπική µου γνώµη, απαιτούµενος. 

 

Για να ελέγξετε την ορθογραφία του κειµένου των σελίδων σας, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ανοικτή µία σελίδα σε προβολή Σελίδας, επιλέξτε την εντολή Tools >- Spelling από τη γραµµή των 

µενού, ή πατήστε F7. θα εµφανιστεί το παράθυρο διαλόγου Spelling, παρουσιάζοντας την πρώτη εµφάνιση 

µιας ανορθόγραφης ή αµφισβητούµενης λέξης στο πεδίο Not In Dictionary (δεν υπάρχει στο λεξικό), όπως 

βλέπετε στην Εικόνα 3.6. 

 

 
 

ΕΙΚΟΝΑ 3,6 

Το παράθυρο διαλόγου Spelling υποδεικνύει τις λανθασµένες (ή αµφισβητούµενες) λέξεις και προτείνει τις 

διορθώσεις τους. 
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2.   To Frontpage προτείνει µία σωστή ορθογραφία στο πεδίο Change To και αναφέρει άλλες πιθανώς 

σωστές ορθογραφίες στο πλαίσιο λίστας Suggestions (υποδείξεις). Για να αποδεχτείτε την ορθογραφία που 

προτείνει το πρόγραµµα, κάντε κλικ στο κουµπί Change. Για να αλλάξετε όλες τις εµφανίσεις της 

ανορθόγραφης λέξης µονοµιάς, κάντε κλικ στο κουµπί Change All. 

 

Εναλλακτικά, 

Εάν θέλετε να αγνοήσετε την υποτιθέµενη ανορθόγραφη λέξη και να συνεχίσετε τον έλεγχο, κάντε κλικ στο 

κουµπί Ignore (παράβλεψη). Για να αγνοήσετε όλες τις εµφανίσεις αυτής της λέξης µονοµιάς, κάντε κλικ στο 

κουµπί Ignore All (παράβλεψη όλων). 

Εναλλακτικά, 

Για να προσθέσετε την αµφισβητούµενη λέξη στο λεξικό, έτσι ώστε το Frontpage να µην σας ενοχλεί µ' 

αυτή στο µέλλον, κάντε κλικ στο κουµπί Add. 

 

3. Αφού κάνετε κλικ σε ένα από τα κουµπιά, θα εµφανιστεί η επόµενη ανορθόγραφη ή αµφισβητούµενη 

λέξη στο πεδίο Not In Dictionary. Επαναλάβετε το βήµα 2 µέχρι να ολοκληρωθεί ο έλεγχος ορθογραφίας. 

 

4. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου. 

 

Χρησιµοποιώντας τον θησαυρό Λέξεων 

 

Ο θησαυρός Λέξεων (Thesaurus) του Frontpage σας βοηθά να βρίσκετε συνώνυµες και αντίθετες λέξεις για 

τη βελτίωση των κειµένων των Ιστοσελίδων σας. Καλό θα είναι να χρησιµοποιείτε το εργαλείο αυτό όταν 

χρειάζεστε µία "φρέσκια" λέξη ή διατύπωση, αλλά δεν µπορείτε να σκεφτείτε έναν εναλλακτικό τρόπο για να 

εκφράσετε τις σκέψεις σας. 

Για να χρησιµοποιήσετε τον θησαυρό λέξεων, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ανοικτή µία σελίδα στο Frontpage, κάντε κλικ στη λέξη που σας ενδιαφέρει, ή επιλέξτε τη φράση για 

την οποία θέλετε να βρείτε ένα συνώνυµο στον θησαυρό. 

 

2. Από τη γραµµή των µενού, επιλέξτε την εντολή Tools >- Thesaurus (ή πατήστε Shift+F7). θα εµφανιστεί 

το παράθυρο διαλόγου Thesaurus, µε την επιλεγµένη λέξη ή φράση στο πεδίο Looked Up (Εικόνα 3.7). 
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∆ιάφορες σηµασίες για την επιλεγµένη λέξη ή φράση εµφανίζονται στο πλαίσιο λίστας Meanings. To 

Frontpage σας προτείνει το πλησιέστερο συνώνυµο και παρουσιάζει άλλα εναλλακτικά συνώνυµα στο 

συνοδευτικό πλαίσιο λίστας. 

 

 

 

 

ΕΙΚΟΝΑ 3,7 

(Ο θυσαυρός λέξεων του Front Page σας βοηθά να γράψετε καλύτερα κείµενα) 

 

 

 

3. Εάν η επιθυµητή σηµασία δεν είναι ήδη επιλεγµένο στο πλαίσιο λίστας Meanings, κάντε κλικ σε µία 

καταλληλότερη σηµασία για τη λέξη που επιλέξατε. Στο δεξιότερο πλαίσιο λίστας θα εµφανιστούν 

διαφορετικά συνώνυµα, καταλληλότερα για την επιλεγµένη σηµασία. 

 

4. Εάν το συνώνυµο που θέλετε να χρησιµοποιήσετε δεν εµφανίζεται στο πλαίσιο κειµένου Replace With 

Synonym, κάντε κλικ στο επιθυµητό συνώνυµο στο κατάλληλο πλαίσιο λίστας και κατόπιν κάντε κλικ στο 

κουµπί Replace (αντικατάσταση). Το παράθυρο διαλόγου Thesaurus θα κλείσει, ενώ η επιλεγµένη λέξη ή 

φράση της σελίδας σας αντικαθίσταται από το συνώνυµο που µόλις επιλέξατε. 

Στο σηµείο αυτό µπορείτε να συνεχίσετε εκτελώντας οποιεσδήποτε άλλες εργασίες θέλετε στη σελίδα. 

 

Εύρεση Κειµένου 
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Καθώς δηµιουργείτε µ ία τοποθεσία γι α το Web, αναµφίβολα ορισµένες φορές θα θέλετε να αλλάζετε 

συγκεκριµένο κείµενο. Οι λειτουργίες Εύρεσης και Αντικατάστασης (Find και Replace) µπορούν να 

διευκολύνουν σηµαντικά τις γενικής έκτασης αλλαγές στο κείµενο. Συγκεκριµένα, σας επιτρέπουν να 

εντοπίζετε άµεσα όλες τις εµφανίσεις ενός ή περισσότερων χαρακτήρων, µιας λέξης, ή µιας ολόκληρης 

φράσης, και εάν θέλετε, να αντικαθιστάτε τις εµφανίσεις αυτές µε διαφορετικό κείµενο. 

Για να χρησιµοποιήσετε τη λειτουργία Εύρεσης, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ανοικτή τη σελίδα που σας ενδιαφέρει σε προβολή Σελίδας, τοποθετήστε τον δείκτη στη θέση από την 

οποία θέλετε να ξεκινήσει η αναζήτηση. (Ανόµοια µε τη λειτουργία ελέγχου ορθογραφίας η οποία ξεκινά 

πάντα από την κορυφή της σελίδας, η λειτουργία Εύρεσης ξεκινά από το σηµείο που της λέτε εσείς). 

 

2. Από τη γραµµή των µενού, επιλέξτε την εντολή Edit > Find (ή πατήστε Ctrl+F). θα εµφανιστεί το 

παράθυρο διαλόγου Find. 

 

3. Στο πεδίο Find What (εύρεση του) πληκτρολογήστε τον χαρακτήρα, τη λέξη, ή τη φράση που θέλετε να 

εντοπίσετε. 

 

4. Κάντε κλικ σε ένα από τα κουµπιά της ενότητας Find Where για να καθορίσετε εάν θέλετε η αναζήτηση 

να διεξαχθεί µόνο στην επιλεγµένη σελίδα, ή σε ολόκληρο τον ιστό. 

 

5. Εάν θέλετε η λειτουργία Εύρεσης να εντοπίσει µόνο εµφανίσεις ολόκληρων λέξεων (π.χ. εάν θέλετε να 

βρείτε τη λέξη yια, αλλά δε θέλετε η λειτουργία Εύρεσης να σταµατά όταν συναντά τη λέξη γιατρός), 

µαρκάρετε το πλαίσιο ελέγχου Find Whole Word Only (εύρεση µόνο ολόκληρων λέξεων). 

 

6. Εάν θέλετε να κάνετε διάκριση µεταξύ κεφαλαίων και πεζών χαρακτήρων, µαρκάρετε το πλαίσιο ελέγχου 

Match Case. 

 

7. Εξ ορισµού, το Frontpage ψάχνει για το αναζητούµενο κείµενο ξεκινώντας από την τρέχουσα θέση του 

δείκτη και προχωρώντας προς τα κάτω στη σελίδα. Εάν θέλετε η αναζήτηση να κινηθεί προς την αντίθετη 

κατεύθυνση, κάντε κλικ στο κουµπί Up. 

 

8. Κάντε κλικ στο κουµπί Find Next (εύρεση επόµενου). Στη σελίδα σας, ο δείκτης µεταφέρεται στην πρώτη 

εµφάνιση της αναζητούµενης λέξης ή φράσης και επιλέγει το κείµενο που βρέθηκε (το παράθυρο διαλόγου 
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Find παραµένει ορατό στην οθόνη). Για να αλλάξετε το επιλεγµένο κείµενο, κάντε κλικ στη σελίδα και κατόπιν 

κάντε οποιαδήποτε αλλαγή θέλετε. 

 

9. Για να εντοπίσετε την επόµενη εµφάνιση του αναζητουµένου κειµένου, κάντε κλικ στο κουµπί Find Next 

του παραθύρου διαλόγου Find. Ή, εάν έχετε τελειώσει, κάντε κλικ στο Cancel για να κλείσετε το παράθυρο 

διαλόγου Find. Οποιεσδήποτε αλλαγές κάνατε κατά την πορεία, θα παραµείνουν σε ισχύ. 

 

Αντικατάσταση Κειµένου 

 
Η αντικατάσταση κειµένου λειτουργεί παρόµοια µε τη διαδικασία εύρεσης κειµένου που είδατε στην 

προηγούµενη ενότητα· η µόνη διαφορά έγκειται στο γεγονός ότι το Frontpage µπορεί να αντικαταστήσει 

αυτόµατα το κείµενο που βρίσκει µε οτιδήποτε θα του πείτε εσείς. Για να βρείτε και να αντικαταστήσετε 

κείµενο, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ανοικτή µία σελίδα στην προβολή Σελίδας, τοποθετήστε τον δείκτη στη θέση από την οποία θέλετε να 

ξεκινήσει η αναζήτηση. 

 

2. Από τη γραµµή των µενού επιλέξτε την εντολή Edit >Replace (ή πατήστε Ctrl +H). θα εµφανιστεί το 

παράθυρο διαλόγου Replace. 

 

 
 

 

3. Στο πεδίο Find What πληκτρολογήστε τον χαρακτήρα, τη λέξη, ή τη φράση που θέλετε να βρείτε. 

 

4. Στο πεδίο Replace With (αντικατάσταση µε...) πληκτρολογήστε το κείµενο που θέλετε να 

χρησιµοποιήσετε σαν υποκατάστατο του κειµένου που θα βρεθεί. 
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5. Εάν θέλετε να εντοπίσετε µόνο τις εµφανίσεις ολόκληρων λέξεων, µαρκάρετε το πλαίσιο ελέγχου Find 

Whole Word Only. 

 

6. Εάν θέλετε να κάνετε διάκριση µεταξύ κεφαλαίων και πεζών χαρακτήρων, µαρκάρετε το πλαίσιο ελέγχου 

Match Case. 

 

7. Κάντε κλικ στο κουµπί Find Next. Στη σελίδα, ο δείκτης µετακινείται και επιλέγει την πρώτη εµφάνιση 

του αναζητουµένου κειµένου. 

 

8. Για να αντικαταστήσετε αυτό το κείµενο, κάντε κλικ στο κουµπί Replace. Ιδού! Το επιλεγµένο κείµενο 

της σελίδας αντικαθίσταται αµέσως µε το κείµενο που εσείς καθορίσατε στο παράθυρο διαλόγου. 

 

 

 

9. Συνεχίστε την εύρεση και αντικατάσταση κειµένου, µέχρι να τελειώσετε. Κατόπιν κάντε κλικ στο Cancel 

για να κλείσετε το παράθυρο διαλόγου Replace. 

Μπορείτε τώρα να επιστρέψετε στις συνήθεις εργασίες δηµιουργίας σελίδων. 

 

 

Αποθήκευση Σελίδων 
 

Η αποθήκευση της εργασίας σας είναι φυσικά η πιο σηµαντική εργασία που θα πρέπει να κάνετε για 

οποιοδήποτε έργο ολοκληρώνετε µε τον υπολογιστή. Στο κάτω κάτω θέλετε να διατηρήσετε το αποτέλεσµα 

των δηµιουργικών προσπαθειών σας, σωστά; 

Καλό θα είναι να αποθηκεύετε τη δουλειά σας από νωρίς και συχνά· θα αισθανθείτε ιδιαίτερα ευτυχείς γι' 

αυτή τη συνήθεια που αποκτήσατε εάν πάθει κάποια βλάβη ο υπολογιστής σας. 

 

 

Αποθήκευση Σελίδας στον Τρέχοντα Ιστό του Frontpage 
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Εξ ορισµού, το Frontpage αποθηκεύει όλες τις νέες ιστοσελίδες σαν µέρος του τρέχοντος ιστού. (To 

Frontpage θεωρεί τις σελίδες που ανοίγετε απευθείας από το World Wide Web, ή τις µετατρέπετε από άλλους 

τύπους αρχείων, σαν νέες ιστοσελίδες). 

 Ωστόσο, εάν ανοίξατε αρχικά την ιστοσελίδα από τον υπολογιστή σας ή από το τοπικό δίκτυο στο οποίο 

συνδέεστε, θα πρέπει να πείτε ρητά στο Frontpage να αποθηκεύσει τη σελίδα αυτή σαν µέρος του τρέχοντος 

ιστού η διαδικασία δε γίνεται αυτόµατα, όπως ισχύει για τις νέες ιστοσελίδες. 

Για να αποθηκεύσετε µία σελίδα σαν µέρος του τρέχοντος ιστού του Frontpage, βεβαιωθείτε ότι είναι 

ανοικτή σε προβολή Σελίδας και κατόπιν ακολουθήστε τα παρακάτω βήµατα: 

 

1. Από τη γραµµή των µενού, επιλέξτε την εντολή File >· Save As. θα εµφανιστεί το παράθυρο διαλόγου 

Save As (αποθήκευση ως), το οποίο βλέπετε στην Εικόνα 3.8, παρουσιάζοντας τα περιεχόµενα του τρέχοντος 

ιστού του Frontpage. To πεδίο URL περιέχει το όνοµα αρχείου της σελίδας, ενώ το πεδίο Title εµφανίζει τον 

τίτλο της. 

 

2. Εάν δεν έχετε αποθηκεύσει αυτή τη σελίδα ποτέ •πριν, θα πρέπει να πληκτρολογήστε ένα όνοµα αρχείου 

στο πεδίο URL. Για το όνοµα αρχείου της σελίδας µπορείτε να χρησιµοποιήσετε οποιονδήποτε συνδυασµό 

αλφαβητικών και αριθµητικών χαρακτήρων ωστόσο, οι περισσότεροι χαρακτήρες στίξης δεν είναι έγκυροι για 

τα ονόµατα αρχείων.  

Συνηθίζεται να χρησιµοποιούνται πεζά γράµµατα, ή µόνο το πρώτο γράµµα κεφαλαίο, σε ένα όνοµα 

αρχείου. Αλλά θα πρέπει να συµπεριλάβετε οπωσδήποτε την επέκταση .htm, ή .html, στο όνοµα αρχείου. 
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ΕΙΚΟΝΑ 3,8 

(Το παράθυρο διαλόγου Save As σας επιτρέπει να καθορίσετε που θα αποθηκεύσετε την τρέχουσα σελίδα)  

 

3. Εάν η σελίδα έχει ήδη αποθηκευτεί και στο παρελθόν σαν µέρος ενός ιστού, τότε θα έχει έναν τίτλο στο 

πεδίο Title. Μπορείτε να αλλάξετε τον τίτλο κάνοντας κλικ στο κουµπί Change δίπλα στην καταχώριση Page 

Title. Στο πεδίο Title πληκτρολογήστε έναν σύντοµο αλλά περιγραφικό τίτλο.  

 

4. Κάντε κλικ στο ΟΚ. Το παράθυρο διαλόγου θα κλείσει και η σελίδα σας αποθηκεύεται σαν µέρος του 

τρέχοντος ιστού του Frontpage. 

Τώρα που η σελίδα σας είναι αποθηκευµένη, µπορείτε να συνεχίσετε την εργασία σας µ' αυτή ως συνήθως. 

Για να αποθηκεύσετε τις επόµενες αλλαγές που θα κάνετε στη σελίδα, κάντε απλώς κλικ στο κουµπί Save της 

Βασικής γραµµής εργαλείων και η δουλειά σας θα αποθηκευτεί χωρίς να σας ζητηθεί να καθορίσετε τίποτα. 

 

Αποθήκευση Σελίδας σαν Αρχείο 

 
Μπορείτε πολύ εύκολα να παρακάµψετε τον τρέχοντα ιστό του Frontpage και να αποθηκεύσετε µία σελίδα 

σε µία συγκεκριµένη θέση του υπολογιστή σας, ή του τοπικού δικτύου σας. Ακολουθήστε τα παρακάτω 

βήµατα: 

 

1. Με τη σελίδα που σας ενδιαφέρει ανοικτή σε προβολή Σελίδας - εάν η σελίδα είναι νέα - κάντε κλικ στο 

κουµπί" Save της Βασικής γραµµής εργαλείων.  

Εναλλακτικά, 

Εάν ανοίξατε αρχικά τη σελίδα από µία θέση του υπολογιστή σας ή του τοπικού δικτύου σας και θέλετε να 

αποθηκεύσετε το αρχείο της σε µία διαφορετική θέση, επιλέξτε File > Save As. (To κλικ στο κουµπί Save 

αποθηκεύει απλώς τις αλλαγές που έχουν γίνει στη σελίδα, στην αρχική θέση αποθήκευσης της), θα εµφανιστεί 

το παράθυρο διαλόγου Save As. 

2. Στο παράθυρο διαλόγου Save As, κινηθείτε µέσα στο σύστηµα αρχείων του υπολογιστή ή του δικτύου 

σας για να εντοπίσετε και να επιλέξετε τη θέση στην οποία θέλετε να αποθηκεύσετε το αρχείο. 

 

3. Κάντε κλικ στο κουµπί Save. 
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4. Το παράθυρο διαλόγου Save As File καθώς και το παράθυρο διαλόγου Save As θα κλείσουν, ενώ το 

Frontpage αποθηκεύει το αρχείο της σελίδας στην επιλεγµένη θέση. 

 

Τώρα που η σελίδα σας είναι αποθηκευµένη, µπορείτε να συνεχίσετε την εργασία σας µ' αυτή ως συνήθως. 

Για να αποθηκεύσετε στην ίδια θέση τις επόµενες αλλαγές που θα κάνετε στη σελίδα, χρησιµοποιήστε το 

κουµπί Save της γραµµής εργαλείων. 

 

 

 

Αποθήκευση Ιστοσελίδας σαν Πρότυπο 

 
Εάν προσθέτετε τακτικά σελίδες στην τοποθεσία σας χρησιµοποιώντας µία στάνταρ εµφάνιση ή στάνταρ 

συστατικά στοιχεία (π.χ. την ίδια σηµείωση copyright σε κάθε σελίδα), µπορείτε να γλιτώσετε αρκετό χρόνο 

και κόπο αποθηκεύοντας το στάνταρ υλικό σαν ένα πρότυπο (template). Αφού αποθηκεύσετε µία σελίδα σαν 

πρότυπο, το πρότυπο αυτό θα εµφανίζεται µαζί µε τα άλλα πρότυπα του Frontpage στο παράθυρο διαλόγου 

New (ανατρέξτε στην ενότητα µε τίτλο "∆ηµιουργία Νέας Σελίδας στην Προβολή Σελίδας" εάν θέλετε να 

φρεσκάρετε τη µνήµη σας σχετικά µε το παράθυρο διαλόγου New). 

Για να αποθηκεύσετε µία σελίδα σαν πρότυπο, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Από τη γραµµή των µενού επιλέξτε την εντολή File > Save As. θα εµφανιστεί το παράθυρο διαλόγου 

Save As. 

 

2. Στο παράθυρο διαλόγου, κάντε κλικ στο κουµπί µε το κάτω βέλος στα δεξιά της αναδιπλούµενης λίστας 

Save As Type (αποθήκευση ως τύπος) για να την ανοίξετε. Από την αναδιπλούµενη λίστα επιλέξτε την 

καταχώριση Frontpage Template (*.tem). ∆ώστε ένα όνοµα στο αρχείο, θα εµφανιστεί το παράθυρο διαλόγου 

Save As Template (αποθήκευση ως πρότυπο). 

 

3. Στο πεδίο Title πληκτρολογήστε έναν περιγραφικό τίτλο για το πρότυπο. Ο τίτλος αυτός θα 

χρησιµοποιείται για την περιγραφή του προτύπου στο παράθυρο διαλόγου New, οπότε εάν καθορίσετε ένα 

όνοµα που ξεκινά µε τον χαρακτήρα Α ή µε µία κάτω παύλα, το εξειδικευµένο πρότυπο σας θα αναφέρεται 

στην κορυφή της λίστας των προτύπων, πράγµα το οποίο καθιστά ευκολότερη την ανεύρεση του. 

 

4. Στο πεδίο Name εισάγετε ένα σύντοµο, µονολεκτικό όνοµα (το όνοµα αρχείου κατασκευάζεται από τη 

λέξη που επιλέγετε). 
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5. Στο πεδίο Description εισάγετε µία σύντοµη περιγραφή για τη διάταξη ή τη λειτουργία του προτύπου. Η 

περιγραφή αυτή θα υπενθυµίζει τόσο σ' εσάς, όσο και στους συνεργάτες σας, τον σκοπό ή τη λειτουργία αυτού 

του προτύπου. 

 

6. Κάντε κλικ στο ΟΚ. Τα παράθυρα διαλόγου Save As Template και Save As θα κλείσουν. 

 

7. Προσαρµόστε το πρότυπο όπως θέλετε και κατόπιν κάντε κλικ στο κουµπί Save της γραµµής εργαλείων 

για να αποθηκεύσετε τις αλλαγές σας. Εναλλακτικά, επιλέξτε την εντολή File > Close για να κλείσετε το νέο 

πρότυπο που µόλις αποθηκεύσατε. 

Την επόµενη φορά που θα θελήσετε να δηµιουργήσετε µία νέα σελίδα βασισµένη σε ένα πρότυπο, το όνοµα 

του εξειδικευµένου προτύπου σας θα αναφέρεται στο παράθυρο διαλόγου New. 

 

 

Προεπισκόπηση Σελίδας 
 

Καθώς αναπτύσσετε έναν ιστό σελίδων, η σελίδα µε την οποία δουλεύετε την τρέχουσα στιγµή θα 

εµφανίζεται στο παράθυρο του Συντάκτη, µε µία µορφή παρόµοια µ' αυτή που θα βλέπουν οι χρήστες 

εφαρµογών browser όπως ο Internet Explorer της Microsoft, ή το Netscape Navigator. Για να δείτε πώς 

ακριβώς θα δείχνει η σελίδα σας αφού τη δηµοσιεύσετε, θα πρέπει να την εµφανίσετε σε προεπισκόπηση 

(preview). 

Μπορείτε να εµφανίσετε σε προεπισκόπηση µία σελίδα χρησιµοποιώντας την καρτέλα Preview, ή 

ξεκινώντας µια εφαρµογή εξερεύνησης του Web και ανάγνωσης Ιστοσελίδων (browser), στο παράθυρο της 

οποίας θα εξετάσετε τη σελίδα σας. Ας δούµε πώς δουλεύει αυτό. 

 

Προεπισκόπηση Σελίδας µε την Καρτέλα Preview 
 

Εάν έχετε εγκαταστήσει τον Internet Explorer της Microsoft στον υπολογιστή σας, θα εµφανίζεται µία 

καρτέλα µε όνοµα Preview (προεπισκόπηση) στην κάτω αριστερή γωνία του παραθύρου της προβολής 

Σελίδας. Κάντε κλικ σ' αυτή την καρτέλα για να δείτε πώς ακριβώς θα δείχνει η τρέχουσα ανοικτή σελίδα όταν 
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ένας χρήστης θα την εµφανίζει στο παράθυρο του Internet Explorer. Η επιλογή αυτή είναι ιδιαίτερα βολική για 

τη γρήγορη εξέταση των σελίδων σας. 

 

Εξέταση Σελίδας µε µία Εφαρµογή Browser 
 

Εάν δεν έχετε την καρτέλα Preview, ή εάν θέλετε να δείτε πώς ακριβώς θα δείχνει η σελίδα σας στους 

χρήστες που χρησιµοποιούν διαφορετικές εφαρµογές browser (εκτός του Internet Explorer), ή εάν θέλετε 

απλώς να δείτε µε ακρίβεια ένα δείγµα προεπισκό-πησης της σελίδας, µπορείτε να ξεκινήσετε µία ξεχωριστή 

εφαρµογή browser και να εµφανίσετε τη σελίδα σας στο παράθυρο της. Σας συνιστούµε να χρησιµοποιείτε 

αυτή τη µέθοδο επειδή σας επιτρέπει να ελέγχετε την εµφάνιση των σελίδων σας τόσο στο Netscape Navigator, 

όσο και στον Internet Explorer, καθώς επίσης και σε οποιεσδήποτε άλλες εφαρµογές browser είναι πιθανό να 

χρησιµοποιείτο ακροατήριο της τοποθεσίας σας. 

Για να εξετάσετε σε προεπισκόπηση τη σελίδα σας χρησιµοποιώντας µία εφαρµογή browser, ακολουθήστε 

τα παρακάτω βήµατα: 

 

1. Από τη γραµµή των µενού επιλέξτε την εντολή File >· Preview In Browser, θα εµφανιστεί το παράθυρο 

διαλόγου Preview In Browser. Η περιοχή Browser του παραθύρου διαλόγου αναφέρει τις διάφορες εφαρµογές 

browser που είναι εγκατεστηµένες στον υπολογιστή σας. 

 

2. Στο πλαίσιο λίστας Browser κάντε κλικ στο όνοµα της εφαρµογής browser που θέλετε να 

χρησιµοποιήσετε για την εξέταση της σελίδας. (Μπορείτε να προσθέσετε περισσότερες εφαρµογές browser σ' 

αυτό το πλαίσιο λίστας). 

 

3. Στην περιοχή Window Size κάντε κλικ στο στρογγυλό κουµπί που περιγράφει την ανάλυση οθόνης που 

θέλετε να προσοµοιώνει το παράθυρο της εφαρµογής browser. 

 

4. Για να ζητήσετε από το Frontpage να αποθηκεύει τις αλλαγές που κάνετε στη σελίδα κάθε φορά που την 

εξετάζετε σε προεπισκόπηση, µαρκάρετε το πλαίσιο ελέγχου Automatically Save Page. 

 

5. Κάντε κλικ στο κουµπί Preview. To παράθυρο διαλόγου θα κλείσει και η επιλεγµένη εφαρµογή browser 

θα ξεκινήσει και θα εµφανίσει τη σελίδα στο παράθυρο της. 
 

Εάν θέλετε να κάνετε αλλαγές στις σελίδες που εξετάζετε σε προεπισκόπηση, επιστρέψτε στο Frontpage. 

Κάντε τις αλλαγές σας σε προβολή Σελίδας, αποθηκεύστε τη σελίδα και κατόπιν επιστρέψτε στην εφαρµογή 
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browser για να τις ελέγξετε. Για να δείτε την ενηµερωµένη έκδοση της σελίδας θα πρέπει να την 

ξαναφορτώσετε (από τη γραµµή εργαλείων της εφαρµογής browser επιλέξτε το κουµπί Reload ή Refresh). 

Μπορείτε να συνεχίσετε αυτή τη διαδικασία εναλλαγής µεταξύ της εφαρµογής browser και του Frontpage, 

µέχρι να τελειοποιήσετε τη σελίδα σας. 
 

Για να εξετάσετε στα γρήγορα σε προεπισκόπηση τη σελίδα σας (χρησιµοποιώντας τις ρυθµίσεις που 

καθορίσατε την τελευταία φορά στο παράθυρο διαλόγου Preview In Browser), κάντε κλικ στο κουµπί Preview 

In Browser της Βασικής γραµµής εργαλείων. 

 
 
 
 
 

 

Ξεκινώντας 

 
Στο προηγούµενο κεφάλαιο µάθατε πώς να χειρίζεστε τα εργαλεία επεξεργασίας και πώς να δηµιουργείτε 

νέες ιστοσελίδες στο Frontpage. Είστε τώρα έτοιµοι να εφαρµόσετε αυτές τις βασικές γνώσεις στην πράξη και 

να δουλέψετε µε συγκεκριµένα χαρακτηριστικά των σελίδων. Όπως εξηγήσαµε , η προβολή Σελίδας θα είναι η 

κεντρική θέση από την οποία θα καθορίζετε τη διάταξη για µία σελίδα και θα παράγετε τα HTML έγγραφα - 

τις ιστοσελίδες - που θα αποτελέσουν τελικά την τοποθεσία σας. Το κεφάλαιο αυτό θα σας δείξει πώς µπορείτε 

να προσθέτετε βασικά στοιχεία σε µία σελίδα, όπως το κείµενο και οι εικόνες, καθώς επίσης και πώς µπορείτε 

να µορφοποιείτε αυτά τα στοιχεία, θα µάθετε επίσης πώς να δουλεύετε µε τους συνδέσµους (links) - αυτή 

άλλωστε είναι η ουσία του Web. 

 

Άνοιγµα Υπάρχουσας Ιστοσελίδας 

 
Είναι πολύ πιθανό να έχετε ξεκινήσει ήδη τη δηµιουργία σελίδων είτε µε µία προηγούµενη έκδοση του 

Frontpage, είτε µε κάποιον άλλο συντάκτη HTML, ή απλό συντάκτη κειµένων. Εάν θέλετε να ξεκινήσετε την 

πορεία σας στο Frontpage µε ένα έργο υπό εξέλιξη, ακολουθήστε απλώς τα παρακάτω βήµατα: 
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1. Ανοίξτε ή δηµιουργήστε έναν ιστό (web) του Frontpage χρησιµοποιώντας την προβολή Σελίδας. 

 

2. Από τη γραµµή των µενού επιλέξτε την εντολή File > Open (ή πατήστε Ctrl+0)  θα εµφανιστεί το 

παράθυρο διαλόγου Open. 

 

3. Κινηθείτε στη λίστα των αρχείων/φακέλων του υπολογιστή σας µέχρι να εντοπίσετε το αρχείο µε το 

οποίο θέλετε να δουλέψετε (κατά πάσα πιθανότητα θα έχει επέκταση .him ή .html). Επιλέξτε το αρχείο αυτό 

και κάντε κλικ στο κουµπί Open για να εµφανίσετε την ιστοσελίδα του στην προβολή Σελίδας του Frontpage. 

Ανάλογα µε τα βήµατα που ακολουθήσατε, θα πρέπει να δείτε είτε µία νέα, κενή σελίδα, είτε µία 

υπάρχουσα σελίδα στο παράθυρο της προβολής Σελίδας. Γενικά, αυτή είναι η µόνη διαδικασία που απαιτείται 

για το άνοιγµα µιας ιστοσελίδας στο Frontpage. Είστε τώρα έτοιµοι να ξεκινήσετε την προσθήκη κειµένου και 

εικόνων στη σελίδα σας. 

 

 

 

∆ηµιουργία Νέας Σελίδας 

 
Εάν θέλετε να δηµιουργήσετε µία ιστοσελίδα από την αρχή, ακολουθήστε τα παρακάτω βήµατα για να 

δηµιουργήσετε µία νέα σελίδα στον τρέχοντα ιστό του Frontpage: 

 

1. Για να δηµιουργήσετε ένα νέο αρχείο, επιλέξτε την εντολή File > New > Page (δηµιουργία ιστοσελίδας). 

 

2. Από την καρτέλα General του παραθύρου διαλόγου επιλέξτε το επιθυµητό πρότυπο για τη δηµιουργία της 

σελίδας σας. Εγώ θα επιλέξω το πρότυπο Three-Column Staggered (για τρίστηλη σελίδα). 

 

3. Κάντε κλικ στο ΟΚ. Η σελίδα θα ανοίξει στην περιοχή επεξεργασίας, µε το προεπιλεγµένο όνοµα 

newpage1.htm. θα δείτε επίσης γραµµές πλέγµατος, "πλασµατικό" κείµενο (άνευ σηµασίας κείµενο το οποίο θα 

αντικαταστήσετε µε το δικό σας περιεχόµενο) και, ανάλογα µε το πρότυπο σελίδας που επιλέξατε στο βήµα 2 

παραπάνω, ορισµένα γραφικά ή εικόνες. 

 

Εξέταση του HTML Κώδικα που Κρύβεται Πίσω από τη Σελίδα σας 
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Στο σηµείο αυτό θα πρέπει να έχετε έναν ιστό ή µία ιστοσελίδα. Είστε τώρα έτοιµοι να αρχίσετε την 

προσθήκη κειµένου και εικόνων και να ασχοληθείτε µε τη διαχείριση αυτών των στοιχείων στις σελίδες σας. 

Πριν όµως σας δείξουµε πώς µπορείτε να κάνετε όλα αυτά τα πράγµατα, πιστεύουµε ότι θα πρέπει να µπορείτε 

να εξετάζετε και να κατανοείτε τον τρόπο µε τον οποίο τοποθετείται το κείµενο και οι εικόνες σε µία σελίδα. 

Εκτός από το φιλικό, εύχρηστο και άµεσο περιβάλλον επεξεργασίας Ιστοσελίδων που σας παρέχει, η 

προβολή Σελίδας σας επιτρέπει να δουλεύετε απευθείας µε τον υποκείµενο HTML κώδικα - τον κώδικα που 

λέει στην εφαρµογή browser πού θα εµφανίσει το κείµενο, τις εικόνες και οποιαδήποτε άλλα στοιχεία του 

περιεχοµένου. Όταν χρησιµοποιείτε το Frontpage δεν είστε υποχρεωµένοι να παραµείνετε µόνο στην προβολή 

Σελίδας, αλλά µπορείτε επίσης να ρίχνετε µία µατιά "στα παρασκήνια" για να εξετάζετε τον κώδικα ή για να 

προσθέτετε µόνοι σας νέο κώδικα. Αυτό σηµαίνει ότι µπορείτε να εισάγετε HTML κώδικα ο οποίος δεν 

υποστηρίζεται άµεσα από το Frontpage, να ελέγξετε την εργασία σας, ή ακόµη και να κάνετε αλλαγές στον 

κώδικα µιας σελίδας. 

Για να εξετάσετε τον HTML κώδικα που κρύβεται πίσω από τη σελίδα σας και να τον ανοίξετε για 

επεξεργασία, βεβαιωθείτε ότι έχετε ανοικτή τη σελίδα που σας ενδιαφέρει σε προβολή Σελίδας. Κατόπιν 

επιλέξτε την καρτέλα HTML. Γα περιεχόµενα του παραθύρου αλλάζουν, παρουσιάζοντας πλέον τον πηγαίο 

HTML κώδικα για την τρέχουσα σελίδα. 

Μπορείτε τώρα να κάνετε αλλαγές πληκτρολογώντας νέο ή τροποποιηµένο HTML κώδικα απευθείας στην 

προβολή Σελίδας. Μπορείτε επίσης να διαγράψετε αποσπάσµατα HTML κώδικα επιλέγοντας τα και πατώντας 

το πλήκτρο Delete. 

 

 

Προσθήκη Κειµένου σε µία Σελίδα 

 
Για να προσθέσετε κείµενο στη σελίδα σας, ανοίξτε απλώς την ιστοσελίδα που σας ενδιαφέρει και 

ξεκινήστε την πληκτρολόγηση του κειµένου σε προβολή Σελίδας. Μπορείτε επίσης να αντιγράψετε (copy), ή 

να αποκόψετε (cut) κείµενο από ένα απλό αρχείο κειµένου, ένα έγγραφο του Microsoft Word, ένα µήνυµα 

ηλεκτρονικού ταχυδροµείου, ή κάποια άλλη ιστοσελίδα, και κατόπιν να το επικολλήσετε (paste) στην 

τρέχουσα σελίδα µε την οποία δουλεύετε. Ακολουθήστε απλώς τα παρακάτω βήµατα: 

 

1. Ανοίξτε το έγγραφο το οποίο έχει ήδη το περιεχόµενο που θέλετε να µεταφέρετε στην ιστοσελίδα σας. 
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2. Επιλέξτε το επιθυµητό κείµενο και από τη γραµµή των µενού της άλλης εφαρµογής, επιλέξτε την εντολή 

Edit >- Copy (ή πατήστε Ctrl+C). 

 

3. Επιστρέψτε στο παράθυρο της προβολής Σελίδας του FrontPage χρησιµοποιώντας τη γραµµή εργασιών 

των Windows, ή πατώντας Alt+Tab. 

 

4. Κάντε κλικ στο παράθυρο της προβολής Σελίδας για να τοποθετήσετε το σηµείο εισαγωγής στην 

κατάλληλη θέση και επιλέξτε την εντολή Edit > Paste (ή πατήστε Ctrl +V) για να επικολλήσετε ένα αντίγραφο 

του κειµένου. Το κείµενο εµφανίζεται στο παράθυρο. 

 

Αυτό ήταν όλο - η διαδικασία δε διαφέρει σε τίποτα από την αντιγραφή κειµένου από µία θέση ενός 

εγγράφου σε µία διαφορετική θέση 

 

 

 

 

. 

Παράγραφοι Κειµένου 

 
Οι παράγραφοι χρησιµοποιούνται σαν ένα µέσο για τη λογική οµαδοποίηση του κειµένου σε όλων των 

ειδών τα έγγραφα, και η δηµιουργία παραγράφων σε ένα κείµενο δεν είναι καθόλου πολύπλοκη υπόθεση. Η 

προβολή Σελίδας υποστηρίζει αναδίπλωση του κειµένου (wrap text) σε επόµενη γραµµή, παρόµοια µε τις 

µοντέρνες εφαρµογές επεξεργασίας κειµένου. Πληκτρολογείτε απλά το κείµενο σας και αυτό συνεχίζει 

αυτόµατα σε επόµενη γραµµή, µέσα στο παράθυρο. Για να δηµιουργήσετε µία νέα παράγραφο, πατάτε το 

πλήκτρο Enter στο κατάλληλο σηµείο. 

Στην HTML, οι αλλαγές παραγράφων δε σηµαίνουν το ίδιο πράγµα όπως στο έντυπο κείµενο. Για 

παράδειγµα, δεν υπάρχει στάνταρ µηχανισµός (π.χ. στηλοθέτες ή περιθώρια) για την προσθήκη εσοχών στην 

αρχή των παραγράφων. Γενικά, η µέθοδος που χρησιµοποιείται για να υποδεικνύει την αλλαγή παραγράφων 

στο κείµενο είναι µία κενή γραµµή µεταξύ των παραγράφων, αν και οι σχολαστικοί σχεδιαστές υλικού για το 

Web καταφέρνουν συνήθως να βρουν κάποιο τρόπο για να δηµιουργήσουν την ψευδαίσθηση των εσοχών ή να 

υλοποιήσουν άλλες καθιερωµένες συµβάσεις του έντυπου κειµένου. θα µάθετε περισσότερα για τη διαχείριση 

των παραγράφων του κειµένου σε επόµενες ενότητες αυτού του κεφαλαίου, οι οποίες ασχολούνται µε τη 

στοίχιση και τα µη-διακοπτόµενα διαστήµατα. 
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Εισαγωγή Αλλαγών Παραγράφων 

 
Η HTML αντιµετωπίζει τις παραγράφους λίγο διαφορετικά απ' ότι το έντυπο κείµενο και οι επεξεργαστές 

κειµένων. Οι παράγραφοι στη HTML δεν είναι κατ' ανάγκην οι στάνταρ µονάδες "τριών περίπου συνεκτικών 

προτάσεων" όπως µαθαίναµε στη γραµµατική του δηµοτικού - είναι οπτικά διαχωρισµένες µονάδες 

ξεχωριστών στοιχείων πάνω σε µία σελίδα, ανεξάρτητα από το εάν τα στοιχεία αυτά είναι κείµενο, γραφικά, ή 

οτιδήποτε άλλο. Μπορείτε ακόµη και να χρησιµοποιείτε αλλαγές παραγράφων για να διαχωρίζετε ενότητες 

κειµένου από εικόνες, ή εικόνες από άλλα γραφικά. 

Ενώ βρίσκεστε σε προβολή Σελίδας, η εισαγωγή µιας αλλαγής παραγράφου (paragraph break) είναι τόσο 

απλή υπόθεση, όσο το πάτηµα του πλήκτρου Enter. Η προκαθορισµένη συµπεριφορά του πλήκτρου Enter στην 

προβολή Σελίδας είναι η δηµιουργία µιας αλλαγής παραγράφου, η οποία στην HTML υποδεικνύεται µε το tag 

<P>. θα µπορούσατε να δείτε αυτό το tag εάν εξετάζατε τον πηγαίο κώδικα της σελίδας σας.  

 

 

 

Χρήση Ειδικών Χαρακτήρων 
 

Ορισµένα σύµβολα, τα οποία είναι γνωστά σαν ειδικοί χαρακτήρες (special characters), χρησιµοποιούνται 

ευρέως στα κείµενα αλλά δεν εµφανίζονται στο πληκτρολόγιο. Οι εφαρµογές επεξεργασίας κειµένου παρέχουν 

γενικώς αυτά τα σύµβολα µέσω ενός ειδικού µενού ή µέσω µιας ειδικής γραµµατοσειράς συµβόλων. 

∆υστυχώς, η γλώσσα HTML δεν αναγνωρίζει αυτά τα σύµβολα· εάν επιχειρήσετε να τα επικολλήσετε από ένα 

έγγραφο επεξεργασίας κειµένου σε µία ιστοσελίδα, τα σύµβολα αυτά απλώς δε θα εµφανιστούν. Συχνά µπορεί 

να θέλετε να χρησιµοποιήσετε το σύµβολο © για να υποδηλώσετε το copyright κειµένου ή οποιουδήποτε 

άλλου υλικού, ή το σύµβολο ™ για τα εµπορικά σήµατα. Σε άλλες περιπτώσεις µπορεί να θέλετε να 

χρησιµοποιήσετε ξενόγλωσσους τονούµενους χαρακτήρες, εάν δουλεύετε µε πολυγλωσσικά κείµενα. 

Ακριβώς όπως η HTML διαθέτει κωδικούς για τον έλεγχο της µορφοποίησης του κειµένου, σας παρέχει 

επίσης ειδικούς κωδικούς, τους αποκαλούµενους χαρακτήρες διαφυγής (escape characters) για την παραγωγή 

των ειδικών χαρακτήρων που δεν προβλέπονται στο πληκτρολόγιο. ∆εν πρόκειται για tags, αλλά για κωδικούς 
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οι οποίοι λένε σε µία εφαρµογή browser ότι στη θέση τους θα πρέπει να εµφανίσει έναν ειδικό χαρακτήρα. To 

Frontpage διευκολύνει την εισαγωγή αυτών των ειδικών χαρακτήρων µε ένα παράθυρο διαλόγου παρόµοιο µε 

το παράθυρο διαλόγου που εµφανίζει η εντολή  Insert > Symbol του Word. 

 

 

 Στην πραγµατικότητα, το Frontpage διαθέτει τη δική του εντολή Insert >Symbol γι' αυτό ακριβώς τον 

σκοπό!  

Ακολουθήστε απλώς τα παρακάτω βήµατα για να τη χρησιµοποιήσετε: 

 

1. Από τη γραµµή των µενού της προβολής Σελίδας, επιλέξτε την εντολή Insert > Symbol, θα εµφανιστεί το 

παράθυρο διαλόγου Symbol. 

 

2. Εντοπίστε το ειδικό σύµβολο που θέλετε να εισάγετε στη σελίδα σας, κάντε κλικ πάνω του και κατόπιν 

κάντε κλικ στο Insert. To σύµβολο θα εµφανιστεί στο έγγραφο σας. (Ορισµένες φορές το παράθυρο διαλόγου 

Symbol µπορεί να κρύβει το εισαγόµενο σύµβολο, οπότε ψάξτε προσεκτικά πριν αποφασίσετε ότι η διαδικασία 

εισαγωγής έχει αποτύχει). 

 

3. Κάντε κλικ στο Close για να κλείσετε το παράθυρο διαλόγου και να επιστρέψετε στην προβολή Σελίδας. 

 

Ενώ το κείµενο είναι ουσιαστικά το "ψαχνό" µιας ιστοσελίδας, θα µπορούσαµε να πούµε ότι οι εικόνες και 

τα γραφικά είναι τα διάφορα µπαχαρικά και καρυκεύµατα. Οι εικόνες και γενικότερα τα γραφικά µπορούν να 

χρησιµοποιούνται για να ενδυναµώνουν το µήνυµα που θέλετε να µεταδώσετε και για να αυξάνουν το οπτικό 

ενδιαφέρον της σελίδας σας, καθιστώντας τη µία αξιοµνηµόνευτη ηλεκτρονική εµπειρία. 

∆ουλεύοντας µε Εικόνες 
 

To Web δεν είναι απλά και µόνο κείµενο και δεσµοί υπερκειµένου. Μία µοντέρνα τοποθεσία στο Web 

σχεδιάζεται βασιζόµενη σ' έναν µεγάλο βαθµό σε γραφικά στοιχεία. Για να προσδώσετε µεγαλύτερο οπτικό 

ενδιαφέρον στις ιστοσελίδες σας µπορείτε να χρησιµοποιείτε γραφικά και εικόνες αποθηκευµένα σε έναν ιστό 

του Frontpage, στον σκληρό σας δίσκο, ή σε µία τοποθεσία του Internet. Εναλλακτικά, θα µπορούσατε να 

καλλωπίσετε τη σελίδα σας µε προκατασκευασµένες εικόνες και γραφικά στοιχεία από τη συλλογή Clip Art 

Gallery του Frontpage, την οποία θα εξετάσουµε στη συνέχεια. 
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  H Συλλογή Έτοιµων Εικόνων Clip Art του Frontpage 

 

Στο Web κυκλοφορούν πολλές συλλογές έτοιµων εικόνων clip art, οι οποίες δεν έχουν να ζηλέψουν τίποτα 

από τις συλλογές εικόνων clip art που κυκλοφορούν σε µορφή βιβλίου και χρησιµοποιούνται από 

επαγγελµατίες γραφίστες και σχεδιαστές σε πολλά είδη εντύπων. ∆υστυχώς, δεν έχουν όλοι οι άνθρωποι το 

καλλιτεχνικό αισθητήριο ή το ταλέντο για να δηµιουργήσουν πρωτότυπες εικόνες για τις ιστοσελίδες τους· για 

τον λόγο αυτό, το να έχετε στη διάθεση σας µία βιβλιοθήκη έτοιµων ψηφιακών εικόνων µπορεί να σας 

εξοικονοµήσει χρόνο και κόπο, επιτρέποντας σας να γεµίσετε µε ελκυστικό και αποτελεσµατικό τρόπο τα κενά 

των Ιστοσελίδων σας. To Frontpage περιλαµβάνει µία συλλογή εικόνων clip art (Clip Art Gallery) η οποία 

περιέχει µικρότερες συλλογές απλών εικονιδίων, κουµπιών, γραµµικών γραφικών, εικόνων φόντου και 

γραφικών µε εφέ κίνησης. 

Η τοποθέτηση µιας έτοιµης εικόνας clip art από τη συλλογή του Frontpage σε µία ιστοσελίδα είναι απλή 

υπόθεση. Ακολουθήστε απλώς τα παρακάτω βήµατα: 

 

1. Στην προβολή Σελίδας, επιλέξτε την εντολή Insert >- Picture > Clip Art (ή κάντε κλικ στο κουµπί Insert 

Picture της Βασικής γραµµής εργαλείων), θα εµφανιστεί το παράθυρο διαλόγου Clip Art Gallery. 

 

2. Επιλέξτε µία κατηγορία - π.χ. Cartoons (κινούµενα σχέδια). Signs (επιγραφές και σήµατα), ή Web 

Buttons (κουµπιά για το Web) - και οι εικόνες που είναι διαθέσιµες σ' αυτή την κατηγορία θα εµφανιστούν στο 

µεγάλο πλαίσιο του παραθύρου διαλόγου (Εικόνα 4.8). 
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EIKONA 4,8 

Μπορείτε να χρησιµοποιήσετε τη συλλογή Clip Art Gallery του FrontPage για να εισάγετε 

προκατασκευασµένα εικονίδια και κουµπιά. 

3. Αφού βρείτε µία εικόνα η οποία σας αρέσει, κάντε κλικ πάνω της. θα εµφανιστεί ένα µενού λειτουργιών 

µε αρκετές επιλογές, όπως οι Insert Clip (εισαγωγή εικόνας), Preview Clip (προεπισκόπηση εικόνας), Add Clip 

To Favorites (προσθήκη εικόνας στα αγαπηµένα) και Find Similar Clips (εύρεση παρόµοιων εικόνων). 
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4. Για να εισάγετε την εικόνα, κάντε κλικ στο κουµπί Insert Clip του µενού· το Frontpage θα εισάγει την clip 

art εικόνα στη σελίδα σας. 

 

5. Το παράθυρο διαλόγου κλείνει και επανεµφανίζεται η προβολή Σελίδας. Η εικόνα 

που επιλέξατε από τη συλλογή εµφανίζεται στο έγγραφο σας. Μπορείτε να επαναλάβετε αυτή τη διαδικασία 

περισσότερες από µία φορές για να προσθέσετε όσες εικόνες θέλετε σε µία σελίδα. 

 

Εισαγωγή Εικόνων σε Έναν Ιστό του Frontpage 
 

Η εισαγωγή µιας εικόνας είναι η διαδικασία µε την οποία παίρνετε µία εικόνα αποθηκευµένη τοπικά στον 

υπολογιστή σας (ή µία εικόνα την οποία βρήκατε σε µία τοποθεσία του Web) και την ενσωµατώνετε στον δικό 

σας χώρο στο Web. 

Όταν εισάγετε µία εικόνα σε έναν ιστό του Frontpage, αυτό δε σηµαίνει ότι την προσθέτετε σε µία 

ιστοσελίδα. Αντίθετα, σηµαίνει ότι συγκεντρώνετε τις εικόνες στην τοποθεσία σας έτσι ώστε να έχετε εύκολη 

πρόσβαση στα αρχεία τους όταν θα είστε έτοιµοι να τις τοποθετήσετε σε συγκεκριµένες ιστοσελίδες. Και όταν 

θα δηµοσιεύσετε τις σελίδες σας, οι εικόνες θα βρίσκονται αποθηκευµένες µε ασφάλεια στη σωστή θέση. 

Η εισαγωγή εικόνων είναι µία απλή διαδικασία. Αφού ανοίξετε τον ιστό σας στο 

Frontpage, ακολουθήστε απλώς τα παρακάτω βήµατα: 

 

1. Κάντε κλικ στο κουµπί Folder View (προβολή φακέλων) της στήλης εικονιδίων που εµφανίζεται στην 

αριστερή πλευρά του παραθύρου. Η ενέργεια αυτή εµφανίζει τους φακέλους και τα αρχεία του τρέχοντος ιστού 

του Frontpage. 

 

2. Στη συνέχεια θα εισάγετε ορισµένες εικόνες από τον σκληρό σας δίσκο στον τρέχοντα ιστό του 

Frontpage. Αφού µεταβείτε σε προβολή Φακέλων, κάντε διπλό κλικ στον φάκελο Images για να εµφανίσετε τα 

περιεχόµενα του (ο φάκελος αυτός µπορεί να είναι κενός τώρα, ή µπορεί να περιέχει εικόνες τις οποίες έχει 

τοποθετήσει εκεί ένα πρότυπο ή ένας οδηγός). 

 

3. Από το µενού File επιλέξτε την εντολή Import, θα εµφανιστεί το παράθυρο διαλόγου Import File To 

Frontpage Web (Εικόνα 4.9). 
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ΕΙΚΟΝΑ 4,9 

 

Το παράθυρο διαλόγου Import File To Front Page Web σας βοηθά να συγκεντρώσετε  

όλες τις απαραίτητες εικόνες σε µια θέση. 

 

 

4. Για να προσθέσετε ένα αρχείο εικόνας στον φάκελο Images, κάντε κλικ στο κουµπί Add File. θα 

εµφανιστεί το παράθυρο διαλόγου Add File To Import List. Χρησιµοποιήστε αυτό το παράθυρο διαλόγου όπως 

και οποιοδήποτε άλλο παράθυρο διαλόγου ανοίγµατος αρχείων στα Windows, για να εντοπίσετε την εικόνα 

που θέλετε να προσθέσετε στη σελίδα σας, κινούµενοι στο σύστηµα των φακέλων του σκληρού σας δίσκου 

µέχρι να εντοπίσετε και να επιλέξετε το επιθυµητό αρχείο εικόνας. Αφού τελειώσετε κάντε κλικ στο Open για 

να επιστρέψετε στο παράθυρο διαλόγου Import..., όπου θα δείτε το όνοµα του αρχείου που µόλις επιλέξατε. 

 

Εναλλακτικά, 
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Για να προσθέσετε όλα τα περιεχόµενα ενός φακέλου (υποθέτοντας ότι ο φάκελος αυτός περιέχει µόνο 

αρχεία εικόνων) στον φάκελο Images του τρέχοντος ιστού του Frontpage, κάντε κλικ στο κουµπί Add Folder, 

θα εµφανιστεί το παράθυρο διαλόγου Browse For Folder, όπως βλέπετε στην Εικόνα 4.10. Εντοπίστε τον 

γεµάτο µε αρχεία εικόνων φάκελο σε µία µονάδα δίσκου του υπολογιστή σας ή του δικτύου σας και κάντε κλικ 

στο εικονίδιο του. Κάντε κλικ στο ΟΚ για να επιστρέψετε στο παράθυρο διαλόγου Import File, όπου θα δείτε 

τα ονόµατα όλων των αρχείων του φακέλου που µόλις επιλέξατε. 

 

Εναλλακτικά, 

Για να προσθέσετε αρχεία από µία υπάρχουσα τοποθεσία του Web, κάντε κλικ στο κουµπί From Web. θα 

εµφανιστεί το παράθυρο του οδηγού Import Web Wizard. Ακολουθήστε απλώς τις προτροπές του οδηγού για 

να εισάγετε το επιθυµητό αρχείο (ή αρχεία) από το Web. 

 

 

ΕΙΚΟΝΑ 4,10 

Το παράθυρο διαλόγου Browse For Folders σας επιτρέπει να εισάγετε όλα τα αρχεία εικόνων ενός φακέλου 

µονοµιάς. 
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5. Μπορείτε να επαναλάβετε το βήµα 4 όσες φορές χρειάζεται για να επιλέξετε όλες τις εικόνες που θέλετε 

να συγκεντρώσετε στον τρέχοντα ιστό του Frontpage. 

 

 

Όταν είστε έτοιµοι να αντιγράψετε αυτά τα αρχεία στον ιστό του Frontpage κάντε κλικ στο ΟΚ.  Τα αρχεία 

θα αρχίσουν να φορτώνονται και το παράθυρο διαλόγου Import File To Frontpage Web θα κλείσει αφού 

ολοκληρωθεί η αντιγραφή. 

Τώρα που έχετε εισάγει όλα τα αρχεία εικόνων στον κατάλληλο φάκελο του τρέχοντος ιστού, η τοποθέτηση 

αυτών των εικόνων στις ιστοσελίδες της τοποθεσίας σας θα είναι πανεύκολη. 
 

Τοποθέτηση Εικόνων σε Ιστοσελίδες 
 

Τώρα που έχετε συγκεντρώσει τις επιθυµητές εικόνες σε µία κεντρική θέση µέσα στον τρέχοντα ιστό του 

Frontpage, µπορείτε να χρησιµοποιήσετε την προβολή Σελίδας για να τις τοποθετήσετε γρήγορα και εύκολα 

στις σελίδες σας. Για να ολοκληρώσετε τη βασική διαδικασία µεταφοράς µιας εικόνας και απόθεσης της πάνω 

στη σελίδα σας, ακολουθήστε τα παρακάτω βήµατα: 
 

1. Με ανοικτή την ιστοσελίδα που σας ενδιαφέρει στην προβολή Σελίδας, επιλέξτε την εντολή Insert > 

Picture > From File. θα εµφανιστεί το παράθυρο διαλόγου Image, όπως βλέπετε στην Εικόνα 4.11. 
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ΕΙΚΟΝΑ 4,11 

Το παράθυρο διαλόγου Image σας επιτρέπει να εντοπίσετε και να εισάγετε την επιθυµητή εικόνα. 

2. To παράθυρο διαλόγου Image εµφανίζει τους φακέλους του τρέχοντος ιστού του Frontpage. Εάν η εικόνα 

είναι διαθέσιµη στον τρέχοντα ιστό, κάντε κλικ στον φάκελο στον οποίο περιέχεται  

(κατά πάσα πιθανότητα στον φάκελο Images) για να εµφανίσετε τα περιεχόµενα αυτού του φακέλου και 

κατόπιν κάντε κλικ στο όνοµα της επιθυµητής εικόνας. Η θέση του αρχείου της εικόνας εµφανίζεται στο πεδίο 

URL του παραθύρου διαλόγου. 

3. Τώρα που έχετε καθορίσει τη θέση της εικόνας που θέλετε να προσθέσετε στη σελίδα σας, κάντε κλικ στο 

ΟΚ για να κλείσετε το παράθυρο διαλόγου Image, θα επιστρέψετε σε προβολή Σελίδας. 

 

Η εικόνα σας εµφανίζεται στο παράθυρο της προβολής Σελίδας. Μπορείτε να την αφήσετε στην τρέχουσα 

θέση της, ή να τη µεταφέρετε σε µία νέα θέση της σελίδας χρησιµοποιώντας τις γνωστές από τα Windows 

διαδικασίες αποκοπής και επικόλλησης. 
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6. Κάντε κλικ στο ΟΚ για να κλείσει το παράθυρο διαλόγου Image Properties, θα επιστρέψετε σε προβολή 

Σελίδας, στην οποία µπορείτε να δείτε τα αποτελέσµατα των αλλαγών σας. 

Εάν το γραφικό σας δείχνει λίγο περίεργο, ή εάν δεν είναι αυτό ακριβώς που είχατε υπόψη, συνεχίστε τη 

διαδικασία προσαρµογής του επαναλαµβάνοντας τα παραπάνω βήµατα µέχρι να επιτύχετε την επιθυµητή 

εµφάνιση. 

Μία άλλη θαυµάσια χρήση των γραφικών είναι η δηµιουργία εικόνων φόντου. Αυτή η κατηγορία γραφικών 

αναφέρεται συχνά σαν εικόνες ταπετσαρίας (wallpaper) και µπορεί να αποτελέσει ένα θαυµάσιο διακοσµητικό 

ή σχεδιαστικό στοιχείο. Συνεχίστε το διάβασµα για περισσότερες πληροφορίες. 

 

Χρήση Ειδικών Εικόνων στο Φόντο 
 

 

Ενώ οι παλαιότερες εφαρµογές browser εµφάνιζαν το φόντο όλων των σελίδων σαν ένα οµοιόµορφο και 

βαρετό γκρι, οι περισσότερες µοντέρνες εφαρµογές browser µπορούν να εµφανίζουν πολύχρωµα φόντα, καθώς 

επίσης και φόντα αποτελούµενα από εικόνες - στην πραγµατικότητα, οποιαδήποτε εικόνα µπορεί να εµφανιστεί 

σε µία ιστοσελίδα, µπορεί επίσης να χρησιµοποιηθεί σαν φόντο. 

 Η δυνατότητα αυτή είναι θαυµάσια, αλλά µπορεί επίσης να αποδειχτεί σηµαντική αδυναµία στον τοµέα της 

σχεδίασης, θα πρέπει να προσέχετε ιδιαίτερα όταν σχεδιάζετε τις σελίδες σας: 

. 

 

Επιλογή Χρώµατος Φόντου 
 

Η επιλογή του χρώµατος φόντου για µία ιστοσελίδα είναι απλή υπόθεση. Ακολουθήστε τα παρακάτω 

βήµατα: 

 

1. Με τη σελίδα της οποίας το φόντο θέλετε να προσαρµόσετε ανοικτή σε προβολή Σελίδας, επιλέξτε την 

εντολή Format > Background, θα εµφανιστεί το παράθυρο διαλόγου Page Properties, µε ορατή την καρτέλα 

Background (Εικόνα 4.17). 
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2. Ανοίξτε την αναδιπλούµενη λίστα Background και επιλέξτε ένα από τα διαθέσιµα χρώµατα. Για να 

διαλέξετε ένα χρώµα εκτός από τα προκαθορισµένα διαθέσιµα χρώµατα, επιλέξτε Custom, θα εµφανιστεί το 

παράθυρο διαλόγου Color. 

 

ΕΙΚΟΝΑ 4,17 

Θα χρησιµοποιήσετε την καρτέλα Background του παραθύρου διαλόγου Properties για να αλλάζετε το 

χρώµα φόντου σελίδων σας. 

 

3. Κάντε κλικ στην τετράγωνη περιοχή επιλογής χρώµατος του παραθύρου διαλόγου Color για να διαλέξετε 

ένα χρώµα και κατόπιν κάντε κλικ στην περιοχή επιλογής τόνων (τη στενότερη περιοχή στα δεξιά του 

ουράνιου τόξου) για να προσαρµόσετε τη φωτεινότητα του επιλεγµένου χρώµατος. Το χρώµα που επιλέξατε 

εµφανίζεται στην περιοχή Color/Solid του παραθύρου διαλόγου Color. 

 

4. Κάντε κλικ στο Add To Custom Colors· το χρώµα που επιλέξατε θα εµφανιστεί στην περιοχή Custom 

Colors του παραθύρου διαλόγου Color. 
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5. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Color, θα επανεµφανιστεί το παράθυρο 

διαλόγου Page Properties. To χρώµα που επιλέξατε θα αναφέρεται σ' αυτό το παράθυρο διαλόγου, µαζί µε τη 

λέξη Custom, στην αναδιπλούµενη λίστα Background. 

 

6. Κάντε κλικ στο ΟΚ για να εφαρµόσετε το χρώµα φόντου που µόλις επιλέξατε στη σελίδα σας. Το 

παράθυρο διαλόγου Page Properties κλείνει και εσείς επιστρέφετε σε προβολή Σελίδας, µε το νέο χρώµα στο 

φόντο της σελίδας σας. 
 

Μπορείτε να επαναλάβετε τα παραπάνω βήµατα όσες φορές θέλετε, µέχρι να βρείτε ένα χρώµα το οποίο καλύπτει τις ανάγκες σας. 

 

 

Eπιλογή Εικόνας Φόντου 
 

Η επιλογή µιας εικόνας για το φόντο µιας σελίδας είναι παρόµοια µε τον καθορισµό ενός χρώµατος φόντου. 

Η εικόνα που επιλέγετε θα πρέπει να είναι αδιόρατη και να εξυπηρετεί τον σκοπό που υποδηλώνει το όνοµα 

της - ένα φόντο πάνω στο οποίο θα κάθεται το κείµενο της σελίδας. Οι εφαρµογές browser που µπορούν να 

εµφανίζουν εικόνες φόντου έχουν τη δυνατότητα να επαναλαµβάνουν την εικόνα σε πλευρική παράθεση - σαν 

να ήταν ένα πλακίδιο σ' ένα µεγαλύτερο µωσαϊκό - µέχρι να γεµίσει όλο το παράθυρο της εφαρµογής, 

ανεξαρτήτως του µεγέθους του. Εάν έχετε ασχοληθεί ποτέ µε την αλλαγή της ταπετσαρίας στην επιφάνεια 

εργασίας των Windows, τότε πιθανότατα γνωρίζετε το αποτέλεσµα της πλευρικής παράθεσης. 

Η επιλογή µιας εικόνας φόντου για µία ιστοσελίδα είναι απλή υπόθεση.  

Ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ανοικτή τη σελίδα που σας ενδιαφέρει σε προβολή Σελίδας, επιλέξτε την εντολή Format > 

Background, θα εµφανιστεί το παράθυρο διαλόγου Page Properties, µε ορατή την καρτέλα Background 

(φόντο). 

 

2. Μαρκάρετε το πλαίσιο ελέγχου Background Image. To κουµπί Browse γίνεται διαθέσιµο (δεν 

εµφανίζεται πλέον αµυδρό). 

 

3. Στο πεδίο Background Image πληκτρολογήστε το πλήρες όνοµα διαδροµής της θέσης στην οποία 

βρίσκεται η εικόνα φόντου που θέλετε να χρησιµοποιήσετε, ή κάντε κλικ στο κουµπί Browse για να εντοπίσετε 

και να επιλέξετε µία θέση µέσα σε έναν ιστό του Frontpage ή στον υπολογιστή σας. 
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4. Εάν χρησιµοποιείτε µία µεγάλη εικόνα για το φόντο της σελίδας σας (µία εικόνα η οποία καταλαµβάνει 

χώρο περίπου όσο και µία σελίδα οθόνης) µπορείτε να µαρκάρετε το πλαίσιο ελέγχου Watermark 

(υδατογράφηµα). 

 

5. Όταν είστε έτοιµοι, κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Page Properties, θα 

επιστρέψετε σε προβολή Σελίδας. 

Ελέγξτε προσεκτικά για να βεβαιωθείτε ότι η εικόνα σας έχει την επιθυµητή εµφάνιση τώρα που 

επαναλαµβάνεται σε πλευρική παράθεση σε όλο το µήκος και το πλάτος της οθόνης - περίπου έτσι θα τη 

βλέπουν και όλοι οι υπόλοιποι άνθρωποι στο Web. Εάν σας αρέσει αυτό που βλέπετε, είστε έτοιµοι. Εάν όχι, 

αλλάξτε τις ρυθµίσεις για την εικόνα. 

Στο σηµείο αυτό θα πρέπει να έχετε µία ωραία σε εµφάνιση σελίδα. Αλλά αποµένει να προσθέσετε ένα από 

τα σηµαντικότερα κοµµάτια στο παζλ του Web: τους συνδέσµους, ή δεσµούς υπερκειµένου! 

 

Προσθήκη Συνδέσµων (∆εσµών Υπερκειµένου) 
 

Οι δεσµοί υπερκειµένου (hyperlinks), οι οποίοι αποκαλούνται επίσης σύνδεσµοι (links) είναι το στοιχείο 

που κάνει τη µεγάλη διαφορά µεταξύ του Web και των άλλων µέσων - ανεξάρτητα από το πόσο σκληρά θα 

προσπαθήσετε, δεν µπορείτε να κάνετε κλικ σε έναν χάρτη τον οποίο βλέπετε στην τηλεόραση, στο όνοµα ενός 

συγγραφέα σ' ένα περιοδικό, ή στον τίτλο ενός ποιήµατος σ' ένα βιβλίο. (Τουλάχιστον όχι ακόµη!). 

Όπως αναµφίβολα γνωρίζετε εάν έχετε βρεθεί στο Web έστω και για 15 µόνο λεπτά, ένας σύνδεσµος (ή 

δεσµός υπερκειµένου) µπορεί να δείχνει σε οποιαδήποτε διεύθυνση του Internet - η οποία, µε τη σειρά της, 

µπορεί να αντιπροσωπεύει πολλούς διαφορετικούς τοµείς και πόρους πληροφοριών, όπως π.χ. έναν διακοµιστή 

FTP, ένα αρχείο, µία εφαρµογή, ένα κλιπ πολυµέσων, µία διεύθυνση ηλεκτρονικού ταχυδροµείου, ή τη 

διεύθυνση µιας οµάδας συζήτησης (newsgroup). Οποιαδήποτε "δηµόσιας πρόσβασης" θέση του Internet µπορεί 

να προσπελάζεται µέσω του Web χρησιµοποιώντας συνδέσµους (δεσµούς υπερκειµένου). 

 

Γενικά υπάρχουν πολλά είδη διευθύνσεων URL, αλλά ειδικά για τους συνδέσµους υπάρχουν µόνο δύο είδη 

διευθύνσεων: οι σχετικές (relative) και οι απόλυτες (absolute). Οι σχετικές διευθύνσεις περιέχουν µόνο ένα 

όνοµα αρχείου, την επέκταση του, και πιθανώς τη θέση του µέσα στον κατάλογο αρχείων. Μία σχετική 

διεύθυνση URL δείχνει σε ένα αρχείο το οποίο βρίσκεται στον ίδιο διακοµιστή Web. Για παράδειγµα, όταν 

διασυνδέετε µία σελίδα µε µία άλλη σελίδα η οποία βρίσκεται στον ίδιο φάκελο του τρέχοντος ιστού του 

Frontpage, µπορείτε απλά να υποδείξετε το όνοµα αρχείου της: figs.html. Εάν βρίσκεστε στον κύριο φάκελο 

αλλά έχετε την εικόνα αποθηκευµένη στον υποφάκελο Images, µπορείτε να δείξετε στο αρχείο αυτής της 
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εικόνας χρησιµοποιώντας µία σχετική διεύθυνση. Η διεύθυνση αυτή θα έδειχνε ως εξής: images / figs.gif.H 

χρήση σχετικών διευθύνσεων είναι καλή πρακτική όταν διασυνδέετε τα στοιχεία της ίδιας τοποθεσίας, επειδή 

διευκολύνει τη συντήρηση της τοποθεσίας. Εάν έχετε χρησιµοποιήσει σχετικές διευθύνσεις, µπορείτε να 

µετακινείτε αρχεία από έναν φάκελο ενός διακοµιστή Web σ' έναν διαφορετικό φάκελο του ίδιου διακοµιστή, 

χωρίς να χρειάζεται να κάνετε µεγάλης έκτασης αλλαγές στον HTML κώδικα της τοποθεσίας σας. 

 

Από την άλλη, εάν γράφατε ολόκληρη τη διεύθυνση URL µε την τυπική της µορφή, όπως π.χ. http: //www. 

my site. corn/figs .html, τότε θα χρησιµοποιούσατε µία απόλυτη διεύθυνση. Οι απόλυτες διευθύνσεις ξεκινούν 

µε ένα προσδιοριστικό πρωτοκόλλου, όπως το http: //, το ftp: //, ή οτιδήποτε άλλο. (Ένα πρωτόκολλο είναι 

απλά ένας προσυµφωνηµένος τρόπος εκτέλεσης ενεργειών. HTTP είναι το όνοµα του πρωτοκόλλου 

Μεταφοράς Υπερκειµένου, το οποίο χρησιµοποιείται για τη διακίνηση των Ιστοσελίδων στο Web). To 

προσδιοριστικό πρωτοκόλλου ακολουθείται από το υπόλοιπο τµήµα µιας πλήρους διεύθυνσης URL. Ο όρος 

"απόλυτη διεύθυνση" υποδεικνύει ότι δε δίνεται απλά και µόνο το όνοµα του εγγράφου όπως έχει αποθηκευτεί 

σε έναν διακοµιστή, αλλά ολόκληρη η διαδροµή που οδηγεί στη θέση του αρχείου. 

 

Γενικά, οι σύνδεσµοι που δείχνουν σε τοπικούς πόρους - στοιχεία αποθηκευµένα στον ίδιο διακοµιστή - 

χρησιµοποιούν σχετικές διευθύνσεις, ενώ οι σύνδεσµοι που δείχνουν σε οποιαδήποτε άλλη θέση του 

κυβερνοχώρου χρησιµοποιούν απόλυτες διευθύνσεις Εάν συνεχίζετε να µην κατανοείτε πλήρως αυτό το 

σκεπτικό, το Frontpage θα φρόντισε να σας το καταστήσει σαφές πολύ σύντοµα. Συνεχίστε απλώς το 

διάβασµα. 

 

 

 

 

∆ιασύνδεση µε µία Σελίδα του Τρέχοντος Ιστού του Frontpage 

 

Η διασύνδεση δύο σελίδων που ανήκουν στον ίδιο ιστό του Front Page είναι ένα τέλειο παράδειγµα 

σχετικής διασύνδεσης στην ορολογία του Front Page αποκαλείτε εσωτερική διασύνδεση (internal 

hyperlink). 
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Η εσωτερική διασύνδεση σας επιτρέπει να αναφερθείτε σε έγγραφα που ανήκουν στον ίδιο ιστό του 

Frontpage. Μπορεί επίσης να ακούσετε αυτό τον όρο να περιγράφει τους συνδέσµους που οδηγούν σε 

διαφορετικές θέσεις µέσα στην ίδια ιστοσελίδα. 

 

 

Υποθέστε ότι υπάρχουν δύο σελίδες στον τρέχοντα ιστό του Frontpage: οι default . html και new. html. 

Πιθανότατα θα θέλετε να διασυνδέσετε αυτές τις δύο σελίδες. Ας υποθέσουµε επίσης ότι έχετε ανοικτή τη 

σελίδα default, html σε προβολή Σελίδας και θέλετε να δηµιουργήσετε έναν σύνδεσµο (δεσµό υπερκειµένου) 

από αυτή, προς τη σελίδα new. html η οποία είναι αποθηκευµένη στον ίδιο φάκελο µε τη σελίδα home. html 

στον τρέχοντα ιστό του Frontpage. Ακολουθήστε τα παρακάτω βήµατα: 

 

 

1.  Με ανοικτό το Frontpage και ορατό το έγγραφο σας στο παράθυρο του, πληκτρολογήστε τη λέξη που 

θέλετε να χρησιµοποιήσετε σαν δεσµό υπερκειµένου και κατόπιν επιλέξτε την. Στο παράδειγµα µας θα 

µπορούσατε να πληκτρολογήσετε τη φράση What's new (ή Τι Νέο Υπάρχει) στη σελίδα default. html. 

 

 

 

2.  Από τη γραµµή των µενού στο παράθυρο µε την προβολή Σελίδας επιλέξτε την εντολή Insert > 

Hyperlink (ή κάντε κλικ στο κουµπί Hyperlink της Βασικής γραµµής εργαλείων, ή χρησιµοποιήστε τον 

συνδυασµό πλήκτρων Ctrl + Κ). θα εµφανιστεί το παράθυρο διαλόγου Create Hyperlink (Εικόνα 4.18). 
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ΕΙΚΟΝΑ 4,18 

 

Θα χρησιµοποιείτε το παράθυρο διαλόγου Create Hyperlink για να καθορίσετε τη διεύθυνση URL ενός 

συνδέσµου (δεσµού).  

 

3. Στο παράθυρο διαλόγου Create Hyperlink θα πρέπει να βλέπετε τα ονόµατα αρχείων και τους τίτλους των 

σελίδων του τρέχοντος ιστού του Frontpage. Επιλέξτε το αρχείο στο οποίο θέλετε να δείχνει ο σύνδεσµος που 

δηµιουργείτε κάνοντας κλικ πάνω του- η διεύθυνση URL αυτού του αρχείου θα εµφανιστεί στο πεδίο URL. 

 

4. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου· θα επιστρέψετε σε προβολή Σελίδας. 

 

Στο σηµείο αυτό θα πρέπει να βλέπετε τη λέξη που χρησιµοποιήσατε στον δεσµό (What's New στο 

παράδειγµα µας) υπογραµµισµένη και µε διαφορετικό χρώµα. Περάστε τον δείκτη του ποντικιού πάνω από τον 

δεσµό ( η ενέργεια αυτή αποκαλείτε mouse over ) και θα δείτε τη διεύθυνση της σελίδας να εµφανίζεται στην 

γραµµή καταστάσεων της προβολής σελίδας. 

Θα µπορούσατε να ακολουθήσετε τα ίδια βήµατα για να τοποθετήσετε έναν σύνδεσµο (δεσµό) στη σελίδα 

new. html, ο οποίος θα σας οδηγεί πίσω στην αρχική σελίδα. 
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Ξεκινώντας 

 
Στο προηγούµενο κεφάλαιο µάθατε πώς να χειρίζεστε τα εργαλεία επεξεργασίας και πώς να δηµιουργείτε 

νέες ιστοσελίδες στο Frontpage. Είστε τώρα έτοιµοι να εφαρµόσετε αυτές τις βασικές γνώσεις στην πράξη και 

να δουλέψετε µε συγκεκριµένα χαρακτηριστικά των σελίδων. Όπως εξηγήσαµε , η προβολή Σελίδας θα είναι η 
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κεντρική θέση από την οποία θα καθορίζετε τη διάταξη για µία σελίδα και θα παράγετε τα HTML έγγραφα - 

τις ιστοσελίδες - που θα αποτελέσουν τελικά την τοποθεσία σας. Το κεφάλαιο αυτό θα σας δείξει πώς µπορείτε 

να προσθέτετε βασικά στοιχεία σε µία σελίδα, όπως το κείµενο και οι εικόνες, καθώς επίσης και πώς µπορείτε 

να µορφοποιείτε αυτά τα στοιχεία, θα µάθετε επίσης πώς να δουλεύετε µε τους συνδέσµους (links) - αυτή 

άλλωστε είναι η ουσία του Web. 

 

Άνοιγµα Υπάρχουσας Ιστοσελίδας 

 
Είναι πολύ πιθανό να έχετε ξεκινήσει ήδη τη δηµιουργία σελίδων είτε µε µία προηγούµενη έκδοση του 

Frontpage, είτε µε κάποιον άλλο συντάκτη HTML, ή απλό συντάκτη κειµένων. Εάν θέλετε να ξεκινήσετε την 

πορεία σας στο Frontpage µε ένα έργο υπό εξέλιξη, ακολουθήστε απλώς τα παρακάτω βήµατα: 

 

1. Ανοίξτε ή δηµιουργήστε έναν ιστό (web) του Frontpage χρησιµοποιώντας την προβολή Σελίδας. 

 

2. Από τη γραµµή των µενού επιλέξτε την εντολή File > Open (ή πατήστε Ctrl+0)  θα εµφανιστεί το 

παράθυρο διαλόγου Open. 

 

3. Κινηθείτε στη λίστα των αρχείων/φακέλων του υπολογιστή σας µέχρι να εντοπίσετε το αρχείο µε το 

οποίο θέλετε να δουλέψετε (κατά πάσα πιθανότητα θα έχει επέκταση .him ή .html). Επιλέξτε το αρχείο αυτό 

και κάντε κλικ στο κουµπί Open για να εµφανίσετε την ιστοσελίδα του στην προβολή Σελίδας του Frontpage. 

Ανάλογα µε τα βήµατα που ακολουθήσατε, θα πρέπει να δείτε είτε µία νέα, κενή σελίδα, είτε µία 

υπάρχουσα σελίδα στο παράθυρο της προβολής Σελίδας. Γενικά, αυτή είναι η µόνη διαδικασία που απαιτείται 

για το άνοιγµα µιας ιστοσελίδας στο Frontpage. Είστε τώρα έτοιµοι να ξεκινήσετε την προσθήκη κειµένου και 

εικόνων στη σελίδα σας. 

 

 

 

∆ηµιουργία Νέας Σελίδας 

 
Εάν θέλετε να δηµιουργήσετε µία ιστοσελίδα από την αρχή, ακολουθήστε τα παρακάτω βήµατα για να 

δηµιουργήσετε µία νέα σελίδα στον τρέχοντα ιστό του Frontpage: 
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1. Για να δηµιουργήσετε ένα νέο αρχείο, επιλέξτε την εντολή File > New > Page (δηµιουργία ιστοσελίδας). 

 

2. Από την καρτέλα General του παραθύρου διαλόγου επιλέξτε το επιθυµητό πρότυπο για τη δηµιουργία της 

σελίδας σας. Εγώ θα επιλέξω το πρότυπο Three-Column Staggered (για τρίστηλη σελίδα). 

 

3. Κάντε κλικ στο ΟΚ. Η σελίδα θα ανοίξει στην περιοχή επεξεργασίας, µε το προεπιλεγµένο όνοµα 

newpage1.htm. θα δείτε επίσης γραµµές πλέγµατος, "πλασµατικό" κείµενο (άνευ σηµασίας κείµενο το οποίο θα 

αντικαταστήσετε µε το δικό σας περιεχόµενο) και, ανάλογα µε το πρότυπο σελίδας που επιλέξατε στο βήµα 2 

παραπάνω, ορισµένα γραφικά ή εικόνες. 

 

Εξέταση του HTML Κώδικα που Κρύβεται Πίσω από τη Σελίδα σας 

 
Στο σηµείο αυτό θα πρέπει να έχετε έναν ιστό ή µία ιστοσελίδα. Είστε τώρα έτοιµοι να αρχίσετε την 

προσθήκη κειµένου και εικόνων και να ασχοληθείτε µε τη διαχείριση αυτών των στοιχείων στις σελίδες σας. 

Πριν όµως σας δείξουµε πώς µπορείτε να κάνετε όλα αυτά τα πράγµατα, πιστεύουµε ότι θα πρέπει να µπορείτε 

να εξετάζετε και να κατανοείτε τον τρόπο µε τον οποίο τοποθετείται το κείµενο και οι εικόνες σε µία σελίδα. 

Εκτός από το φιλικό, εύχρηστο και άµεσο περιβάλλον επεξεργασίας Ιστοσελίδων που σας παρέχει, η 

προβολή Σελίδας σας επιτρέπει να δουλεύετε απευθείας µε τον υποκείµενο HTML κώδικα - τον κώδικα που 

λέει στην εφαρµογή browser πού θα εµφανίσει το κείµενο, τις εικόνες και οποιαδήποτε άλλα στοιχεία του 

περιεχοµένου. Όταν χρησιµοποιείτε το Frontpage δεν είστε υποχρεωµένοι να παραµείνετε µόνο στην προβολή 

Σελίδας, αλλά µπορείτε επίσης να ρίχνετε µία µατιά "στα παρασκήνια" για να εξετάζετε τον κώδικα ή για να 

προσθέτετε µόνοι σας νέο κώδικα. Αυτό σηµαίνει ότι µπορείτε να εισάγετε HTML κώδικα ο οποίος δεν 

υποστηρίζεται άµεσα από το Frontpage, να ελέγξετε την εργασία σας, ή ακόµη και να κάνετε αλλαγές στον 

κώδικα µιας σελίδας. 

Για να εξετάσετε τον HTML κώδικα που κρύβεται πίσω από τη σελίδα σας και να τον ανοίξετε για 

επεξεργασία, βεβαιωθείτε ότι έχετε ανοικτή τη σελίδα που σας ενδιαφέρει σε προβολή Σελίδας. Κατόπιν 

επιλέξτε την καρτέλα HTML. Γα περιεχόµενα του παραθύρου αλλάζουν, παρουσιάζοντας πλέον τον πηγαίο 

HTML κώδικα για την τρέχουσα σελίδα. 

Μπορείτε τώρα να κάνετε αλλαγές πληκτρολογώντας νέο ή τροποποιηµένο HTML κώδικα απευθείας στην 

προβολή Σελίδας. Μπορείτε επίσης να διαγράψετε αποσπάσµατα HTML κώδικα επιλέγοντας τα και πατώντας 

το πλήκτρο Delete. 

 

 82



Εισαγωγή στο FrontPage 

 

Προσθήκη Κειµένου σε µία Σελίδα 

 
Για να προσθέσετε κείµενο στη σελίδα σας, ανοίξτε απλώς την ιστοσελίδα που σας ενδιαφέρει και 

ξεκινήστε την πληκτρολόγηση του κειµένου σε προβολή Σελίδας. Μπορείτε επίσης να αντιγράψετε (copy), ή 

να αποκόψετε (cut) κείµενο από ένα απλό αρχείο κειµένου, ένα έγγραφο του Microsoft Word, ένα µήνυµα 

ηλεκτρονικού ταχυδροµείου, ή κάποια άλλη ιστοσελίδα, και κατόπιν να το επικολλήσετε (paste) στην 

τρέχουσα σελίδα µε την οποία δουλεύετε. Ακολουθήστε απλώς τα παρακάτω βήµατα: 

 

1. Ανοίξτε το έγγραφο το οποίο έχει ήδη το περιεχόµενο που θέλετε να µεταφέρετε στην ιστοσελίδα σας. 

 

2. Επιλέξτε το επιθυµητό κείµενο και από τη γραµµή των µενού της άλλης εφαρµογής, επιλέξτε την εντολή 

Edit >- Copy (ή πατήστε Ctrl+C). 

 

3. Επιστρέψτε στο παράθυρο της προβολής Σελίδας του FrontPage χρησιµοποιώντας τη γραµµή εργασιών 

των Windows, ή πατώντας Alt+Tab. 

 

4. Κάντε κλικ στο παράθυρο της προβολής Σελίδας για να τοποθετήσετε το σηµείο εισαγωγής στην 

κατάλληλη θέση και επιλέξτε την εντολή Edit > Paste (ή πατήστε Ctrl +V) για να επικολλήσετε ένα αντίγραφο 

του κειµένου. Το κείµενο εµφανίζεται στο παράθυρο. 

 

Αυτό ήταν όλο - η διαδικασία δε διαφέρει σε τίποτα από την αντιγραφή κειµένου από µία θέση ενός 

εγγράφου σε µία διαφορετική θέση 

 

 

 

 

. 

Παράγραφοι Κειµένου 
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Οι παράγραφοι χρησιµοποιούνται σαν ένα µέσο για τη λογική οµαδοποίηση του κειµένου σε όλων των 

ειδών τα έγγραφα, και η δηµιουργία παραγράφων σε ένα κείµενο δεν είναι καθόλου πολύπλοκη υπόθεση. Η 

προβολή Σελίδας υποστηρίζει αναδίπλωση του κειµένου (wrap text) σε επόµενη γραµµή, παρόµοια µε τις 

µοντέρνες εφαρµογές επεξεργασίας κειµένου. Πληκτρολογείτε απλά το κείµενο σας και αυτό συνεχίζει 

αυτόµατα σε επόµενη γραµµή, µέσα στο παράθυρο. Για να δηµιουργήσετε µία νέα παράγραφο, πατάτε το 

πλήκτρο Enter στο κατάλληλο σηµείο. 

Στην HTML, οι αλλαγές παραγράφων δε σηµαίνουν το ίδιο πράγµα όπως στο έντυπο κείµενο. Για 

παράδειγµα, δεν υπάρχει στάνταρ µηχανισµός (π.χ. στηλοθέτες ή περιθώρια) για την προσθήκη εσοχών στην 

αρχή των παραγράφων. Γενικά, η µέθοδος που χρησιµοποιείται για να υποδεικνύει την αλλαγή παραγράφων 

στο κείµενο είναι µία κενή γραµµή µεταξύ των παραγράφων, αν και οι σχολαστικοί σχεδιαστές υλικού για το 

Web καταφέρνουν συνήθως να βρουν κάποιο τρόπο για να δηµιουργήσουν την ψευδαίσθηση των εσοχών ή να 

υλοποιήσουν άλλες καθιερωµένες συµβάσεις του έντυπου κειµένου. θα µάθετε περισσότερα για τη διαχείριση 

των παραγράφων του κειµένου σε επόµενες ενότητες αυτού του κεφαλαίου, οι οποίες ασχολούνται µε τη 

στοίχιση και τα µη-διακοπτόµενα διαστήµατα. 

 

Εισαγωγή Αλλαγών Παραγράφων 

 
Η HTML αντιµετωπίζει τις παραγράφους λίγο διαφορετικά απ' ότι το έντυπο κείµενο και οι επεξεργαστές 

κειµένων. Οι παράγραφοι στη HTML δεν είναι κατ' ανάγκην οι στάνταρ µονάδες "τριών περίπου συνεκτικών 

προτάσεων" όπως µαθαίναµε στη γραµµατική του δηµοτικού - είναι οπτικά διαχωρισµένες µονάδες 

ξεχωριστών στοιχείων πάνω σε µία σελίδα, ανεξάρτητα από το εάν τα στοιχεία αυτά είναι κείµενο, γραφικά, ή 

οτιδήποτε άλλο. Μπορείτε ακόµη και να χρησιµοποιείτε αλλαγές παραγράφων για να διαχωρίζετε ενότητες 

κειµένου από εικόνες, ή εικόνες από άλλα γραφικά. 

Ενώ βρίσκεστε σε προβολή Σελίδας, η εισαγωγή µιας αλλαγής παραγράφου (paragraph break) είναι τόσο 

απλή υπόθεση, όσο το πάτηµα του πλήκτρου Enter. Η προκαθορισµένη συµπεριφορά του πλήκτρου Enter στην 

προβολή Σελίδας είναι η δηµιουργία µιας αλλαγής παραγράφου, η οποία στην HTML υποδεικνύεται µε το tag 

<P>. θα µπορούσατε να δείτε αυτό το tag εάν εξετάζατε τον πηγαίο κώδικα της σελίδας σας.  
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Χρήση Ειδικών Χαρακτήρων 
 

Ορισµένα σύµβολα, τα οποία είναι γνωστά σαν ειδικοί χαρακτήρες (special characters), χρησιµοποιούνται 

ευρέως στα κείµενα αλλά δεν εµφανίζονται στο πληκτρολόγιο. Οι εφαρµογές επεξεργασίας κειµένου παρέχουν 

γενικώς αυτά τα σύµβολα µέσω ενός ειδικού µενού ή µέσω µιας ειδικής γραµµατοσειράς συµβόλων. 

∆υστυχώς, η γλώσσα HTML δεν αναγνωρίζει αυτά τα σύµβολα· εάν επιχειρήσετε να τα επικολλήσετε από ένα 

έγγραφο επεξεργασίας κειµένου σε µία ιστοσελίδα, τα σύµβολα αυτά απλώς δε θα εµφανιστούν. Συχνά µπορεί 

να θέλετε να χρησιµοποιήσετε το σύµβολο © για να υποδηλώσετε το copyright κειµένου ή οποιουδήποτε 

άλλου υλικού, ή το σύµβολο ™ για τα εµπορικά σήµατα. Σε άλλες περιπτώσεις µπορεί να θέλετε να 

χρησιµοποιήσετε ξενόγλωσσους τονούµενους χαρακτήρες, εάν δουλεύετε µε πολυγλωσσικά κείµενα. 

Ακριβώς όπως η HTML διαθέτει κωδικούς για τον έλεγχο της µορφοποίησης του κειµένου, σας παρέχει 

επίσης ειδικούς κωδικούς, τους αποκαλούµενους χαρακτήρες διαφυγής (escape characters) για την παραγωγή 

των ειδικών χαρακτήρων που δεν προβλέπονται στο πληκτρολόγιο. ∆εν πρόκειται για tags, αλλά για κωδικούς 

οι οποίοι λένε σε µία εφαρµογή browser ότι στη θέση τους θα πρέπει να εµφανίσει έναν ειδικό χαρακτήρα. To 

Frontpage διευκολύνει την εισαγωγή αυτών των ειδικών χαρακτήρων µε ένα παράθυρο διαλόγου παρόµοιο µε 

το παράθυρο διαλόγου που εµφανίζει η εντολή  Insert > Symbol του Word. 

 

 

 Στην πραγµατικότητα, το Frontpage διαθέτει τη δική του εντολή Insert >Symbol γι' αυτό ακριβώς τον 

σκοπό!  

Ακολουθήστε απλώς τα παρακάτω βήµατα για να τη χρησιµοποιήσετε: 

 

1. Από τη γραµµή των µενού της προβολής Σελίδας, επιλέξτε την εντολή Insert > Symbol, θα εµφανιστεί το 

παράθυρο διαλόγου Symbol. 

 

2. Εντοπίστε το ειδικό σύµβολο που θέλετε να εισάγετε στη σελίδα σας, κάντε κλικ πάνω του και κατόπιν 

κάντε κλικ στο Insert. To σύµβολο θα εµφανιστεί στο έγγραφο σας. (Ορισµένες φορές το παράθυρο διαλόγου 

Symbol µπορεί να κρύβει το εισαγόµενο σύµβολο, οπότε ψάξτε προσεκτικά πριν αποφασίσετε ότι η διαδικασία 

εισαγωγής έχει αποτύχει). 

 

3. Κάντε κλικ στο Close για να κλείσετε το παράθυρο διαλόγου και να επιστρέψετε στην προβολή Σελίδας. 

 

Ενώ το κείµενο είναι ουσιαστικά το "ψαχνό" µιας ιστοσελίδας, θα µπορούσαµε να πούµε ότι οι εικόνες και 

τα γραφικά είναι τα διάφορα µπαχαρικά και καρυκεύµατα. Οι εικόνες και γενικότερα τα γραφικά µπορούν να 
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χρησιµοποιούνται για να ενδυναµώνουν το µήνυµα που θέλετε να µεταδώσετε και για να αυξάνουν το οπτικό 

ενδιαφέρον της σελίδας σας, καθιστώντας τη µία αξιοµνηµόνευτη ηλεκτρονική εµπειρία. 

∆ουλεύοντας µε Εικόνες 
 

To Web δεν είναι απλά και µόνο κείµενο και δεσµοί υπερκειµένου. Μία µοντέρνα τοποθεσία στο Web 

σχεδιάζεται βασιζόµενη σ' έναν µεγάλο βαθµό σε γραφικά στοιχεία. Για να προσδώσετε µεγαλύτερο οπτικό 

ενδιαφέρον στις ιστοσελίδες σας µπορείτε να χρησιµοποιείτε γραφικά και εικόνες αποθηκευµένα σε έναν ιστό 

του Frontpage, στον σκληρό σας δίσκο, ή σε µία τοποθεσία του Internet. Εναλλακτικά, θα µπορούσατε να 

καλλωπίσετε τη σελίδα σας µε προκατασκευασµένες εικόνες και γραφικά στοιχεία από τη συλλογή Clip Art 

Gallery του Frontpage, την οποία θα εξετάσουµε στη συνέχεια. 

 

 

  H Συλλογή Έτοιµων Εικόνων Clip Art του Frontpage 

 

Στο Web κυκλοφορούν πολλές συλλογές έτοιµων εικόνων clip art, οι οποίες δεν έχουν να ζηλέψουν τίποτα 

από τις συλλογές εικόνων clip art που κυκλοφορούν σε µορφή βιβλίου και χρησιµοποιούνται από 

επαγγελµατίες γραφίστες και σχεδιαστές σε πολλά είδη εντύπων. ∆υστυχώς, δεν έχουν όλοι οι άνθρωποι το 

καλλιτεχνικό αισθητήριο ή το ταλέντο για να δηµιουργήσουν πρωτότυπες εικόνες για τις ιστοσελίδες τους· για 

τον λόγο αυτό, το να έχετε στη διάθεση σας µία βιβλιοθήκη έτοιµων ψηφιακών εικόνων µπορεί να σας 

εξοικονοµήσει χρόνο και κόπο, επιτρέποντας σας να γεµίσετε µε ελκυστικό και αποτελεσµατικό τρόπο τα κενά 

των Ιστοσελίδων σας. To Frontpage περιλαµβάνει µία συλλογή εικόνων clip art (Clip Art Gallery) η οποία 

περιέχει µικρότερες συλλογές απλών εικονιδίων, κουµπιών, γραµµικών γραφικών, εικόνων φόντου και 

γραφικών µε εφέ κίνησης. 

Η τοποθέτηση µιας έτοιµης εικόνας clip art από τη συλλογή του Frontpage σε µία ιστοσελίδα είναι απλή 

υπόθεση. Ακολουθήστε απλώς τα παρακάτω βήµατα: 

 

1. Στην προβολή Σελίδας, επιλέξτε την εντολή Insert >- Picture > Clip Art (ή κάντε κλικ στο κουµπί Insert 

Picture της Βασικής γραµµής εργαλείων), θα εµφανιστεί το παράθυρο διαλόγου Clip Art Gallery. 

 

2. Επιλέξτε µία κατηγορία - π.χ. Cartoons (κινούµενα σχέδια). Signs (επιγραφές και σήµατα), ή Web 

Buttons (κουµπιά για το Web) - και οι εικόνες που είναι διαθέσιµες σ' αυτή την κατηγορία θα εµφανιστούν στο 

µεγάλο πλαίσιο του παραθύρου διαλόγου (Εικόνα 4.8). 
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EIKONA 4,8 

Μπορείτε να χρησιµοποιήσετε τη συλλογή Clip Art Gallery του FrontPage για να εισάγετε 

προκατασκευασµένα εικονίδια και κουµπιά. 

2. Αφού βρείτε µία εικόνα η οποία σας αρέσει, κάντε κλικ πάνω της. θα εµφανιστεί ένα µενού 

λειτουργιών µε αρκετές επιλογές, όπως οι Insert Clip (εισαγωγή εικόνας), Preview Clip 

(προεπισκόπηση εικόνας), Add Clip To Favorites (προσθήκη εικόνας στα αγαπηµένα) και Find Similar 

Clips (εύρεση παρόµοιων εικόνων). 
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4. Για να εισάγετε την εικόνα, κάντε κλικ στο κουµπί Insert Clip του µενού· το Frontpage θα εισάγει την clip 

art εικόνα στη σελίδα σας. 

 

5. Το παράθυρο διαλόγου κλείνει και επανεµφανίζεται η προβολή Σελίδας. Η εικόνα 

που επιλέξατε από τη συλλογή εµφανίζεται στο έγγραφο σας. Μπορείτε να επαναλάβετε αυτή τη διαδικασία 

περισσότερες από µία φορές για να προσθέσετε όσες εικόνες θέλετε σε µία σελίδα. 

 

Εισαγωγή Εικόνων σε Έναν Ιστό του Frontpage 
 

Η εισαγωγή µιας εικόνας είναι η διαδικασία µε την οποία παίρνετε µία εικόνα αποθηκευµένη τοπικά στον 

υπολογιστή σας (ή µία εικόνα την οποία βρήκατε σε µία τοποθεσία του Web) και την ενσωµατώνετε στον δικό 

σας χώρο στο Web. 

Όταν εισάγετε µία εικόνα σε έναν ιστό του Frontpage, αυτό δε σηµαίνει ότι την προσθέτετε σε µία 

ιστοσελίδα. Αντίθετα, σηµαίνει ότι συγκεντρώνετε τις εικόνες στην τοποθεσία σας έτσι ώστε να έχετε εύκολη 

πρόσβαση στα αρχεία τους όταν θα είστε έτοιµοι να τις τοποθετήσετε σε συγκεκριµένες ιστοσελίδες. Και όταν 

θα δηµοσιεύσετε τις σελίδες σας, οι εικόνες θα βρίσκονται αποθηκευµένες µε ασφάλεια στη σωστή θέση. 

Η εισαγωγή εικόνων είναι µία απλή διαδικασία. Αφού ανοίξετε τον ιστό σας στο 

Frontpage, ακολουθήστε απλώς τα παρακάτω βήµατα: 

 

1. Κάντε κλικ στο κουµπί Folder View (προβολή φακέλων) της στήλης εικονιδίων που εµφανίζεται στην 

αριστερή πλευρά του παραθύρου. Η ενέργεια αυτή εµφανίζει τους φακέλους και τα αρχεία του τρέχοντος ιστού 

του Frontpage. 
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2. Στη συνέχεια θα εισάγετε ορισµένες εικόνες από τον σκληρό σας δίσκο στον τρέχοντα ιστό του 

Frontpage. Αφού µεταβείτε σε προβολή Φακέλων, κάντε διπλό κλικ στον φάκελο Images για να εµφανίσετε τα 

περιεχόµενα του (ο φάκελος αυτός µπορεί να είναι κενός τώρα, ή µπορεί να περιέχει εικόνες τις οποίες έχει 

τοποθετήσει εκεί ένα πρότυπο ή ένας οδηγός). 

 

3. Από το µενού File επιλέξτε την εντολή Import, θα εµφανιστεί το παράθυρο διαλόγου Import File To 

Frontpage Web (Εικόνα 4.9). 

 

 

 

 

 
ΕΙΚΟΝΑ 4,9 

 

Το παράθυρο διαλόγου Import File To Front Page Web σας βοηθά να συγκεντρώσετε  

όλες τις απαραίτητες εικόνες σε µια θέση. 
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4. Για να προσθέσετε ένα αρχείο εικόνας στον φάκελο Images, κάντε κλικ στο κουµπί Add File. θα 

εµφανιστεί το παράθυρο διαλόγου Add File To Import List. Χρησιµοποιήστε αυτό το παράθυρο διαλόγου όπως 

και οποιοδήποτε άλλο παράθυρο διαλόγου ανοίγµατος αρχείων στα Windows, για να εντοπίσετε την εικόνα 

που θέλετε να προσθέσετε στη σελίδα σας, κινούµενοι στο σύστηµα των φακέλων του σκληρού σας δίσκου 

µέχρι να εντοπίσετε και να επιλέξετε το επιθυµητό αρχείο εικόνας. Αφού τελειώσετε κάντε κλικ στο Open για 

να επιστρέψετε στο παράθυρο διαλόγου Import..., όπου θα δείτε το όνοµα του αρχείου που µόλις επιλέξατε. 

 

Εναλλακτικά, 

Για να προσθέσετε όλα τα περιεχόµενα ενός φακέλου (υποθέτοντας ότι ο φάκελος αυτός περιέχει µόνο 

αρχεία εικόνων) στον φάκελο Images του τρέχοντος ιστού του Frontpage, κάντε κλικ στο κουµπί Add Folder, 

θα εµφανιστεί το παράθυρο διαλόγου Browse For Folder, όπως βλέπετε στην Εικόνα 4.10. Εντοπίστε τον 

γεµάτο µε αρχεία εικόνων φάκελο σε µία µονάδα δίσκου του υπολογιστή σας ή του δικτύου σας και κάντε κλικ 

στο εικονίδιο του. Κάντε κλικ στο ΟΚ για να επιστρέψετε στο παράθυρο διαλόγου Import File, όπου θα δείτε 

τα ονόµατα όλων των αρχείων του φακέλου που µόλις επιλέξατε. 

 

Εναλλακτικά, 

Για να προσθέσετε αρχεία από µία υπάρχουσα τοποθεσία του Web, κάντε κλικ στο κουµπί From Web. θα 

εµφανιστεί το παράθυρο του οδηγού Import Web Wizard. Ακολουθήστε απλώς τις προτροπές του οδηγού για 

να εισάγετε το επιθυµητό αρχείο (ή αρχεία) από το Web. 
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ΕΙΚΟΝΑ 4,10 

Το παράθυρο διαλόγου Browse For Folders σας επιτρέπει να εισάγετε όλα τα αρχεία εικόνων ενός φακέλου 

µονοµιάς. 

 

 

 

5. Μπορείτε να επαναλάβετε το βήµα 4 όσες φορές χρειάζεται για να επιλέξετε όλες τις εικόνες που θέλετε 

να συγκεντρώσετε στον τρέχοντα ιστό του Frontpage. 

 

 

Όταν είστε έτοιµοι να αντιγράψετε αυτά τα αρχεία στον ιστό του Frontpage κάντε κλικ στο ΟΚ.  Τα αρχεία 

θα αρχίσουν να φορτώνονται και το παράθυρο διαλόγου Import File To Frontpage Web θα κλείσει αφού 

ολοκληρωθεί η αντιγραφή. 

Τώρα που έχετε εισάγει όλα τα αρχεία εικόνων στον κατάλληλο φάκελο του τρέχοντος ιστού, η τοποθέτηση 

αυτών των εικόνων στις ιστοσελίδες της τοποθεσίας σας θα είναι πανεύκολη. 
 

Τοποθέτηση Εικόνων σε Ιστοσελίδες 
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Τώρα που έχετε συγκεντρώσει τις επιθυµητές εικόνες σε µία κεντρική θέση µέσα στον τρέχοντα ιστό του 

Frontpage, µπορείτε να χρησιµοποιήσετε την προβολή Σελίδας για να τις τοποθετήσετε γρήγορα και εύκολα 

στις σελίδες σας. Για να ολοκληρώσετε τη βασική διαδικασία µεταφοράς µιας εικόνας και απόθεσης της πάνω 

στη σελίδα σας, ακολουθήστε τα παρακάτω βήµατα: 
 

1. Με ανοικτή την ιστοσελίδα που σας ενδιαφέρει στην προβολή Σελίδας, επιλέξτε την εντολή Insert > 

Picture > From File. θα εµφανιστεί το παράθυρο διαλόγου Image, όπως βλέπετε στην Εικόνα 4.11. 
 

 

ΕΙΚΟΝΑ 4,11 

Το παράθυρο διαλόγου Image σας επιτρέπει να εντοπίσετε και να εισάγετε την επιθυµητή εικόνα. 

2. To παράθυρο διαλόγου Image εµφανίζει τους φακέλους του τρέχοντος ιστού του Frontpage. Εάν η εικόνα 

είναι διαθέσιµη στον τρέχοντα ιστό, κάντε κλικ στον φάκελο στον οποίο περιέχεται  

(κατά πάσα πιθανότητα στον φάκελο Images) για να εµφανίσετε τα περιεχόµενα αυτού του φακέλου και 

κατόπιν κάντε κλικ στο όνοµα της επιθυµητής εικόνας. Η θέση του αρχείου της εικόνας εµφανίζεται στο πεδίο 

URL του παραθύρου διαλόγου. 
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3. Τώρα που έχετε καθορίσει τη θέση της εικόνας που θέλετε να προσθέσετε στη σελίδα σας, κάντε κλικ στο 

ΟΚ για να κλείσετε το παράθυρο διαλόγου Image, θα επιστρέψετε σε προβολή Σελίδας. 

 

Η εικόνα σας εµφανίζεται στο παράθυρο της προβολής Σελίδας. Μπορείτε να την αφήσετε στην τρέχουσα 

θέση της, ή να τη µεταφέρετε σε µία νέα θέση της σελίδας χρησιµοποιώντας τις γνωστές από τα Windows 

διαδικασίες αποκοπής και επικόλλησης. 

 

6. Κάντε κλικ στο ΟΚ για να κλείσει το παράθυρο διαλόγου Image Properties, θα επιστρέψετε σε προβολή 

Σελίδας, στην οποία µπορείτε να δείτε τα αποτελέσµατα των αλλαγών σας. 

Εάν το γραφικό σας δείχνει λίγο περίεργο, ή εάν δεν είναι αυτό ακριβώς που είχατε υπόψη, συνεχίστε τη 

διαδικασία προσαρµογής του επαναλαµβάνοντας τα παραπάνω βήµατα µέχρι να επιτύχετε την επιθυµητή 

εµφάνιση. 

Μία άλλη θαυµάσια χρήση των γραφικών είναι η δηµιουργία εικόνων φόντου. Αυτή η κατηγορία γραφικών 

αναφέρεται συχνά σαν εικόνες ταπετσαρίας (wallpaper) και µπορεί να αποτελέσει ένα θαυµάσιο διακοσµητικό 

ή σχεδιαστικό στοιχείο. Συνεχίστε το διάβασµα για περισσότερες πληροφορίες. 

 

Χρήση Ειδικών Εικόνων στο Φόντο 
 

 

Ενώ οι παλαιότερες εφαρµογές browser εµφάνιζαν το φόντο όλων των σελίδων σαν ένα οµοιόµορφο και 

βαρετό γκρι, οι περισσότερες µοντέρνες εφαρµογές browser µπορούν να εµφανίζουν πολύχρωµα φόντα, καθώς 

επίσης και φόντα αποτελούµενα από εικόνες - στην πραγµατικότητα, οποιαδήποτε εικόνα µπορεί να εµφανιστεί 

σε µία ιστοσελίδα, µπορεί επίσης να χρησιµοποιηθεί σαν φόντο. 

 Η δυνατότητα αυτή είναι θαυµάσια, αλλά µπορεί επίσης να αποδειχτεί σηµαντική αδυναµία στον τοµέα της 

σχεδίασης, θα πρέπει να προσέχετε ιδιαίτερα όταν σχεδιάζετε τις σελίδες σας: 

. 

 

Επιλογή Χρώµατος Φόντου 
 

Η επιλογή του χρώµατος φόντου για µία ιστοσελίδα είναι απλή υπόθεση. Ακολουθήστε τα παρακάτω 

βήµατα: 
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1. Με τη σελίδα της οποίας το φόντο θέλετε να προσαρµόσετε ανοικτή σε προβολή Σελίδας, επιλέξτε την 

εντολή Format > Background, θα εµφανιστεί το παράθυρο διαλόγου Page Properties, µε ορατή την καρτέλα 

Background (Εικόνα 4.17). 

 

2. Ανοίξτε την αναδιπλούµενη λίστα Background και επιλέξτε ένα από τα διαθέσιµα χρώµατα. Για να 

διαλέξετε ένα χρώµα εκτός από τα προκαθορισµένα διαθέσιµα χρώµατα, επιλέξτε Custom, θα εµφανιστεί το 

παράθυρο διαλόγου Color. 

 

ΕΙΚΟΝΑ 4,17 

Θα χρησιµοποιήσετε την καρτέλα Background του παραθύρου διαλόγου Properties για να αλλάζετε το 

χρώµα φόντου σελίδων σας. 

 

3. Κάντε κλικ στην τετράγωνη περιοχή επιλογής χρώµατος του παραθύρου διαλόγου Color για να διαλέξετε 

ένα χρώµα και κατόπιν κάντε κλικ στην περιοχή επιλογής τόνων (τη στενότερη περιοχή στα δεξιά του 
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ουράνιου τόξου) για να προσαρµόσετε τη φωτεινότητα του επιλεγµένου χρώµατος. Το χρώµα που επιλέξατε 

εµφανίζεται στην περιοχή Color/Solid του παραθύρου διαλόγου Color. 

 

4. Κάντε κλικ στο Add To Custom Colors· το χρώµα που επιλέξατε θα εµφανιστεί στην περιοχή Custom 

Colors του παραθύρου διαλόγου Color. 

 

5. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Color, θα επανεµφανιστεί το παράθυρο 

διαλόγου Page Properties. To χρώµα που επιλέξατε θα αναφέρεται σ' αυτό το παράθυρο διαλόγου, µαζί µε τη 

λέξη Custom, στην αναδιπλούµενη λίστα Background. 

 

6. Κάντε κλικ στο ΟΚ για να εφαρµόσετε το χρώµα φόντου που µόλις επιλέξατε στη σελίδα σας. Το 

παράθυρο διαλόγου Page Properties κλείνει και εσείς επιστρέφετε σε προβολή Σελίδας, µε το νέο χρώµα στο 

φόντο της σελίδας σας. 
 

Μπορείτε να επαναλάβετε τα παραπάνω βήµατα όσες φορές θέλετε, µέχρι να βρείτε ένα χρώµα το οποίο καλύπτει τις ανάγκες σας. 

 

 

Eπιλογή Εικόνας Φόντου 
 

Η επιλογή µιας εικόνας για το φόντο µιας σελίδας είναι παρόµοια µε τον καθορισµό ενός χρώµατος φόντου. 

Η εικόνα που επιλέγετε θα πρέπει να είναι αδιόρατη και να εξυπηρετεί τον σκοπό που υποδηλώνει το όνοµα 

της - ένα φόντο πάνω στο οποίο θα κάθεται το κείµενο της σελίδας. Οι εφαρµογές browser που µπορούν να 

εµφανίζουν εικόνες φόντου έχουν τη δυνατότητα να επαναλαµβάνουν την εικόνα σε πλευρική παράθεση - σαν 

να ήταν ένα πλακίδιο σ' ένα µεγαλύτερο µωσαϊκό - µέχρι να γεµίσει όλο το παράθυρο της εφαρµογής, 

ανεξαρτήτως του µεγέθους του. Εάν έχετε ασχοληθεί ποτέ µε την αλλαγή της ταπετσαρίας στην επιφάνεια 

εργασίας των Windows, τότε πιθανότατα γνωρίζετε το αποτέλεσµα της πλευρικής παράθεσης. 

Η επιλογή µιας εικόνας φόντου για µία ιστοσελίδα είναι απλή υπόθεση.  

Ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ανοικτή τη σελίδα που σας ενδιαφέρει σε προβολή Σελίδας, επιλέξτε την εντολή Format > 

Background, θα εµφανιστεί το παράθυρο διαλόγου Page Properties, µε ορατή την καρτέλα Background 

(φόντο). 
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2. Μαρκάρετε το πλαίσιο ελέγχου Background Image. To κουµπί Browse γίνεται διαθέσιµο (δεν 

εµφανίζεται πλέον αµυδρό). 

 

3. Στο πεδίο Background Image πληκτρολογήστε το πλήρες όνοµα διαδροµής της θέσης στην οποία 

βρίσκεται η εικόνα φόντου που θέλετε να χρησιµοποιήσετε, ή κάντε κλικ στο κουµπί Browse για να εντοπίσετε 

και να επιλέξετε µία θέση µέσα σε έναν ιστό του Frontpage ή στον υπολογιστή σας. 

 

4. Εάν χρησιµοποιείτε µία µεγάλη εικόνα για το φόντο της σελίδας σας (µία εικόνα η οποία καταλαµβάνει 

χώρο περίπου όσο και µία σελίδα οθόνης) µπορείτε να µαρκάρετε το πλαίσιο ελέγχου Watermark 

(υδατογράφηµα). 

 

5. Όταν είστε έτοιµοι, κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Page Properties, θα 

επιστρέψετε σε προβολή Σελίδας. 

Ελέγξτε προσεκτικά για να βεβαιωθείτε ότι η εικόνα σας έχει την επιθυµητή εµφάνιση τώρα που 

επαναλαµβάνεται σε πλευρική παράθεση σε όλο το µήκος και το πλάτος της οθόνης - περίπου έτσι θα τη 

βλέπουν και όλοι οι υπόλοιποι άνθρωποι στο Web. Εάν σας αρέσει αυτό που βλέπετε, είστε έτοιµοι. Εάν όχι, 

αλλάξτε τις ρυθµίσεις για την εικόνα. 

Στο σηµείο αυτό θα πρέπει να έχετε µία ωραία σε εµφάνιση σελίδα. Αλλά αποµένει να προσθέσετε ένα από 

τα σηµαντικότερα κοµµάτια στο παζλ του Web: τους συνδέσµους, ή δεσµούς υπερκειµένου! 

 

Προσθήκη Συνδέσµων (∆εσµών Υπερκειµένου) 
 

Οι δεσµοί υπερκειµένου (hyperlinks), οι οποίοι αποκαλούνται επίσης σύνδεσµοι (links) είναι το στοιχείο 

που κάνει τη µεγάλη διαφορά µεταξύ του Web και των άλλων µέσων - ανεξάρτητα από το πόσο σκληρά θα 

προσπαθήσετε, δεν µπορείτε να κάνετε κλικ σε έναν χάρτη τον οποίο βλέπετε στην τηλεόραση, στο όνοµα ενός 

συγγραφέα σ' ένα περιοδικό, ή στον τίτλο ενός ποιήµατος σ' ένα βιβλίο. (Τουλάχιστον όχι ακόµη!). 

Όπως αναµφίβολα γνωρίζετε εάν έχετε βρεθεί στο Web έστω και για 15 µόνο λεπτά, ένας σύνδεσµος (ή 

δεσµός υπερκειµένου) µπορεί να δείχνει σε οποιαδήποτε διεύθυνση του Internet - η οποία, µε τη σειρά της, 

µπορεί να αντιπροσωπεύει πολλούς διαφορετικούς τοµείς και πόρους πληροφοριών, όπως π.χ. έναν διακοµιστή 

FTP, ένα αρχείο, µία εφαρµογή, ένα κλιπ πολυµέσων, µία διεύθυνση ηλεκτρονικού ταχυδροµείου, ή τη 

διεύθυνση µιας οµάδας συζήτησης (newsgroup). Οποιαδήποτε "δηµόσιας πρόσβασης" θέση του Internet µπορεί 

να προσπελάζεται µέσω του Web χρησιµοποιώντας συνδέσµους (δεσµούς υπερκειµένου). 
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Γενικά υπάρχουν πολλά είδη διευθύνσεων URL, αλλά ειδικά για τους συνδέσµους υπάρχουν µόνο δύο είδη 

διευθύνσεων: οι σχετικές (relative) και οι απόλυτες (absolute). Οι σχετικές διευθύνσεις περιέχουν µόνο ένα 

όνοµα αρχείου, την επέκταση του, και πιθανώς τη θέση του µέσα στον κατάλογο αρχείων. Μία σχετική 

διεύθυνση URL δείχνει σε ένα αρχείο το οποίο βρίσκεται στον ίδιο διακοµιστή Web. Για παράδειγµα, όταν 

διασυνδέετε µία σελίδα µε µία άλλη σελίδα η οποία βρίσκεται στον ίδιο φάκελο του τρέχοντος ιστού του 

Frontpage, µπορείτε απλά να υποδείξετε το όνοµα αρχείου της: figs.html. Εάν βρίσκεστε στον κύριο φάκελο 

αλλά έχετε την εικόνα αποθηκευµένη στον υποφάκελο Images, µπορείτε να δείξετε στο αρχείο αυτής της 

εικόνας χρησιµοποιώντας µία σχετική διεύθυνση. Η διεύθυνση αυτή θα έδειχνε ως εξής: images / figs.gif.H 

χρήση σχετικών διευθύνσεων είναι καλή πρακτική όταν διασυνδέετε τα στοιχεία της ίδιας τοποθεσίας, επειδή 

διευκολύνει τη συντήρηση της τοποθεσίας. Εάν έχετε χρησιµοποιήσει σχετικές διευθύνσεις, µπορείτε να 

µετακινείτε αρχεία από έναν φάκελο ενός διακοµιστή Web σ' έναν διαφορετικό φάκελο του ίδιου διακοµιστή, 

χωρίς να χρειάζεται να κάνετε µεγάλης έκτασης αλλαγές στον HTML κώδικα της τοποθεσίας σας. 

 

Από την άλλη, εάν γράφατε ολόκληρη τη διεύθυνση URL µε την τυπική της µορφή, όπως π.χ. http: //www. 

my site. corn/figs .html, τότε θα χρησιµοποιούσατε µία απόλυτη διεύθυνση. Οι απόλυτες διευθύνσεις ξεκινούν 

µε ένα προσδιοριστικό πρωτοκόλλου, όπως το http: //, το ftp: //, ή οτιδήποτε άλλο. (Ένα πρωτόκολλο είναι 

απλά ένας προσυµφωνηµένος τρόπος εκτέλεσης ενεργειών. HTTP είναι το όνοµα του πρωτοκόλλου 

Μεταφοράς Υπερκειµένου, το οποίο χρησιµοποιείται για τη διακίνηση των Ιστοσελίδων στο Web). To 

προσδιοριστικό πρωτοκόλλου ακολουθείται από το υπόλοιπο τµήµα µιας πλήρους διεύθυνσης URL. Ο όρος 

"απόλυτη διεύθυνση" υποδεικνύει ότι δε δίνεται απλά και µόνο το όνοµα του εγγράφου όπως έχει αποθηκευτεί 

σε έναν διακοµιστή, αλλά ολόκληρη η διαδροµή που οδηγεί στη θέση του αρχείου. 

 

Γενικά, οι σύνδεσµοι που δείχνουν σε τοπικούς πόρους - στοιχεία αποθηκευµένα στον ίδιο διακοµιστή - 

χρησιµοποιούν σχετικές διευθύνσεις, ενώ οι σύνδεσµοι που δείχνουν σε οποιαδήποτε άλλη θέση του 

κυβερνοχώρου χρησιµοποιούν απόλυτες διευθύνσεις Εάν συνεχίζετε να µην κατανοείτε πλήρως αυτό το 

σκεπτικό, το Frontpage θα φρόντισε να σας το καταστήσει σαφές πολύ σύντοµα. Συνεχίστε απλώς το 

διάβασµα. 

 

 

 

 

∆ιασύνδεση µε µία Σελίδα του Τρέχοντος Ιστού του Frontpage 
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Η διασύνδεση δύο σελίδων που ανήκουν στον ίδιο ιστό του Front Page είναι ένα τέλειο παράδειγµα 

σχετικής διασύνδεσης στην ορολογία του Front Page αποκαλείτε εσωτερική διασύνδεση (internal 

hyperlink). 

 

Η εσωτερική διασύνδεση σας επιτρέπει να αναφερθείτε σε έγγραφα που ανήκουν στον ίδιο ιστό του 

Frontpage. Μπορεί επίσης να ακούσετε αυτό τον όρο να περιγράφει τους συνδέσµους που οδηγούν σε 

διαφορετικές θέσεις µέσα στην ίδια ιστοσελίδα. 

 

 

Υποθέστε ότι υπάρχουν δύο σελίδες στον τρέχοντα ιστό του Frontpage: οι default . html και new. html. 

Πιθανότατα θα θέλετε να διασυνδέσετε αυτές τις δύο σελίδες. Ας υποθέσουµε επίσης ότι έχετε ανοικτή τη 

σελίδα default, html σε προβολή Σελίδας και θέλετε να δηµιουργήσετε έναν σύνδεσµο (δεσµό υπερκειµένου) 

από αυτή, προς τη σελίδα new. html η οποία είναι αποθηκευµένη στον ίδιο φάκελο µε τη σελίδα home. html 

στον τρέχοντα ιστό του Frontpage. Ακολουθήστε τα παρακάτω βήµατα: 

 

 

1.  Με ανοικτό το Frontpage και ορατό το έγγραφο σας στο παράθυρο του, πληκτρολογήστε τη λέξη που 

θέλετε να χρησιµοποιήσετε σαν δεσµό υπερκειµένου και κατόπιν επιλέξτε την. Στο παράδειγµα µας θα 

µπορούσατε να πληκτρολογήσετε τη φράση What's new (ή Τι Νέο Υπάρχει) στη σελίδα default. html. 

 

 

 

2.  Από τη γραµµή των µενού στο παράθυρο µε την προβολή Σελίδας επιλέξτε την εντολή Insert > 

Hyperlink (ή κάντε κλικ στο κουµπί Hyperlink της Βασικής γραµµής εργαλείων, ή χρησιµοποιήστε τον 

συνδυασµό πλήκτρων Ctrl + Κ). θα εµφανιστεί το παράθυρο διαλόγου Create Hyperlink (Εικόνα 4.18). 
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ΕΙΚΟΝΑ 4,18 

 

Θα χρησιµοποιείτε το παράθυρο διαλόγου Create Hyperlink για να καθορίσετε τη διεύθυνση URL ενός 

συνδέσµου (δεσµού).  

 

3. Στο παράθυρο διαλόγου Create Hyperlink θα πρέπει να βλέπετε τα ονόµατα αρχείων και τους τίτλους των 

σελίδων του τρέχοντος ιστού του Frontpage. Επιλέξτε το αρχείο στο οποίο θέλετε να δείχνει ο σύνδεσµος που 

δηµιουργείτε κάνοντας κλικ πάνω του- η διεύθυνση URL αυτού του αρχείου θα εµφανιστεί στο πεδίο URL. 

 

4. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου· θα επιστρέψετε σε προβολή Σελίδας. 

 

Στο σηµείο αυτό θα πρέπει να βλέπετε τη λέξη που χρησιµοποιήσατε στον δεσµό (What's New στο 

παράδειγµα µας) υπογραµµισµένη και µε διαφορετικό χρώµα. Περάστε τον δείκτη του ποντικιού πάνω από τον 

δεσµό ( η ενέργεια αυτή αποκαλείτε mouse over ) και θα δείτε τη διεύθυνση της σελίδας να εµφανίζεται στην 

γραµµή καταστάσεων της προβολής σελίδας. 

Θα µπορούσατε να ακολουθήσετε τα ίδια βήµατα για να τοποθετήσετε έναν σύνδεσµο (δεσµό) στη σελίδα 

new. html, ο οποίος θα σας οδηγεί πίσω στην αρχική σελίδα. 
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Τι Είναι οι Πίνακες; 
 

Οι πίνακες της HTML δεν είναι τίποτα περισσότερο από τους πίνακες που βλέπετε στα βιβλία, στα φύλλα 

εργασίας και σε πολλά άλλα έγγραφα. Ένας πίνακας είναι απλά ένας τρόπος οργάνωσης και παρουσίασης των 

πληροφοριών ο οποίος χρησιµοποιεί γραµµές και στήλες για την οµαδοποίηση σχετιζόµενων στοιχείων.  

Οι επιστήµονες, οι οποίοι θέλουν να παρουσιάζουν τα αποτελέσµατα των πειραµάτων τους µε περισσότερες 

από µία-δύο µεταβλητές διευθετούν τα δεδοµένα τους σε ευανάγνωστα πλέγµατα (πίνακες) έτσι ώστε οι ίδιοι 
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να µπορούν να ανατρέχουν σ' αυτά µελλοντικά, και οι συνάδελφοι' τους να µπορούν να συγκρίνουν εύκολα τα 

διάφορα στοιχεία των αποτελεσµάτων. Γι' αυτό ακριβώς τον λόγο χρησιµοποιήθηκαν αρχικά οι πίνακες και στο 

Web: έτσι ώστε η κοινότητα των επιστηµόνων να µπορεί να ανταλλάσσει δεδοµένα µε έναν γρήγορο και 

αποτελεσµατικό τρόπο. 

 

∆ηµιουργία Ενός Απλού Πίνακα 
 

Η εισαγωγή ενός πίνακα σε µία ιστοσελίδα είναι πανεύκολη υπόθεση. Μπορείτε να δηµιουργήσετε έναν 

πίνακα ο οποίος θα καταλαµβάνει ολόκληρο το χώρο της σελίδας, ή µόνο ένα µέρος της - και µπορείτε να 

αλλάξετε τις διαστάσεις του πίνακα αργότερα, εάν χρειαστεί. Μέχρι να τοποθετήσετε το δικό σας περιεχόµενο 

στα κελιά, αυτά θα έχουν όλα ίσο µέγεθος και θα δείχνουν µάλλον µικρά πάνω στη σελίδα. 

 

Ο Πρώτος Τρόπος ∆ηµιουργίας Πίνακα 
 

Ο απλούστερος τρόπος για να δηµιουργήσετε έναν πίνακα είναι η χρήση του κουµπιού Insert Table 

(εισαγωγή πίνακα) της Βασικής γραµµής εργαλείων του Frontpage. Κάντε κλικ σ' αυτό το κουµπί και θα 

τοποθετηθεί αµέσως ένας πίνακας στη σελίδα σας. Με τον τρόπο αυτό µπορείτε να δηµιουργήσετε έναν πίνακα 

ενός κελιού ή έναν πίνακα µε διαστάσεις 4 επί 5 (20 κελιά). Για τον σκοπό αυτό, ακολουθήστε τα παρακάτω 

βήµατα: 

 1. Με ανοικτή µία σελίδα σε προβολή Σελίδας, κάντε κλικ στο κουµπί Insert Table της    Βασικής γραµµής 

εργαλείων. Στην οθόνη σας θα εµφανιστεί µία αναδιπλούµενη παλέτα επιλογής γραµµών/στηλών πίνακα. 

 

 

 

 
 

2. Κάντε κλικ σε ένα από τα κελιά αυτής της παλέτας για να υποδείξετε τις επιθυµητές διαστάσεις για τον 

πίνακα που θέλετε να δηµιουργήσετε. Για παράδειγµα, εάν θέλετε να δηµιουργήσετε έναν πίνακα µε 3 στήλες 
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πλάτος και 3 γραµµές ύψος θα έπρεπε να κάνετε κλικ στο κελί που απέχει τρία κελιά από το αριστερό και πάνω 

άκρο της παλέτας. Αφού κάνετε κλικ στο επιθυµητό κελί της παλέτας, η παλέτα θα κλείσει και ένας κενός 

πίνακας θα εµφανιστεί στη σελίδα σας. 

Για τον πίνακα που µόλις δηµιουργήσατε ισχύουν οι προεπιλεγµένες ρυθµίσεις του Frontpage. Για 

παράδειγµα, ο πίνακας σας θα καταλαµβάνει πιθανότατα το 100 τοις εκατό του πλάτους της οθόνης και θα έχει 

περίγραµµα πάχους 1 pixel. 

Φυσικά, εάν έχετε αλλάξει ήδη τις προεπιλεγµένες ρυθµίσεις για τους πίνακες, θα ισχύουν οι τελευταίες 

ρυθµίσεις που καθορίσατε στο πρόγραµµα. Καθώς προχωράτε σ' αυτό το κεφάλαιο θα µάθετε περισσότερα για 

την αλλαγή των προεπιλεγµένων ρυθµίσεων έτσι ώστε να δίνετε σε κάθε πίνακα την επιθυµητή εµφάνιση. 

 

Ένας ∆εύτερος Τρόπος ∆ηµιουργίας Πίνακα 

 

Σ' αυτή την ενότητα θα χρησιµοποιήσετε το παράθυρο διαλόγου Insert Table (εισαγωγή πίνακα) για να 

δηµιουργήσετε έναν απλό πίνακα ο οποίος θα έχει δύο στήλες και τέσσερις γραµµές (σύνολο οκτώ κελιά). 

Ακολουθήστε τα παρακάτω βήµατα: 

1. Ανοίξτε το Frontpage και δηµιουργήστε µία νέα ιστοσελίδα µε τη συνήθη διαδικασία (ή ανοίξτε µία 

υπάρχουσα ιστοσελίδα στην οποία θέλετε να προσθέσετε έναν πίνακα). 

 

2. Κάντε κλικ για να τοποθετήσετε το σηµείο εισαγωγής στη θέση της σελίδας στην οποία θέλετε να 

εµφανιστεί ο πίνακας και από τη γραµµή των µενού επιλέξτε την 

εντολή Table >· Insert Table, θα εµφανιστεί το παράθυρο διαλόγου Insert Table, το οποίο βλέπετε στην 

Εικόνα 11.7. 
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EIKONA 11,7 

Το παράθυρο διαλόγου Insert Table σας επιτρέπει να καθορίσετε τις αρχικές ρυθµίσεις για έναν πίνακα 

 

3. Στην περιοχή Size (µέγεθος) του παραθύρου διαλόγου βλέπετε ότι οι προεπιλεγµένες ρυθµίσεις για το 

πλήθος των γραµµών (Rows) είναι 2, όπως επίσης και για το πλήθος των στηλών (Columns). Αυτές είναι οι 

ρυθµίσεις που πρέπει να προσαρµόσετε για να δηµιουργήσετε έναν πίνακα µε διαφορετικό αριθµό γραµµών 

(κατά πλάτος της σελίδας) ή στηλών (κατά το ύψος της σελίδας). 

 Για να δηµιουργήσετε έναν πίνακα µε τέσσερις γραµµές, πληκτρολογήστε 4 στο πεδίο Rows. 

 

4. Στην ενότητα Layout (διάταξη) του παραθύρου διαλόγου Insert Table µπορείτε να καθορίσετε εάν ο 

πίνακας σας θα στοιχίζεται αριστερά, στο κέντρο ή δεξιά, επιλέγοντας την κατάλληλη ρύθµιση (Left, Center ή 

Right) από την αναδιπλούµενη λίστα Alignment. Εάν αποφασίσετε να αφήσετε τη ρύθµιση "Default" 

(προεπιλεγµένη) στην αναδιπλούµενη λίστα Alignment, ο πίνακας σας θα στοιχιστεί ανάλογα µε τη θέση στην 

οποία είχατε τοποθετήσει το σηµείο εισαγωγής πάνω στη σελίδα πριν εισάγετε τον πίνακα. Για να κεντράρετε 

τον πίνακα σας πάνω στη σελίδα, επιλέξτε τη ρύθµιση Center από την αναδιπλούµενη λίστα Alignment. 

 

5. Στις περισσότερες περιπτώσεις είναι ευκολότερο να δουλέψει κανείς µ' έναν πίνακα εάν ο πίνακας έχει 

ορατά τα περιγράµµατα του. Μπορείτε να αφαιρέσετε το περίγραµµα ανά πάσα στιγµή, αλλά για την ώρα 
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καθορίστε περίγραµµα πάχους 1 pixel γύρω απ' όλα τα κελιά του πίνακα πληκτρολογώντας την τιµή 1 στο 

πεδίο Border Size (µέγεθος περιγράµµατος). 

 

6. θα µιλήσουµε για τις επιλογές Cell Padding και Cell Spacing παρακάτω σ' αυτό το κεφάλαιο· για την ώρα, 

αφήστε τις ρυθµίσεις τους άθικτες. 

 

7. Η τελευταία περιοχή του παραθύρου διαλόγου περιέχει επιλογές για το πλάτος που θα καταλαµβάνει στην 

οθόνη ο πίνακας σας. Εάν δεν καθορίσετε συγκεκριµένο πλάτος, το πλάτος του πίνακα θα προσαρµόζεται 

ανάλογα µε τα µεγαλύτερα αντικείµενα που τοποθετείτε µέσα στα κελιά του. Για να καθορίσετε ένα 

συγκεκριµένο πλάτος για τον πίνακα σας, µαρκάρετε το πλαίσιο ελέγχου Specify Width για να εµφανίσετε τις 

κατάλληλες επιλογές. 

 

8. Εάν θέλετε ο πίνακας σας να καταλαµβάνει ένα συγκεκριµένο ποσοστό του παραθύρου, κάντε κλικ στο 

κουµπί In Percent για να το ενεργοποιήσετε. Για να καθορίσετε το πλήθος των pixels που θα πρέπει να 

καταλαµβάνει ο πίνακας σας κατά πλάτος της οθόνης, κάντε κλικ στο κουµπί In Pixels. Σε κάθε περίπτωση, 

πληκτρολογήστε µία τιµή στο πεδίο Specify Width. Για παράδειγµα, εάν θέλετε ο πίνακας σας να 

καταλαµβάνει το 50 τοις εκατό του πλάτους του παραθύρου κάντε κλικ στο κουµπί I n Percent και κατόπιν 

πληκτρολογήστε 50 στο πεδίο Specify Width. 

 

9. Είστε τώρα έτοιµοι να οριστικοποιήσετε την εισαγωγή του πίνακα στη σελίδα. Κάντε κλικ στο ΟΚ για να 

κλείσετε το παράθυρο διαλόγου Insert Table. Ο πίνακας σας θα πρέπει να εµφανιστεί στη σελίδα περίπου όπως 

δείχνει στην Εικόνα 11.8. 
Έχετε τώρα τον πρώτο σας πίνακα και είστε έτοιµοι να τον χρησιµοποιήσετε για την καλύτερη διευθέτηση του υλικού σας πάνω στη σελίδα. 

 

 

ΕΙΚΟΝΑ 11,8 

Τοποθέτηση Κειµένου και Εικόνων στα Κελιά ενός Πίνακα 

 

Αφού δηµιουργήσετε τον πίνακα σας, θα πρέπει να τοποθετήσετε το κατάλληλο περιεχόµενο στα κελιά του. 

Μπορείτε να πληκτρολογήσετε ή να επικολλήσετε κείµενο στα κελιά ενός πίνακα, ακριβώς όπως θα το κάνατε 

και σε οποιοδήποτε σηµείο µιας ιστοσελίδας. Κάντε απλώς κλικ µε το σηµείο εισαγωγής στη θέση στην οποία 
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θέλετε να εµφανιστεί το κείµενο σας και ξεκινήστε την πληκτρολόγηση. Αφού πληκτρολογήσετε λίγο κείµενο 

στον πίνακα σας, µπορείτε να το διαχειριστείτε ακριβώς όπως και οποιοδήποτε άλλο κείµενο σε µία 

ιστοσελίδα, χρησιµοποιώντας τα γνωστά εργαλεία του Frontpage για τη δηµιουργία διαφορετικών στυλ 

κειµένου, την επιλογή γραµµατοσειρών, µεγεθών και χρωµάτων, ή οτιδήποτε άλλο θέλετε. Αν και η 

τροποποίηση του κειµένου και των εικόνων ενός πίνακα δε διαφέρει και πολύ από τις αντίστοιχες διαδικασίες 

που θα εκτελούσατε σε οποιοδήποτε άλλο σηµείο µιας ιστοσελίδας, στη συνέχεια θα σας παρουσιάσω 

ορισµένα συγκεκριµένα στοιχεία τα οποία µπορείτε να χρησιµοποιείτε για να βελτιώνετε την εµφάνιση των 

πινάκων σας. Η τοποθέτηση εικόνων στα κελιά ενός πίνακα δε διαφέρει από την τοποθέτηση µιας εικόνας ή 

οποιουδήποτε άλλου γραφικού σε οποιοδήποτε σηµείο µιας ιστοσελίδας. θα πρέπει ωστόσο να γνωρίζετε ότι 

όταν εισάγετε µία εικόνα ή ένα γραφικό σε ένα κελί ενός πίνακα, οι διαστάσεις του κελιού επεκτείνονται έτσι 

ώστε να χωρέσει ολόκληρη η εικόνα. Αυτό µπορεί να είναι είτε πλεονέκτηµα, είτε µειονέκτηµα- φυσικά, είναι 

πολύ πιο εύκολο να τοποθετήσετε πρώτα την εικόνα και να αφήσετε το κελί να επεκταθεί µόνο του, παρά να 

προσπαθήσετε να δηµιουργήσετε εξαρχής ένα κελί το οποίο θα έχει επακριβώς το µέγεθος της εικόνας σας. 

Από την άλλη, εάν περιορίζεστε σε συγκεκριµένο πλάτος και ύψος για τον πίνακα σας, ίσως χρειαστεί να 

αναθεωρήσετε τα πλάνα σας για να µπορέσετε να χρησιµοποιήσετε τις εικόνες που έχετε ήδη. 

Ευθυγράµµιση Κειµένου και Εικόνων στα Κελιά ενός Πίνακα 
 

Ακριβώς όπως µπορείτε να αλλάξετε την ευθυγράµµιση (στοίχιση) του κειµένου σε µία συµβατική ιστοσελίδα, µπορείτε να αλλάζετε και τη στοίχιση 

του κειµένου ή των εικόνων που τοποθετείτε στα κελιά ενός πίνακα. Σε µία στάνταρ ιστοσελίδα µπορείτε να στοιχίσετε το κείµενο και τις 

παραγράφους ως προς το αριστερό ή το δεξιό περιθώριο, ή ως προς το κέντρο της σελίδας. Για το κείµενο που εισάγετε στα κελιά ενός πίνακα 

έχετε τις ίδιες ακριβώς επιλογές στοίχισης, αλλά και ορισµένες επιπλέον: 

συγκεκριµένα, µπορείτε να ευθυγραµµίσετε το κείµενο ως προς την πάνω ή κάτω πλευρά ενός κελιού, ως 

προς το µέσον του κελιού, ή ως προς τη γραµµή βάσης.  

Για να αλλάξετε τη στοίχιση του κειµένου ενός κελιού, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Αφού ανοίξετε τη σελίδα που σας ενδιαφέρει και εµφανίσετε τον πίνακα µε τον οποίο θέλετε να 

δουλέψετε, κάντε κλικ µε το δεξιό πλήκτρο του ποντικιού στο κελί του οποίου τη στοίχιση θέλετε να αλλάξετε. 

Από το µενού συντόµευσης που εµφανίζεται, επιλέξτε Cell Properties (ιδιότητες κελιού), θα εµφανιστεί το 

παράθυρο διαλόγου Cell Properties (Εικόνα 11.10). 
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ΕΙΚΟΝΑ 11,10 

Το παράθυρο διαλόγου Cell Properties σας επιτρέπει να αλλάξετε την στοίχιση του κειµένου σε ένα κελί 

µεταξύ άλλων πραγµάτων 

 

2. Στην περιοχή Layout του παραθύρου διαλόγου ανοίξτε την αναδιπλούµενη λίστα Horizontal Alignment 

(οριζόντια στοίχιση) και επιλέξτε την επιθυµητή ρύθµιση (Left-αριστερά, Right-δεξιά, ή Center-στο κέντρο). Η 

ρύθµιση Default επιτρέπει στην εφαρµογή browser να διερµηνεύσει µόνη της τη στοίχιση (γενικά, σαν 

αριστερή στοίχιση). 

 

3. Στην περιοχή Layout ανοίξτε επίσης την αναδιπλούµενη λίστα Vertical Alignment και επιλέξτε µία 

ρύθµιση για την κατακόρυφη στοίχιση (Τορ-πάνω, Middle-µέσον, Baseline-γραµµή βάσης, ή Bottom-κάτω). Η 

ρύθµιση Default επιτρέπει στην εφαρµογή browser να διερµηνεύσει µόνη της τη στοίχιση (γενικά, σαν 

στοίχιση στο µέσον). 

 

4. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Cell Properties. Οποιοδήποτε κείµενο ή 

εικόνες υπάρχουν στο επηρεαζόµενο κελί επαναπροσαρµόζονται συµφωνά µε τις νέες προδιαγραφές στοίχισης. 
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Εάν το κελί δεν περιέχει ακόµη κείµενο ή εικόνες, τα στοιχεία αυτά θα στοιχιστούν συµφωνά µε τις ρυθµίσεις 

που επιλέξατε παραπάνω, εάν και όποτε τα τοποθετήσετε. 

 

 

Προσθήκη Μεµονωµένων Κελιών σε Έναν Πίνακα 

Εξ ορισµού, τα κελιά προστίθενται στη δεξιά πλευρά ενός πίνακα (ή στην αριστερή, εάν ο πίνακας είναι δεξιά στοιχισµένος). Για να προσθέσετε ένα 

κελί, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ορατή την ιστοσελίδα και τον πίνακα που σας ενδιαφέρει, κάντε κλικ οπουδήποτε µέσα στον πίνακα. 

 

2. Από τη γραµµή των µενού, επιλέξτε την εντολή Table >· Insert Cell (εισαγωγή κελιού). Ιδού! Ο πίνακας 

σας έχει τώρα ένα νέο κελί.  

Φυσικά, µπορείτε να προσθέσετε δύο, τρία, ή όσα κελιά θέλετε µ' αυτό τον τρόπο (ένα προς ένα), αλλά εάν 

θέλετε να προσθέσετε µία ολόκληρη νέα γραµµή ή στήλη κελιών, είναι προτιµότερο να ακολουθήσετε τις 

οδηγίες της προηγούµενης ενότητας. 

∆ιαίρεση Κελιών 
 

Εάν θέλετε, µπορείτε να δηµιουργήσετε ενδιαφέροντα εφέ διαιρώντας ένα ή περισσότερα από τα κελιά του 

πίνακα σας. Η διαίρεση κόβει ουσιαστικά ένα κελί σε µικρότερα κοµµάτια, µε αποτέλεσµα να σχηµατίζεται µία 

µίνι-γραµµή ή στήλη µέσα σ' αυτό το κελί. 
Για να διαιρέσετε ένα κελί, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Αφού εµφανίσετε την ιστοσελίδα µε τον πίνακα που σας ενδιαφέρει, κάντε κλικ µέσα στο κελί του πίνακα 

το οποίο θέλετε να διαιρέσετε. 

 

2. Από τη γραµµή των µενού, επιλέξτε την εντολή Table >· Split Cells (διαίρεση κελιών), θα εµφανιστεί το 

παράθυρο διαλόγου Split Cells (Εικόνα 11.17). 

 

3. Στο παράθυρο διαλόγου, κάντε κλικ στο στρογγυλό κουµπί Split Into Columns ή στο στρογγυλό κουµπί 

Split Into Rows, ανάλογα µε το εάν θέλετε να διαιρέσετε το επιλεγµένο κελί σε στήλες ή σε γραµµές. 

4. Εξ ορισµού ένα κελί διαιρείται σε δύο, αλλά εάν θέλετε µπορείτε να το χωρίσετε σε µικρότερα κοµµάτια, 

πληκτρολογώντας την επιθυµητή τιµή στο πεδίο Number Of Columns (ή Rows). 
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5. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Split Cells, θα επιστρέψετε στη σελίδα σας, 

στην οποία θα πρέπει να δείτε το αποτέλεσµα της διαίρεσης του κελιού. 

 

 

ΕΙΚΟΝΑ 11,17 

Το παράθυρο διαλόγου Split Cells 

Αφού διαιρέσετε ένα ή περισσότερα κελιά µπορείτε να κάνετε οτιδήποτε θέλετε µε τα νέα κοµµάτια που θα προκύψουν, όπως για παράδειγµα να 

εφαρµόσετε διαφορετικό χρώµα σε κάθε κοµµάτι . 

 

 

 

 

 

 
 
 
 

 

 

Τα πλαίσια (frames) µπορούν να κάνουν µία ολόκληρη τοποθεσία του Web προ-πελάσιµη από µία και µόνο 

οθόνη. Τα πλαίσια διαχωρίζουν το παράθυρο της εφαρµογής browser σε µικρότερα παράθυρα, καθένα εκ των 

οποίων µπορεί να περιέχει µία µεµονωµένη ιστοσελίδα. Μία ιστοσελίδα η οποία εµφανίζεται µέσα σ' ένα 

πλαίσιο µπορεί να περιλαµβάνει οποιοδήποτε στοιχείο µπορείτε να συµπεριλάβετε και σε µία συµβατική 

ιστοσελίδα. Η ισχύς που σας παρέχουν τα πλαίσια όσον αφορά στις µετακινήσεις µεταξύ των ιστοσελίδων µιας 

τοποθεσίας µπορεί να είναι εκπληκτική, και το Frontpage σας παρέχει τον ευκολότερο δυνατό τρόπο για να 

δηµιουργήσετε µία πλήρως λειτουργική, βασιζόµενη σε πλαίσια τοποθεσία στο Web. 
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Σ' αυτό το κεφάλαιο θα ξεκινήσετε µε ένα πρότυπο δηµιουργίας πλαισίων και κατόπιν θα τροποποιήσετε τη 

διάταξη, το περιεχόµενο και τους µηχανισµούς πλοήγησης που θα δηµιουργηθούν. Επειδή τα πλαίσια 

δουλεύουν µόνο σε συγκεκριµένες εφαρµογές browser - Netscape Navigator έκδοση 2 ή µεταγενέστερη και 

Microsoft Internet Explorer έκδοση 3 ή µεταγενέστερη - θα εξετάσουµε επίσης τι µπορείτε να κάνετε για τους 

επισκέπτες της τοποθεσίας σας οι οποίοι χρησιµοποιούν άλλες, µειωµένων δυνατοτήτων εφαρµογές browser. 

 

Πώς Λειτουργούν τα Πλαίσια; 
 

Όταν σχεδιάζονται σωστά, τα πλαίσια δείχνουν θαυµάσια. και, στην πραγµατικότητα, λειτουργούν ακόµη 

καλύτερα απ' όσο δείχνουν, ανόµοια µε τα περισσότερα πλαίσια. Τα πλαίσια είναι µία πολύ καλή παροµοίωση 

για τις βασιζόµενες σε πλαίσια ιστοσελίδες, επειδή υπάρχει πάντα µία πατρική ιστοσελίδα η οποία αποκαλείται 

σελίδα πλαισίων (frames page) στην ορολογία του Frontpage και η οποία καθορίζει τις γενικές οδηγίες για τη 

λειτουργία των θυγατρικών της σελίδων, οι οποίες στο Frontpage αποκαλούνται σελίδες περιεχοµένου (content 

pages). Ολόκληρη αυτή η συλλογή των σελίδων - η σελίδα πλαισίων και οι προσαρτηµένες σ' αυτήν σελίδες 

περιεχοµένου - αποκαλείται σύνολο πλαισίων (frameset). 

Κάθε πλαίσιο σε µία σελίδα πλαισίων είναι ένα ξεχωριστό HTML αρχείο. Μπορείτε να δηµιουργήσετε 

οποιονδήποτε αριθµό εγγράφων για χρήση σε µία βασιζόµενη σε πλαίσια τοποθεσία. Τα καλά νέα είναι ότι το 

Frontpage καθιστά πολύ εύκολη την αντιστοίχιση σελίδων σε πλαίσια. Τα κακά νέα είναι ότι το πρόγραµµα δε 

δηµιουργεί τις απαιτούµενες σελίδες για εσάς. Ο καλύτερος τρόπος για να δηµιουργήσετε µία βασιζόµενη σε 

πλαίσια σελίδα είναι να δηµιουργήσετε κατ' αρχήν ορισµένες από τις σελίδες περιεχοµένου, πριν ξεκινήσετε τη 

δηµιουργία του συνόλου πλαισίων (frameset). Αφού τοποθετήσετε αυτές τις σελίδες στο σύνολο πλαισίων, 

µπορείτε να τις προσαρµόσετε για να διασφαλίσετε ότι θα δείχνουν απόλυτα εντάξει όταν θα εµφανίζονται 

µέσα σε πλαίσια. 

Η σελίδα πλαισίων περιλαµβάνει γενικές οδηγίες σχετικά µε το πλήθος των πλαισίων που θα εµφανίζονται 

στο παράθυρο, το µέγεθος τους και τη συµπεριφορά τους. Κάθε πλαίσιο έχει κατ' αρχήν µία σελίδα και µπορεί 

να συνδέεται µε οποιοδήποτε πλήθος υπο-σελίδων του συνόλου πλαισίων µέσω συνδέσµων.  

Η διαδικασία µε την οποία καθορίζετε ποιος σύνδεσµος αντιστοιχεί σε ποιο πλαίσιο αποκαλείται συνήθως 

καθορισµός προορισµού (targeting). Ο προεπιλεγµένος προορισµός για κάθε πλαίσιο είναι ο εαυτός του µε 

άλλα λόγια, εάν δεν καθορίσετε οποιονδήποτε προορισµό για ένα πλαίσιο, οι σύνδεσµοι στους οποίους κάνει 

κλικ ο χρήστης µέσα σ' αυτό το πλαίσιο θα ανοίγουν το διασυνδεδεµένο έγγραφο προορισµού στο ίδιο πλαίσιο. 

Μπορείτε να διαµορφώσετε τον προορισµό των συνδέσµων σας ώστε να ανοίγουν µία νέα ιστοσελίδα σε ένα 

πλαίσιο, στο ίδιο παράθυρο της εφαρµογής browser (αλλά όχι σε ένα πλαίσιο), ή σε ένα εντελώς νέο παράθυρο 

της εφαρµογής. 
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Χρησιµοποιώντας το FrontPage είvαι πολύ εύκολο να δηµιουργήσετε σελίδες όπως αυτή της παραπάνω 

εικόνας. Επειδή κάθε πλαίσιο περιέχει µία διαφορετική σελίδα, κάθε σελίδα µπορεί να έχει τα δικά της 

χρώµατα για το φόντο, το κείµενο και τους συνδέσµους, αν και είναι σίγουρα προτιµότερο να σχεδιάσετε τα 

περιεχόµενα όλων των πλαισίων µε έναν ενοποιηµένο τρόπο. Ο βασικός κανόνας που πρέπει να θυµάστε είναι 

ο εξής:  

 

 

Αν και εµφανίζονται διαφορετικές σελίδες στα πλαίσια, οι σελίδες αυτές συνδυάζονται µε στόχο την 

επίτευξη µιας ενοποιηµένης τοποθεσίας και για τον λόγο αυτό δε θα πρέπει να έρχονται σε αντίθεση. 

 

Οι Καλύτερες Χρήσεις των Πλαισίων 
 

Χρησιµεύουν σε τίποτα τα πλαίσια; Ναι, ναι, πράγµατι ναι! Οποτεδήποτε θέλετε να δηµιουργήσετε µία 

ιστοσελίδα η οποία θα µπορούσε να ωφεληθεί από την ταυτόχρονη εµφάνιση πολλών εγγράφων στο ίδιο 

παράθυρο, θα διαπιστώσετε ότι τα πλαίσια είναι η πιο βολική και σωστή λύση. Ακολουθεί µία σύντοµη 

αναφορά σε πολλές κοινές αλλά και δηµιουργικές χρήσεις των πλαισίων: 

 

Μηχανισµοί διεξαγωγής αναζητήσεων (search engines) Η φόρµα για τη διεξαγωγή µιας αναζήτησης 

εµφανίζεται σ' ένα πλαίσιο και τα αποτελέσµατα της αναζήτησης σ' ένα άλλο, έτσι ώστε και οι δύο αυτές 

οµάδες πληροφοριών να µπορούν να παρουσιάζονται δίπλα-δίπλα στην οθόνη. Σ' αυτή την περίπτωση, θα 

θέλετε οι προορισµοί των συνδέσµων που αντιπροσωπεύουν τα αποτελέσµατα της αναζήτησης να 

εµφανίζονται σ' ένα νέο παράθυρο. 

 

Πίνακες περιεχοµένων (tables of contents) Οι πίνακες αυτοί εµφανίζονται συχνά σ' ένα πλαίσιο µε ψηλό 

και στενό σχήµα, το οποίο διατρέχει την αριστερή πλευρά του παραθύρου. Όταν κάνετε κλικ σε µία 

καταχώριση του πίνακα περιεχοµένων -η οποία λειτουργεί σαν σύνδεσµος - ο προορισµός της εµφανίζεται σε 

ένα µεγαλύτερο πλαίσιο στο ίδιο παράθυρο. 

 

Γραµµές κουµπιών Παρόµοια µε έναν πίνακα περιεχοµένων, µία γραµµή κουµπιών (button bar) ή µία 

οµάδα εργαλείων πλοήγησης είναι ορατή καθ' όλη τη διάρκεια της επίσκεψης σας σε µία τοποθεσία µε πλαίσια 

και εµφανίζεται συνήθως στην πάνω, κάτω, ή αριστερή πλευρά της κεντρικής περιοχής πλοήγησης. 
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Υποσηµειώσεις (footnotes) Οι ακαδηµαϊκές διατριβές δεν εκµεταλλεύονται όσο συχνά θα έπρεπε τις 

δυνατότητες των πλαισίων στον τοµέα των υποσηµειώσεων. Οι χρήστες µπορούν να κάνουν κλικ στη λέξη που 

επισηµαίνεται µέσα στον κορµό του κειµένου (στο κυρίως παράθυρο) για να εµφανίσουν την υποσηµείωση 

ταυτόχρονα σ' ένα µικρότερο πλαίσιο, στο κάτω άκρο του παραθύρου.  

 

Βιβλία επισκεπτών (Cuestbooks) Οι επισκέπτες µπορούν να πληκτρολογούν σχολίασε µία φόρµα 

τοποθετηµένη σε έναπλαίσιο και όταν κάνουν κλικ στο κουµπί Send, τα σχόλια τους θα εµφανίζονται σ' ένα 

άλλο πλαίσιο. 

 

Κατάλογοι τέχνης Τοποθετείτε µία εικόνα σ' ένα πλαίσιο και το κείµενο που αντιστοιχεί σ' αυτή σ' ένα 

άλλο πλαίσιο µε γραµµές κύλισης. Αν και η γενική ιδέα σ' αυτό το σενάριο είναι η δηµιουργία ενός καταλόγου 

για µία έκθεση τέχνης, τα πλαίσια λειτουργούν θαυµάσια σε οποιαδήποτε περίπτωση στην οποία θα θέλατε να 

έχετε ορατή µία εικόνα στην οθόνη, καθώς διαβάζετε το σχετιζόµενο µε αυτή κείµενο. 

 

∆ιαφηµιστικά Banners Πολλές τοποθεσίες χρησιµοποιούν ένα ξεχωριστό πλαίσιο στο οποίο παρουσιάζουν 

τις διαφηµίσεις τους. Για ορισµένους, αυτό λύνει το πρόβληµα της ενσωµάτωσης διαφηµιστικών στη σχεδίαση 

µιας ιστοσελίδας. 

 

Πολυµέσα Μπορείτε να χρησιµοποιείτε ένα πλαίσιο σαν χώρο υποδοχής για ένα αρχείο ήχου, µία ταινία 

Shockwave, µία µίνι-εφαρµογή Java, ή ένα ένθετο βιντεοκλίπ. 
Τα µόνα που θα µπορούσαν να σας περιορίσουν όσον αφορά στη δηµιουργική χρήση των πλαισίων είναι η φαντασία σας και τα όρια του καλού 

γούστου. 

 

∆ηµιουργία Σελίδων Πλαισίων από Ένα Πρότυπο 
 

To Frontpage σας παρέχει αρκετά πρότυπα δηµιουργίας πλαισίων καθώς και µεθόδους για την επεξεργασία 

τους. θα µπορούσατε να δηµιουργήσετε οποιαδήποτε σχεδίαση   πλαισίων µπορεί να φανταστεί κανείς 

ξεκινώντας µε τα πρότυπα που σας παρέχει το  ίδιο το Frontpage. 

Ας δηµιουργήσουµε τώρα µαζί µία σελίδα πλαισίων. Ακολουθήστε τα παρακάτω βήµατα: 

 

1. Από τη γραµµή των µενού, επιλέξτε την εντολή File > New > Page. θα εµφανιστεί το παράθυρο διαλόγου 

New. 

2. Κάντε κλικ στην καρτέλα Frames Pages (σελίδες πλαισίων) για να εµφανίσετε τις επιλογές της (Εικόνα 

12.2). 
3. Μπορείτε να διαλέξετε οποιαδήποτε από τις δέκα διαφορετικές διατάξεις πλαισίων . Κάντε κλικ στο όνοµα µιας διάταξης για να εµφανίσετε ένα 
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δείγµα της σε προεπισκόπηση και µία περιγραφή της στη δεξιά πλευρά του παραθύρου διαλόγου. 

 

 
 

ΕΙΚΟΝΑ 12,2 

Επιλέξτε την επιθυµητή διάταξη απο την καρτέλα Frame Pages του παραθύρου διαλόγου New. 

 

4. Αφού βρείτε την επιθυµητή διάταξη, κάντε κλικ πάνω της για να την επιλέξετε και κατόπιν κάντε κλικ 

στο ΟΚ. Το παράθυρο διαλόγου New θα κλείσει και η επιλεγµένη διάταξη για τη σελίδα πλαισίων θα 

εµφανιστεί στην οθόνη σας. 

 

Τα γκρι πεδία που εµφανίζονται είναι πλασµατικά υποδείγµατα των σελίδων των πλαισίων. Είναι αυτά που 

θα χρησιµοποιήσετε για να αντιστοιχίσετε συγκεκριµένες HTML σελίδες (σελίδες περιεχοµένου) σε κάθε 

πλαίσιο. Κάθε περιοχή ενός συνόλου πλαισίων αντιπροσωπεύεται από ένα κενό, γκρι πλαίσιο µε το δικό του 

σετ κουµπιών. Η Εικόνα 12.3 παρουσιάζει ένα παράδειγµα του τι θα δείτε στην προβολή Σελίδας όταν 

δηµιουργήσετε µία σελίδα πλαισίων βασισµένη σε ένα πρότυπο. 
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Όταν θέλετε να τροποποιήσετε ένα συγκεκριµένο πλαίσιο, το επιλέγετε κάνοντας κλικ πάνω του. Κάντε 

κλικ στα διάφορα πλαίσια της νέας σελίδας που δηµιουργήσατε και παρακολουθήστε τον τρόπο µε τον οποίο 

τονίζεται το επιλεγµένο πλαίσιο στην περίµετρο του. Τώρα που έχετε µία σελίδα µε πλαίσια για να δουλέψετε, 

ας ξεκινήσουµε από τα βασικά. 

 

 

EIKONA 12,3 

 

Αυτό το πρότυπο δηµιουργεί δύο πλαίσια µε οριζόντιο προσανατολισµό. Παρατηρήστε ότι το κάθε πλαίσιο 

έχει τη δική του οµάδα κουµπιών. 

 

 

 

  

Επεξεργασία Πλαισίων και Σελίδων Πλαισίων 

 

Η υλοποίηση των λειτουργιών και εργαλείων επεξεργασίας πλαισίων στο Frontpage είναι πραγµατικά 

εξαιρετική. Είναι απόλυτα προφανές για τον οποιοδήποτε χρήστη το γεγονός ότι κάθε πλαίσιο περιέχει µία 

διαφορετική σελίδα (ένα διαφορετικό HTML έγγραφο) - ένα σκεπτικό το οποίο δυσκολεύονται να 
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κατανοήσουν οι περισσότεροι χρήστες. Αφού αντιστοιχίσετε έγγραφα (ιστοσελίδες) στα πλαίσια, αυτά 

εµφανίζονται σε προβολή Σελίδας, απ' όπου και µπορείτε να τα τροποποιήσετε. Οι ελάχιστοι συντάκτες 

ιστοσελίδων µε υποστήριξη πλαισίων που υπάρχουν αυτή τη στιγµή, απλά δεν είναι τόσο κοµψοί ή τόσο 

εύχρηστοι. 

Μπορείτε να ξεκινήσετε την τροποποίηση των πλαισίων µιας σελίδας µε οποιαδήποτε σειρά θέλετε. 

Μπορείτε να αντιστοιχίσετε µεµονωµένες σελίδες οι οποίες είναι ήδη σε τελική µορφή σε όλα τα πλαίσια και 

να κάνετε τις απαιτούµενες προσαρµογές για την τελειοποίηση τους. Εναλλακτικά, θα µπορούσατε να 

αντιστοιχίσετε ηµιτελείς ή πλασµατικές εκδόσεις των σελίδων στα πλαίσια σας και να τις ολοκληρώσετε κατά 

την πορεία. Τέλος, θα µπορούσατε να δηµιουργήσετε ολόκληρο το σύστηµα των πλαισίων "εκ του προχείρου" 

αυτή τη στιγµή. Η µεθοδολογία που θα ακολουθήσετε είναι δική σας ευθύνη.  

 

Αντιστοίχιση µιας Σελίδας σε ένα Πλαίσιο 
 

Η αρχική σελίδα, η οποία αναφέρεται συνήθως µε τον όρο προεπιλεγµένη σελίδα (default page) είναι η 

σελίδα η οποία "ανήκει" σε ένα πλαίσιο. Όταν φορτώνεται ολόκληρη η σελίδα πλαισίων στο παράθυρο µιας 

εφαρµογής browser, κάθε πλαίσιο πρέπει να γεµίσει µε κάτι, και αυτό το "κάτι" είναι η αρχική ή 

προεπιλεγµένη σελίδα. Ανεξάρτητα από το περιεχόµενο που αποκτούν τα πλαίσια κατά την πορεία των 

ενεργειών σας -κλικ για να προχωρήσετε ή να οπισθοχωρήσετε εδώ κι εκεί- οι αρχικές σελίδες θα είναι πάντα 

το σηµείο εκκίνησης της βασιζόµενης στα πλαίσια τοποθεσίας σας. 

Για να αντιστοιχίσετε µία αρχική ή προεπιλεγµένη σελίδα σ' ένα πλαίσιο, ακολουθήστε τα παρακάτω 

βήµατα: 

 

1. Με ορατή τη σελίδα πλαισίων σε προβολή Σελίδας, κάντε κλικ στο .πλαίσιο που θέλετε να επιλέξετε. 

 

2. Κάντε κλικ στο κουµπί Set Initial Page (ορισµός αρχικής σελίδας) του πλαισίου, θα εµφανιστεί το 

παράθυρο διαλόγου Create Hyperlink (δηµιουργία δεσµού υπερκειµένου), το οποίο βλέπετε στην Εικόνα 12.8. 
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ΕΙΚΟΝΑ 12,8 

Θα χρησιµοποιήσετε το παράθυρο διαλόγου Create Hyperlink για να αντιστοιχίσετε µια αρχική σελίδα σ’ 

ένα πλαίσιο 

3. Για να αντιστοιχίσετε µία σελίδα η οποία είναι ανοίκτή ή διαθέσιµη στον τρέχοντα ιστό του Frontpage, 

κάντε κλικ στο όνοµα της επιθυµητής σελίδας, στο πλαίσιο λίστας αρχείων.  

Εναλλακτικά, 

Για να αντιστοιχίσετε µία σελίδα αποθηκευµένη στον σκληρό δίσκο του υπολογιστή σας, κάντε κλικ στο 

κουµπι Attach Page (προσάρτηση σελίδας): 

 

4. θα εµφανιστεί το παράθυρο διαλόγου επιλογής αρχείων. Ψάξτε στη δοµή των φακέλων και των αρχείων 

του σκληρού σας δίσκου µέχρι να εντοπίσετε το αρχείο της επιθυµητής ιστοσελίδας. Αφού εντοπίσετε το 

αρχείο, κάντε κλικ στο ΟΚ για να το επιλέξετε. Το παράθυρο διαλόγου επιλογής αρχείων κλείνει κι εσείς 

επιστρέφετε στο παράθυρο διαλόγου Create Hyperiink. Εναλλακτικά, 
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Για να αντιστοιχίσετε µία σελίδα η οποία υπάρχει ήδη στο Web, πληκτρολογήστε ή επικολλήστε τη 

διεύθυνση URL αυτής της σελίδας στο πεδίο URL. Για να επιλέξετε µία σελίδα χρησιµοποιώντας µία 

εφαρµογή browser, κάντε κλικ στο κουµπί Use Web Browser. 

 

5. θα εµφανιστεί το παράθυρο της εφαρµογής browser- µπορείτε να το χρησιµοποιήσετε για να εντοπίσετε 

την επιθυµητή ιστοσελίδα. Όταν τελειώσετε, κάντε κλικ στο κουµπί που αντιπροσωπεύει το Frontpage, στη 

γραµµή εργασιών, θα επανεµφανιστεί το παράθυρο του Frontpage µε τη διεύθυνση URL της επιλεγµένης 

σελίδας να αναφέρεται ήδη στο πεδίο URL. 

 

6. Αφού εισάγετε τη διεύθυνση της επιθυµητής σελίδας (είτε τοπική, είτε του Internet) στο πεδίο URL, 

µπορείτε να κάνετε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Create Hyperiink. θα επιστρέψετε στο 

παράθυρο του Frontpage, όπου θα δείτε τη σελίδα που επιλέξατε στο βήµα 3 µέσα στο πλαίσιο. 

Μπορείτε να ακολουθήσετε τα παραπάνω βήµατα για κάθε πλαίσιο που συµπεριλάβατε στη σελίδα σας. 

Μπορείτε επίσης να δηµιουργήσετε µία νέα σελίδα, απευθείας από την σελίδα πλαισίων σας (ανατρέξτε στην 

ενότητα "Αντιστοίχιση Νέας Σελίδας CIF ένα Πλαίσιο"). 

 

 

Αντιστοίχηση Νέας Σελίδας σε ένα Πλαίσιο               

 

Μπορείτε να δηµιουργήσετε µία νέα σελίδα στο πλαίσιο σας - µία απόλυτα κενή σελίδα η οποία περιµένει 

να τη γεµίσετε µε κείµενο, γραφικά, ή άλλα αντικείµενα. Για παράδειγµα, εάν ένα από τα πλαίσια σας 

πρόκειται να περιλαµβάνει απλώς έναν τίτλο ή ένα λογότυπο, δε χρειάζεται να το δηµιουργήσετε εκ των 

προτέρων. Μπορείτε να προσθέσετε µία νέα σελίδα στο τρέχον σύνολο πλαισίων σας και να τη δηµιουργήσετε 

απευθείας από τη σελίδα πλαισίων. 

Για να προσθέσετε µία νέα σελίδα στο τρέχον σύνολο πλαισίων, ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ορατή τη σελίδα πλαισίων σε προβολή Σελίδας, κάντε κλικ στο πλαίσιο στο οποίο θέλετε να 

προσθέσετε µία σελίδα. 

 

2. Κάντε κλικ στο κουµπί New Page αυτού του πλαισίου, θα εµφανιστεί µία κενή 

σελίδα στο πλαίσιο. 
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Αυτό ήταν όλο. Μπορείτε τώρα ν' αρχίσετε να δουλεύετε µ' αυτή τη σελίδα, όπως θα δουλεύατε και µε 

οποιαδήποτε άλλη σελίδα. Στην ενότητα µε τίτλο 'Τροποποίηση Σελίδων µέσα στη Σελίδα Πλαισίων" θα σας 

παρουσιάσουµε ορισµένες υποδείξεις για τη διαχείριση των σελίδων ενός συνόλου πλαισίων. 

 

Αποθήκευση ενός Συνόλου Πλαισίων 
 

Ένα σύνολο πλαισίων (frameset) απαρτίζεται από αρκετές σελίδες: τη σελίδα πλαισίων, η οποία κατακρατά 

τις οδηγίες που ελέγχουν την εµφάνιση και τη συµπεριφορά ολόκληρου του συνόλου πλαισίων, καθώς και τις 

αρχικές (προεπιλεγµένες) σελίδες για κάθε πλαίσιο του συνόλου πλαισίων. Όταν αποθηκεύετε ένα σύνολο 

πλαισίων, θα πρέπει να αποθηκεύετε όλες αυτές τις σελίδες. Εάν αντιστοιχίσατε ήδη αποθηκευµένες αρχικές 

σελίδες στο σύνολο των πλαισίων σας, θα πρέπει να αποθηκεύσετε µόνο τη σελίδα πλαισίων και µαζί µ' αυτή 

αποθηκεύονται όλα τα υπόλοιπα. Εάν το σύνολο των πλαισίων σας περιέχει οποιεσδήποτε νέες ή κενές 

σελίδες, συµπεριλαµβανοµένων και σελίδων οι οποίες προήλθαν από το Web, θα πρέπει να τις αποθηκεύσετε 

κι αυτές επίσης. 

 

 

Όταν αποθηκεύετε ένα σύνολο πλαισίων θα πρέπει να καθορίζετε όνοµα αρχείου και τίτλο σελίδας για τη 

σελίδα πλαισίων και για κάθε αρχική σελίδα του συνόλου πλαισίων. To Frontpage σας προτείνει 

προτυποποιηµένους τίτλους, αλλά είναι χρησιµότερο να καθορίζετε δικούς σας τίτλους από το να έχετε 

δεκάδες σελίδες µε τίτλους του στυλ "New Page 1", "New Page 2", κ.λ.π. 

To όνοµα αρχείου της κύριας σελίδας πλαισίων χρησιµοποιείται στη διεύθυνση URL της σελίδας: είναι ο 

προορισµός των συνδέσµων οι οποίοι θα µεταφέρουν τους επισκέπτες της τοποθεσίας σας εκεί. Το όνοµα 

αρχείου κάθε αρχικής σελίδας για κάθε µεµονωµένο πλαίσιο αποθηκεύεται σαν διεύθυνση URL µέσα στη 

σελίδα πλαισίων, έτσι ώστε αυτή να µπορεί να ξέρει ποιες αρχικές σελίδες πρέπει να φορτώσει. 

Ο τίτλος σελίδας, ο οποίος εµφανίζεται στη γραµµή τίτλου του παραθύρου της εφαρµογής browser όταν 

φορτώνετε αυτόνοµες ιστοσελίδες, δεν είναι απόλυτα απαραίτητος για κάθε πλαίσιο, αλλά το να έχετε έναν 

τίτλο σελίδας για κάθε πλαίσιο αποδεικνύεται ιδιαίτερα χρήσιµο κατά την επεξεργασία του συνόλου των 

πλαισίων µε το Frontpage. Όταν κάνετε κλικ σε ένα πλαίσιο στο Frontpage, η γραµµή τίτλου εµφανίζει τόσο 

τον τίτλο ολόκληρου του συνόλου πλαισίων, όσο και τον τίτλο του µεµονωµένου πλαισίου, οπότε το να δίνετε 

σε κάθε πλαίσιο ένα µοναδικό όνοµα - ακόµη κι αν είναι κάτι τόσο απλό όσο το "αριστερό", ή το "µπλε" - 

µπορεί να σας βοηθήσει να εξακριβώνετε ευκολότερα τι τροποποιείτε κάθε στιγµή. 

Ανεξάρτητα από το στάδιο ολοκλήρωσης στο οποίο βρίσκεται το σύνολο των πλαισίων σας, ακολουθήστε 

τα παρακάτω βήµατα για να αποθηκεύσετε ολόκληρο το σύνολο των πλαισίων: 
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1. Με ορατή τη σελίδα πλαισίων σε προβολή Σελίδας, επιλέξτε την εντολή File >Save. θα εµφανιστεί το 

παράθυρο διαλόγου Save As. ∆ώστε ιδιαίτερη προσοχή στην περιοχή προεπισκόπησης, στη δεξιά πλευρά του 

παραθύρου διαλόγου Save As. To τµήµα που εµφανίζεται µε τονισµό στην περιοχή προεπισκόπησης 

υποδεικνύει το πλαίσιο που αποθηκεύετε. 

 

 

2. Στο πεδίο File Name πληκτρολογήστε το όνοµα αρχείου της σελίδας που αποθηκεύετε. Εάν θέλετε να 

αλλάξετε τον τίτλο της σελίδας, κάντε κλικ στο κουµπί" Change για να εµφανίσετε το παράθυρο διαλόγου Set 

Page Title. Πληκτρολογήστε τον τίτλο που θέλετε να χρησιµοποιήσετε και κάντε κλικ στο ΟΚ. 

 

 

3. Ελέγξτε τη θέση στην οποία αποθηκεύετε το αρχείο. Εάν το αποθηκεύετε στον τρέχοντα ιστό του 

Frontpage, επιλέξτε τον επιθυµητό φάκελο αποθήκευσης, εάν υπάρχει, κάνοντας κλικ στην κατάλληλη 

καταχώριση του πλαισίου λίστας αρχείων. 

4. Αφού ελέγξετε το όνοµα αρχείου, τον τίτλο σελίδας και τη θέση αποθήκευσης, κάντε κλικ στο ΟΚ. Το 

παράθυρο διαλόγου Save As κλείνει και κατόπιν επανεµφανίζεται. Παρατηρήστε ότι τώρα εµφανίζεται µε 

τονισµό ένα διαφορετικό πλαίσιο στην περιοχή προεπισκόπησης, στη δεξιά πλευρά του παραθύρου διαλόγου. 

 

 

5. Ακολουθήστε τα βήµατα 2 έως 4 για κάθε πλαίσιο του συνόλου πλαισίων. Ένα νέο παράθυρο διαλόγου 

Save As θα εµφανίζεται αµέσως µόλις ολοκληρώνετε την αποθήκευση του προηγούµενου πλαισίου. Όταν το 

παράθυρο διαλόγου πάρει την εµφάνιση της Εικόνας 12.10, αυτό σηµαίνει ότι αποθηκεύετε την κύρια σελίδα 

πλαισίων. Η διαδικασία είναι (δια γι' αυτή τη σελίδα, εκτός από το ότι το όνοµα αρχείου και ο τίτλος σελίδας 

είναι ελαφρώς πιο σηµαντικά σ' αυτή την περίπτωση, επειδή αντιπροσωπεύουν τον τίτλο και τη διεύθυνση 

URL που θα βλέπει όλος ο κόσµος όταν εξετάζει τη σελίδα πλαισίων σας. 

 

 

6. Αφού ολοκληρώσετε την αποθήκευση της τελικής σελίδας πλαισίων, κάντε κλικ στο ΟΚ και το 

τελευταίο παράθυρο διαλόγου Save As θα κλείσει. 
Στο σηµείο αυτό έχετε αποθηκεύσει τα πάντα. Κάντε κλικ στα διάφορα πλαίσια που εµφανίζονται αυτή τη στιγµή στο παράθυρο του Συντάκτη και 

προσέξτε τι αναφέρεται στη γραµµή τίτλου. Παρατηρήστε ότι η γραµµή τίτλου αναφέρει τόσο τον τίτλο της κυρίας σελίδας πλαισίων, όσο και τον 

τίτλο κάθε µεµονωµένου πλαισίου. 
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EIKONA 12,10 

Το παχυ περίγραµµα γύρω απ’ όλα τα πλαίσια στην περιοχή προεπισκόπησης υποδεικνύει ότι σε αυτό το 

στάδιο αποθηκεύετε την ίδια τη σελίδα 

 

 

 

Τροποποίηση Σελίδων µέσα στη Σελίδα Πλαισίων 
 

Όπως είπαµε παραπάνω, σε ένα πλαίσιο µπορείτε να τοποθετήσετε οποιοδήποτε είδος περιεχοµένου θα 

τοποθετούσατε κανονικά και σε µία στάνταρ, αυτόνοµη ιστοσελίδα. Η τροποποίηση αυτών των σελίδων 

µοιάζει πολύ µε την τροποποίηση µιας νέας, κενής σελίδας. Μπορείτε να καθορίσετε τα χρώµατα για το 

κείµενο και τους συνδέσµους, να επιλέξετε ένα χρώµα ή µία εικόνα για το φόντο και να ορίσετε έναν τίτλο 
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σελίδας. Μπορείτε να προσθέσετε κείµενο σε οποιαδήποτε µορφή, συµπεριλαµβανοµένων των επικεφαλίδων, 

των λιστών και του προ-µορφοποιηµένου κειµένου. Οι φόρµες και οι πίνακες αισθάνονται σαν στο σπίτι τους 

µέσα σε ένα πλαίσιο, όπως επίσης και οι εικόνες, τα πρόσθετα (plug-ins) και οι µινι-εφαρµογές Java. 

Μπορείτε να δηµιουργήσετε µία ολόκληρη σελίδα και κατόπιν να την προσαρτήσετε σ' ένα σύνολο 

πλαισίων. Μπορείτε επίσης να προσαρτήσετε µία ηµιτελή ή εντελώς κενή σελίδα σ' ένα σύνολο πλαισίων και 

κατόπιν να την τροποποιήσετε. Η µόνη διαφορά είναι αυτό που βλέπετε στην οθόνη κατά τη διάρκεια της 

τροποποίησης. Αν και είναι χρήσιµο να βλέπετε όλες τις σελίδες των πλαισίων ταυτόχρονα στην οθόνη, η 

ταυτόχρονη τροποποίηση όλων των σελίδων που ανήκουν σ' ένα σύνολο πλαισίων στο Frontpage απαιτεί 

πολλή περισσότερη µνήµη. 

 

 

. Οι βασικές αρχές είναι ίδιες, εκτός από το ότι µπορείτε να δουλεύετε µε περισσότερες από µία σελίδες οι 

οποίες εµφανίζονται όλες µαζί ταυτόχρονα στο ίδιο παράθυρο. Κάντε κλικ σε οποιοδήποτε πλαίσιο µε το οποίο 

θέλετε να δουλέψετε και όλες οι εντολές των µενού και τα κουµπιά των γραµµών εργαλείων που χρησιµο-

ποιείτε για την τροποποίηση αυτόνοµων ιστοσελίδων θα ισχύουν για το επιλεγµένο πλαίσιο. 

 

 

Προσαρµογή των Ιδιοτήτων των Πλαισίων 
 
Επιπρόσθετα µε τις ιδιότητες που έχει κάθε ιστοσελίδα, τα πλαίσια ενός συνόλου πλαισίων έχουν δικές τους ιδιότητες. Οι ιδιότητες αυτές 

αποθηκεύονται στην κυρία σελίδα πλαισίων, η οποία αποθηκεύει πληροφορίες για τη διάταξη και τις λειτουργίες κάθε πλαισίου του συνόλου 

πλαισίων. Ωστόσο, όταν δουλεύετε µε ένα σύνολο πλαισίων προσαρµόζετε τις ιδιότητες για κάθε πλαίσιο ατοµικά, αντί να κάνετε γενικής ισχύος 

αλλαγές. 

 

Οι ιδιότητες πλαισίων επηρεάζουν την εµφάνιση και τη συµπεριφορά ενός µεµονωµένου πλαισίου όταν 

αυτό παρουσιάζεται στο παράθυρο µιας εφαρµογής browser. Στις ιδιότητες αυτές περιλαµβάνονται πράγµατα 

όπως το εξής: το εάν ένα πλαίσιο µπορεί να αλλάξει µέγεθος στο παράθυρο της εφαρµογής browser, το εάν θα 

εµφανίζει γραµµές κύλισης, τις διαστάσεις του πλαισίου και το τµήµα του παραθύρου που θα καταλαµβάνει. 

Μπορείτε επίσης να ορίσετε περιθώρια (margins) για ένα πλαίσιο, τα οποία ελέγχουν την απόσταση µεταξύ 

των αντικειµένων του πλαισίου και των φυσικών άκρων του. 

 

Στη συνέχεια θα εξετάσουµε τις επιλογές που είναι διαθέσιµες για κάθε πλαίσιο και κατόπιν θα σας 

δείξουµε πώς να χρησιµοποιείτε το παράθυρο διαλόγου Frame Properties (ιδιότητες πλαισίου), το οποίο 

βλέπετε στην Εικόνα 12.11. 
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ΕΙΚΟΝΑ 12,11 

Το παράθυρο διαλόγου Frame Properties σας επιτρέπει να προσαρµόσετε το µέγεθος και το περιθώριο των 

πλαισίων σας µεταξύ άλλων πραγµάτων. 
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Επιλογές 

για την 

Αλλαγή 

του 

Μεγέθους 
 

Σε µία προηγουµένη ενότητα αυτού του κεφαλαίου αλλάξαµε το µέγεθος των πλαισίων µέσα στη σελίδα 

πλαισίων κάνοντας κλικ στα περιθώρια τους και σέρνοντας τα στην επιθυµητή θέση. Εάν καθορίσετε τις 

ιδιότητες πλαισίων έτσι ώστε τα πλαίσια να µπορούν να αλλάξουν µέγεθος, τότε οι επισκέπτες της ιστοσελίδας 

σας θα µπορούν να κάνουν το ίδιο ακριβώς πράγµα. Μπορείτε να απενεργοποιήσετε τη δυνατότητα αλλαγής 

µεγέθους για ένα µεµονωµένο πλαίσιο, εάν δε θέλετε οι επισκέπτες να µπορούν να αλλάζουν τη διάταξη της 

σελίδας σας, αλλά γενικά είναι πιο βολικό να επιτρέπετε στους χρήστες να αλλάζουν το µέγεθος ενός πλαισίου. 

 

 

Γραµµές 

Κύλισης 
 

Κάθε πλαίσιο είναι απόλυτα ικανό να έχει τις δικές του γραµµές κύλισης: είτε µόνο την οριζόντια, είτε µόνο 

την κατακόρυφη, είτε και τις δυο. Υπάρχουν τρεις ρυθµίσεις για τις γραµµές κύλισης τις οποίες µπορείτε να 

ενεργοποιήσετε για κάθε πλαίσιο: If Needed (εάν απαιτείται). Always (πάντα) και Never (ποτέ). Γενικά, η If 

Needed (η οποία; 

αποκαλείται επίσης Auto) είναι µάλλον η καλύτερη επιλογή για τις περισσότερες' σελίδες και είναι επίσης η 

προεπιλεγµένη ρύθµιση. Οι γραµµές κύλισης εµφανίζονται εάν απαιτούνται και εξαφανίζονται από την οθόνη 

εάν δεν απαιτούνται. 

Μπορείτε να επιλέξετε τη ρύθµιση Never εάν είστε απόλυτα σίγουροι ότι το πλαίσιο σας δεν πρόκειται να 

συµπεριλάβει ποτέ περισσότερο περιεχόµενο απ' όσο µπορεί να εµφανιστεί ταυτόχρονα σε µία "σελίδα 

οθόνης". Ωστόσο, είναι εξαιρετικά ενοχλητικό το να βλέπετε µόνο το µισό µιας λέξης ή τα δύο τρίτα µιας 

εικόνας στην 15 ιντσών οθόνη σας, επειδή κάποιος επόπτης τοποθεσίας (Webmaster) µε οθόνη 17 ιντσών 

απενεργοποίησε τη δυνατότητα εµφάνισης των γραµµών κύλισης για τα πλαίσια της σελίδας του. 
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∆εν µπορώ να σκεφτώ έναν απόλυτα καλό λόγο για να ενεργοποιήσετε την επιλογή Always, θα µπορούσατε 

να ενεργοποιήσετε την επιλογή αυτή εάν προβλέπετε ότι το πλαίσιο σας θα γεµίσει σύντοµα µε περισσότερο 

περιεχόµενο και θέλετε να προετοιµάσετε κατάλληλα τους χρήστες. Η εµφάνιση των γραµµών κύλισης πριν 

αυτές καταστούν απαραίτητες µπορεί να γλιτώσει την εφαρµογή browser από ορισµένες δυσκολίες. 

 

Περιθώρια 

Πλαισίων 
 

Ανόµοια µε τα περιθώρια των σελίδων, τα περιθώρια (margins) των πλαισίων δεν είναι µία ιδιότητα η οποία 

ισχύει αποκλειστικά και µόνο στον Internet Explorer. Οποιαδήποτε εφαρµογή browser µπορεί να εµφανίζει 

πλαίσια, θα "σέβεται" τα περιθώρια που καθορίζετε για τα πλαίσια σας. Τα περιθώρια των πλαισίων είναι 

ιδιαίτερα χρήσιµα εάν θέλετε να διασφαλίσετε ότι το περιεχόµενο σας δεν πρόκειται να χαθεί εάν αλλάξει το 

µέγεθος του παραθύρου ή του πλαισίου. Τα περιθώρια των πλαισίων καθορίζονται σε pixels και µετριούνται 

από την πάνω αριστερή γωνία του πλαισίου. 

 

Συνεπώς, η ρύθµιση περιθωρίου για το πλάτος (Width, στην ενότητα Margins) υποδεικνύει πόσα pixels 

κενού χώρου θα υπάρχουν ανάµεσα στην αριστερή πλευρά του πλαισίου και στο περιεχόµενο του, ενώ η 

ρύθµιση περιθωρίου για το ύψος (Height, στην ενότητα Margins) υποδεικνύει πόσα pixels κενού χώρου θα 

υπάρχουν µεταξύ του πάνω άκρου του πλαισίου και του περιεχοµένου του. 

 

Το Παράθυρο ∆ιαλόγου Frame Properties 
 

Τώρα που ξέρετε πώς λειτουργούν οι ιδιότητες ενός πλαισίου, µπορείτε να καθορίσετε στις κατάλληλες 

τιµές για τις σελίδες σας. Ακολουθήστε τα παρακάτω βήµατα: 

 

1. Με ορατή τη σελίδα πλαισίων σας σε προβολή Σελίδας, κάντε κλικ µε το δεξιό πλήκτρο του ποντικιού 

στο πλαίσιο του οποίου τις ιδιότητες θέλετε να προσαρµόσετε. Εάν το πλαίσιο σας είναι κενό, θα εµφανιστεί 

ένα κουµπί µε τίτλο Frame Properties (ιδιότητες πλαισίου). Κάντε κλικ πάνω του για να εµφανίσετε το 

παράθυρο διαλόγου Frame Properties . 

Εναλλακτικά, 

Εάν το πλαίσιο σας περιέχει οτιδήποτε, θα εµφανιστεί ένα µενού αντί για ένα κουµπί. Επιλέξτε την εντολή 

Frame Properties από αυτό το µενού για να εµφανίσετε το παράθυρο διαλόγου Frame Properties. 
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2. Στην περιοχή Options (επιλογές) του παραθύρου διαλόγου, εάν θέλετε το πλαίσιο σας να έχει δυνατότητα 

αλλαγής µεγέθους στο παράθυρο των εφαρµογών browser, αφήστε µαρκαρισµένο το πλαίσιο ελέγχου 

Resizable In Browser. Εάν δε θέλετε οι χρήστες σας να µπορούν να αλλάζουν το µέγεθος των πλαισίων σας, 

ξεµαρκάρετε αυτό το πλαίσιο ελέγχου. 

 

3. Ενεργοποιήστε µία από τις ακόλουθες επιλογές από την αναδιπλούµενη λίστα Show Scrollbars (εµφάνιση 

γραµµών κύλισης): If Needed, Always, ή Never, όπως αναφέραµε παραπάνω, στην ενότητα που ασχολήθηκε 

µε τις γραµµές κύλισης. 

 

4. Στην περιοχή Frame Size του παραθύρου διαλόγου καθορίστε το ύψος και το πλάτος για το πλαίσιο σας 

εισάγοντας µία τιµή στα κατάλληλα πεδία (Width-πλάτος και Height-ύψος) και επιλέγοντας µία µονάδα 

µέτρησης (Relative-σχετικά, Pixels, ή Percent-ποσοστό επί των διαστάσεων της οθόνης) από την αντίστοιχη 

λίστα. Όπως περιγράψαµε στην ενότητα που ασχολήθηκε µε το µέγεθος των πλαισίων, πιθανότατα θα θέλετε 

να καθορίζετε επακριβώς το ύψος και το πλάτος για ορισµένα πλαίσια, αφήνοντας τις ρυθµίσεις για τα 

υπόλοιπα σε Relative (σχετικά). 

 

5. Στην περιοχή Margins του παραθύρου διαλόγου µπορείτε να καθορίσετε περιθώρια για το πλαίσιο σας, 

εάν θέλετε. Εισάγετε µία τιµή (σε pixels) στα πεδία Width (πλάτος) και Height (ύψος). 

 

6. Όταν τελειώσετε, κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Frame Properties. 

 

Ορισµένες από τις ρυθµίσεις σας, όπως αυτές που σχετίζονται µε το µέγεθος και τις γραµµές κύλισης, θα 

τεθούν άµεσα σε ισχύ. Άλλες ρυθµίσεις, όπως π.χ. τα περιθώρια, δεν πρόκειται να έχουν ορατό αποτέλεσµα 

παρά µόνο αφού εµφανίσετε σε προεπι-σκόπηση τη σελίδα σας σε προβολή Σελίδας, ή στο παράθυρο µιας 

εφαρµογής browser. 

 

 

Προεπιλεγµένες Ρυθµίσεις Προορισµών 
 

Οι προεπιλεγµένες ρυθµίσεις προορισµών (default target settings) ενός πλαισίου υποδεικνύουν την θέση 

στην οποία θα φορτώνονται οι σελίδες στις οποίες δείχνουν οι σύνδεσµοι όταν τους επιλέγουν οι χρήστες. 

Εκτός κι αν καθορίσετε κάτι άλλο, οι σύνδεσµοι που περιέχονται σ' ένα συγκεκριµένο πλαίσιο θα "ανοίγουν" σ' 
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αυτό το πλαίσιο. Μπορείτε να καθορίσετε τον προορισµό ενός συνδέσµου έτσι ώστε να ανοίγει σε οποιοδήποτε 

πλαίσιο ενός συνόλου πλαισίων, ενώ µπορείτε επίσης να ορίσετε , προεπιλεγµένες ρυθµίσεις προορισµών για 

κάθε πλαίσιο. Τέλος, µπορείτε να καθορίσετε ορισµένους άλλους βολικούς προορισµούς για τους συνδέσµους  

 

σας, µε διαδικασίες τις οποίες απλοποιεί σηµαντικά το Frontpage. Σ' αυτές τις ειδικές ρυθµίσεις . 

προορισµών περιλαµβάνονται οι ακόλουθες: 

 

• Same Frame (self) - φορτώνει τη σελίδα προορισµού του συνδέσµου στο πλαίσιο στο οποίο βρίσκεται ο 

σύνδεσµος. 

 

• Whole Page (top) - φορτώνει τη σελίδα προορισµού του συνδέσµου στο παράθυρο της εφαρµογής 

browser, αντικαθιστώντας ολόκληρο το σύνολο πλαισίων. 

 

• New Window (blank) - ανοίγει ένα νέο παράθυρο της εφαρµογής browser και φορτώνει τη σελίδα 

προορισµού του συνδέσµου σ' αυτό. 

 

• Parent Frame (parent) - φορτώνει τη σελίδα προορισµού του συνδέσµου στο παράθυρο της εφαρµογής 

browser, αντικαθιστώντας όλα τα τρέχοντα πλαίσια. Εάν ένα από τα πλαίσια περιέχει ένα άλλο σύνολο 

πλαισίων και από ένα πλαίσιο αυτού του συνόλου αναφέρεστε σε ένα "πατρικό" πλαίσιο, το έγγραφο του 

συνδέσµου φορτώνεται στο αρχικό πλαίσιο αντί για το παράθυρο της εφαρµογής browser.  

 

 

Μπορείτε να καθορίσετε τον προορισµό για έναν σύνδεσµο όταν δηµιουργείτε αυτό τον σύνδεσµο µέσα στο 

πλαίσιο, ή όταν τον τροποποιείτε. Εάν χρησιµοποιείτε τις προεπιλεγµένες ρυθµίσεις γι' αυτό το πλαίσιο δε 

χρειάζεται να ορίσετε έναν προορισµό για τους συνδέσµους σας, αλλά µπορείτε να ακολουθήσετε τα επόµενα 

βήµατα τόσο για να ορίσετε έναν προεπιλεγµένο προορισµό για ολόκληρο το πλαίσιο, όσο και για να ορίσετε 

έναν προορισµό διαφορετικό από τον προεπιλεγµένο για έναν µεµονωµένο σύνδεσµο. 

 

 

Ακολουθήστε τα παρακάτω βήµατα: 
 

 

1. Με το σύνολο των πλαισίων ανοικτό σε προβολή Σελίδας, κάντε κλικ στο πλαίσιο στο οποίο θέλετε να προσθέσετε έναν σύνδεσµο. 
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2. Επιλέξτε το κείµενο ή την εικόνα που θα χρησιµοποιήσετε σαν σύνδεσµο και από τη γραµµή των µενού 

επιλέξτε την εντολή Insert > Hyperlink. θα εµφανιστεί το παράθυρο διαλόγου Create Hyperlink. 

 

 

Εναλλακτικά, 

Κάντε κλικ µε το δεξιό πλήκτρο του ποντικιού σε έναν σύνδεσµο που υπάρχει ήδη σ' ένα πλαίσιο και από το 

µενού συντόµευσης που εµφανίζεται επιλέξτε την εντολή Hyperlink Properties (ιδιότητες συνδέσµων), θα 

εµφανιστεί το παράθυρο διαλόγου Edit Hyperiink. (Αυτό το παράθυρο διαλόγου είναι ίδιο µε το παράθυρο 

διαλόγου Create Hyperlink όσον αφορά τους σκοπούς µας εδώ). 

 

 

3. ∆ηµιουργήστε ή τροποποιήστε τον σύνδεσµο µε τις τυπικές διαδικασίες.  

 

4. Στην περιοχή Optional του παραθύρου διαλόγου Create Hyperlink, κάντε κλικ στο κουµπί Change Target 

Frame (αλλαγή πλαισίου προορισµού). 

 

 

θα εµφανιστεί το παράθυρο διαλόγου Target Frame (Εικόνα 12.15). 
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ΕΙΚΟΝΑ 12,15 

Το παράθυρο διαλόγου Target Frame σας επιτρέπει να καθορίσετε προεπιλεγµένους προορισµούς, καθώς επίσης και προορισµούς για 

µεµονωµένους συνδέσµους. 

 

 

5. Σ' αυτό το παράθυρο διαλόγου έχετε αρκετές επιλογές στη διάθεση σας για να καθορίσετε ένα πλαίσιο προορισµού: 

 

 

• Κάντε κλικ στο επιθυµητό πλαίσιο στην περιοχή προεπισκόπησης (Current Frames Page) του παραθύρου 

διαλόγου για να το χρησιµοποιήσετε σαν προεπιλεγµένο προορισµό 

• Πληκτρολογήστε το όνοµα του πλαισίου στο πεδίο Target Setting 

• Επιλέξτε µία από τις καταχωρίσεις της λίστας Common Targets (τις οποίες 

εξηγήσαµε στην αρχή της παρούσας ενότητας) Σε οποιαδήποτε περίπτωση, το όνοµα του πλαισίου 

προορισµού εµφανίζεται στο πεδίο Target Setting. 

 

 

6. Για να καθορίσετε αυτή τη ρύθµιση προορισµού σαν προεπιλεγµένη για όλους τους συνδέσµους αυτού 

του πλαισίου, µαρκάρετε το πλαίσιο ελέγχου Make Default For Hyperlinks On The Page. Αφού ορίσετε τον 

προεπιλεγµένο προορισµό για ένα πλαίσιο, όλοι οι σύνδεσµοι που προσθέτετε σ' αυτό το πλαίσιο ή οι 

σύνδεσµοι που υπάρχουν ήδη σ' αυτό, θα έχουν τον ίδιο προορισµό. 
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7. Αφού ολοκληρώσετε την επιλογή προορισµού για τους συνδέσµους, κάντε κλικ στο ΟΚ. Το παράθυρο 

διαλόγου Target Frame θα κλείσει και θα επανεµφανιστεί το παράθυρο διαλόγου Create (ή Edit) Hyperlink, µε 

το όνοµα του προορισµού να αναφέρεται στο πεδίο Target Frame. 

 

8. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου Create Hyperlink. 

 

Για να ελέγξετε τη σωστή λειτουργία των προορισµών των συνδέσµων σας θα πρέπει κατ' αρχήν να 

εµφανίσετε τη σελίδα σας στο παράθυρο µιας εφαρµογής browser και κατόπιν να κάνετε κλικ στον σύνδεσµο 

του οποίου την ορθότητα θέλετε να επαληθεύσετε. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 128



Εισαγωγή στο FrontPage 

 

∆ηµιουργία Μεταβαλλόµενων Κουµπιών 
 

Ορισµένες φορές επισκέπτεστε µία τοποθεσία στο Web και καθώς περνάτε τον δείκτη του ποντικιού πάνω 

από κάποια εικόνα, η εικόνα αυτή αλλάζει. Για παράδειγµα, µπορεί να εµφανίζει λάµψεις, ή να αλλάζει 

χρώµατα. Αυτό είναι ένα ιδιαίτερα ωραίο εφέ, και µε το συστατικό Hover Button (µεταβαλλόµενο κουµπί) του 

Frontpage µπορείτε να το προσθέτετε γρήγορα και εύκολα στις ιστοσελίδες σας. Ακολουθήστε τα παρακάτω 

βήµατα: 

 

1. Με ανοικτή τη σελίδα που σας ενδιαφέρει, τοποθετήστε τον δείκτη στο σηµείο στο οποίο θέλετε να 

εµφανιστεί το µεταβαλλόµενο κουµπί. 

 

2. Από τη γραµµή των µενού, επιλέξτε την εντολή Insert >· Component >· Hover Button, θα εµφανιστεί το 

παράθυρο διαλόγου Hover Button Properties (Εικόνα 15.3). 

 

 

EIKONA 15,3 

Μπορείτε να δηµιουργήσετε ωραία ειδικά εφέ για τα κουµπιά σας χρησιµοποιώντας το παράθυρο διαλόγου 

Hoover Button Properties 

 

 129



Εισαγωγή στο FrontPage 

3. Στο πεδίο Button Text του παράθυρου διαλόγου πληκτρολογήστε το κείµενο που θέλετε να εµφανίζεται 

στην πρόσοψη του κουµπιού. Αλλάξτε τη γραµµατοσειρά, εάν θέλετε, κάνοντας κλικ στο κουµπί Font και 

επιλέγοντας την επιθυµητή γραµµατοσειρά από το παράθυρο διαλόγου που εµφανίζεται. 

 

4. Στο πεδίο Link To πληκτρολογήστε τη διεύθυνση URL της σελίδας η οποία θέλετε να φορτώνεται όταν οι 

επισκέπτες κάνουν κλικ πάνω σ' αυτό το κουµπί. 

 

5. Από τις αναδιπλούµενες λίστες Button Color, Background Color και Effect Color διαλέξτε το χρώµα για 

το κουµπί, για το φόντο και για το ειδικό εφέ του κουµπιού, αντίστοιχα. Το χρώµα που επιλέγετε για το ίδιο το 

κουµπί θα είναι το βασικό χρώµα του κουµπιού, ενώ το χρώµα φόντου θα εµφανίζεται πίσω από το κουµπί (εάν 

καθορίσετε ότι θα πρέπει να εµφανίζεται κάποιος χώρος πίσω από το κουµπί). Το χρώµα του εφέ θα είναι το 

χρώµα το οποίο θα εφαρµόζεται στο εφέ που θα επιλέξετε στο βήµα 6. 

 

6. Από την αναδιπλούµενη λίστα Effect επιλέξτε το εφέ που θέλετε να λαµβάνει χώρα όταν ο χρήστης 

τοποθετεί τον δείκτη του ποντικιού πάνω στο κουµπί (χωρίς να κάνει κλικ). Μπορείτε να επιλέξετε µόνο ένα 

εφέ - πειραµατιστείτε µε όλα τα εφέ µέχρι να βρείτε αυτό που πραγµατικά σας αρέσει. 

 

7. Κάντε κλικ στο ΟΚ. Το παράθυρο διαλόγου θα κλείσει. 

 

Το κουµπί που µόλις εισάγατε θα είναι ορατό στη σελίδα· ωστόσο, το ειδικό εφέ που επιλέξατε γι' αυτό το 

κουµπί δεν πρόκειται να είναι ορατό (ούτε καν αφού επιλέξετε την καρτέλα Preview), θα πρέπει να εµφανίσετε 

τη σελίδα σας στο παράθυρο µιας εφαρµογής browser η οποία υποστηρίζει τη Java για να δείτε το εφέ του 

µεταβαλλόµενου κουµπιού σας. 

 

Προσθήκη Πλαισίων Κυλιόµενου Κειµένου 
 

Τα πλαίσια κυλιόµενου κειµένου (marquees) είναι περιοχές µέσα στις οποίες µπορείτε να εµφανίζετε ένα 

συγκεκριµένο, "κυλιόµενο" µήνυµα στο ακροατήριο σας. Για να προσθέσετε ένα τέτοιο συστατικό στη σελίδα 

σας, ακολουθήστε τα παρακάτω βήµα 

τα: 
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1. Με ανοικτή τη σελίδα που σας ενδιαφέρει, τοποθετήστε τον δείκτη του ποντικιού στη θέση στην οποία 

θέλετε να εµφανίζεται το κυλιόµενο κείµενο. 

 

2. Από τη γραµµή των µενού, επιλέξτε την εντολή Insert >- Component >· Marquee. θα εµφανιστεί το 

παράθυρο διαλόγου Marquee Properties (Εικόνα 15.4). 

 

 

 

ΕΙΚΟΝΑ 15,4 

Το παράθυρο διαλόγου Marguee Properties 

 

 

3. Στο πεδίο Text πληκτρολογήστε το κείµενο που θέλετε να εµφανίζεται µέσα στο πλαίσιο κυλιόµενου 

κειµένου. 

 

4. Στην περιοχή Direction (κατεύθυνση) καθορίστε εάν η κύλιση του κειµένου θα γίνεται από τ' αριστερά 

(Left) ή από τα δεξιά (Right) κάνοντας κλικ στο κατάλληλο στρογγυλό κουµπί. 
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6. Μπορείτε τώρα να καθορίσετε τη συµπεριφορά του πλαισίου κυλιόµενου κειµένου. Στις επιλογές της 

ενότητας Behavior περιλαµβάνονται οι Scroll (κύλιση), Slide (ολίσθηση) και Alternate (εναλλασσόµενη 

κύλιση). 

 

7. Από την ενότητα Align With Text επιλέξτε µία ρύθµιση στοίχισης για το κείµενο. 

 

8. Στην ενότητα Size καθορίστε το µέγεθος για το πλαίσιο κυλιόµενου κειµένου. 

 

9. Εάν θέλετε το κυλιόµενο κείµενο να επαναλαµβάνεται συνεχώς, µαρκάρετε το πλαίσιο ελέγχου 

Continuously. 

 

10. Επιλέξτε ένα χρώµα φόντου από την αναδιπλούµενη λίστα Background Color.   

 

Στο σηµείο αυτό, µπορείτε να κάνετε κλικ στην καρτέλα Preview για να δείτε το κυλιόµενο πλαίσιο στην 

πράξη. Εάν θέλετε να προσαρµόσετε οποιαδήποτε από τις ιδιότητες του πλαισίου κυλιόµενου κειµένου, κάντε 

κλικ µε το δεξιό πλήκτρο του ποντικιού πάνω του, επιλέξτε την εντολή Marquee Properties και κατόπιν κάντε 

τις επιθυµητές αλλαγές στο παράθυρο διαλόγου ιδιοτήτων (Properties) αυτού του συστατικού. 

 

Ενσωµάτωση µιας Ιστοσελίδας Μέσα σε µία Άλλη Ιστοσελίδα 
 

Το συστατικό Include Page (ενσωµάτωση σελίδας) παίρνει το περιεχόµενο µιας ιστοσελίδα και το εµφανίζει 

µέσα σε µία άλλη ιστοσελίδα. Αν και αυτό µπορεί να µην ακούγεται ιδιαίτερα ενδιαφέρον, µπορεί να σας 

γλιτώσει από πολύ κόπο και χρόνο κατά τη συντήρηση µιας τοποθεσίας. Για παράδειγµα, πολλοί επόπτες 

τοποθεσιών του Web θέλουν να έχουν στάνταρ µηχανισµούς πλοήγησης στις ιστοσελίδες τους. Οι µηχανισµοί 

αυτοί µπορεί να είναι κουµπιά, εικονίδια, ή απλό κείµενο διασυνδεδεµένο µε τις σηµαντικές θέσεις της 

τοποθεσίας τους. Αλλά η πληκτρολόγηση του κειµένου, η εισαγωγή των γραφικών και η δηµιουργία των 

συνδέσµων για κάθε ιστοσελίδα µιας τοποθεσίας είναι µία χρονοβόρα διαδικασία, ιδιαίτερα επιρρεπής σε λάθη. 

Ακόµη χειρότερα, εάν αποφασίσετε να αλλάξετε οτιδήποτε, θα πρέπει να φορτώσετε και να τροποποιήσετε 

κάθε σελίδα η οποία περιέχει µηχανισµούς πλοήγησης. 
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Σε µία τέτοια περίπτωση, το συστατικό Include Page µπορεί να σας σώσει. ∆ηµιουργείτε µία ιστοσελίδα η 

οποία περιέχει τη γραµµή εργαλείων πλοήγησης και κατόπιν χρησιµοποιείτε απλώς το συστατικό Include Page 

για να την προσαρτήσετε σε κάθε ιστοσελίδα της τοποθεσίας σας η οποία χρειάζεται τη γραµµή εργαλείων 

πλοήγησης. Οι αλλαγές είναι επίσης πανεύκολες - αλλάζετε απλώς τη µία ιστοσελίδα µε τη γραµµή εργαλείων 

πλοήγησης, υποδεικνύετε το γεγονός ότι την έχετε ενηµερώσει και όλες οι υπόλοιπες ιστοσελίδες θα 

ενηµερωθούν αυτόµατα. 

 

 

Το συστατικό Include Page είναι επίσης χρήσιµο για τα τµήµατα των σελίδων τα οποία αλλάζουν συχνά: οι 

τίτλοι σε ένα ενηµερωτικό δελτίο, τα ορεκτικά στο µενού ενός ρεστοράν, τα προγράµµατα εβδοµαδιαίων 

δραστηριοτήτων, κ.λ.π. 

Ακολουθήστε τα παρακάτω βήµατα για να χρησιµοποιήσετε το συστατικό Include Page: 

 

1. Με ανοικτή τη σελίδα που σας ενδιαφέρει, τοποθετήστε τον δείκτη στο σηµείο στο οποίο θέλετε να 

ενσωµατώσετε µία άλλη σελίδα. 

 

2. Από τη γραµµή των µενού επιλέξτε την εντολή Insert >· Component >· Include Page (ή κάντε κλικ στο 

κουµπί Component της γραµµής εργαλείων), θα εµφανιστεί το παράθυρο διαλόγου Include Page Properties 

(Εικόνα 15.5). 

 

3. Στο πεδίο Page to Include πληκτρολογήστε τη διεύθυνση URL της σελίδας που θέλετε να ενσωµατώσετε. 

Εναλλακτικά, κάντε κλικ στο κουµπί Browse και από τη λίστα αρχείων που εµφανίζεται επιλέξτε το αρχείο της 

επιθυµητής ιστοσελίδας και κατόπιν κάντε κλικ στο ΟΚ. Η διεύθυνση URL της σελίδας που θέλετε να 

ενσωµατώσετε θα πρέπει να εµφανιστεί στο πεδίο Page to Include. 

 

4. Κάντε κλικ στο ΟΚ για να κλείσετε το παράθυρο διαλόγου. 
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EIKONA 15,5 

Το παράθυρο διαλόγου Include Page Properties 

θα επιστρέψετε σε προβολή Σελίδας, µε τα περιεχόµενα της νέας εισαγόµενης σελίδας µέσα στην τρέχουσα 

σελίδα σας. 

 

 

Προγραµµατισµός της Ενσωµάτωσης Σελίδων 
 

 

Ένα ακόµη ενδιαφέρον συστατικό του Frontpage σας επιτρέπει να καθορίσετε ότι οι σελίδες που 

ενσωµατώνετε σε µία ιστοσελίδα θα πρέπει να εµφανίζονται σ' αυτή σύµφωνα µε µία σαφώς καθορισµένη 

ηµεροµηνία έναρξης, ή ηµεροµηνία λήξης, ή και τα δύο.  

Για παράδειγµα, µπορεί να θέλετε να αντικαθιστάτε µία γενικού σκοπού γραµµή εργαλείων πλοήγησης) µε 

µία εξειδικευµένη γραµµή εργαλείων πλοήγησης, κατάλληλη για την µηνιαίας διάρκειας καµπάνια προώθησης 

ενός συγκεκριµένου προϊόντος. Ή, µπορεί να θέλετε να εµφανίζεται ένας διαφορετικός χαιρετισµός στην 

αρχική σας σελίδα ανάλογα µε την ώρα της ηµέρας.  

Οι εργασίες αυτές µπορούν να επιτευχθούν εύκολα µε το συστατικό Scheduled Include Page, το οποίο 

συνδυάζει το πλεονεκτήµατα των συστατικών Include Page και Scheduled Image. Ακολουθήστε το παρακάτω 

βήµατα για να συµπεριλάβετε ένα συστατικό Scheduled Include Page στη σελίδα σας: 

 

 

 

1. Με ανοικτή τη σελίδα που σας ενδιαφέρει, τοποθετήστε τον δείκτη στο σηµείο στο οποίο θέλετε να 

εµφανιστεί το συστατικό Scheduled Include Page. 

 

2. Από τη γραµµή των µενού επιλέξτε την εντολή Insert >- Component >· Scheduled Include Page (ή 

κάντε κλικ στο κουµπί Component της γραµµής εργαλείων), θα εµφανιστεί το παράθυρο διαλόγου Scheduled 

Include Page Properties (Εικόνα 15.6). 

 134



Εισαγωγή στο FrontPage 

 

 

 

 

 

 

ΕΙΚΟΝΑ 15,6 

Το παράθυρο διαλόγου Scheduled Include Page Properties 

 

3. Στο πεδίο During the scheduled time (κατά το προγραµµατισµένο χρονικό διάστηµα) της ενότητας Page 

to Include πληκτρολογήστε τη διεύθυνση URL της σελίδας που θέλετε να εισάγετε. Εναλλακτικά, κάντε κλικ 

στο κουµπί Browse για να εµφανίσετε το παράθυρο διαλόγου Current Web. Στο παράθυρο διαλόγου θα δείτε 

µία λίστα όλων των αρχείων του τρέχοντος ιστού. Επιλέξτε το αρχείο που σας ενδιαφέρει και κάντε κλικ στο 

ΟΚ. Το παράθυρο διαλόγου θα κλείσει και θα επανεµφανιστεί το παράθυρο διαλόγου Scheduled Include Page 
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Properties. H διεύθυνση URL του αρχείου που µόλις επιλέξατε θα αναφέρεται στο πεδίο During the scheduled 

time. 

 

4. Στην περιοχή µε τίτλο Starting καθορίστε την ηµεροµηνία και ώρα κατά την οποία θ' αρχίσει να 

εµφανίζεται η σελίδα που ενσωµατώνετε, επιλέγοντας τις κατάλληλες πληροφορίες από τις αναδιπλούµενες 

λίστες επιλογής έτους, µήνα, ηµέρας και ώρας. 

 

5. Με παρόµοιο τρόπο, στην περιοχή µε τίτλο Ending, καθορίστε την ηµεροµηνία και την ώρα κατά την 

οποία θέλετε να σταµατήσει η εµφάνιση της ενσωµατωµένης σελίδας, επιλέγοντας τις κατάλληλες χρονικές 

πληροφορίες από τις αναδιπλούµενες λίστες επιλογής έτους, µήνα, ηµέρας και ώρας.  

 

6. Τέλος (προαιρετικά) µπορείτε να επιλέξετε µία εναλλακτική σελίδα η οποία θα εµφανίζεται πριν από την 

ηµεροµηνία έναρξης και µετά από την ηµεροµηνία λήξης. (Εάν δεν καθορίσετε µία εναλλακτική σελίδα, δε θα 

εµφανίζεται τίποτα σ αυτή τη θέση αφού παρέλθει ο καθορισµένος χρόνος). Στο πεδίο µε τίτλο Before And 

After The Scheduled Time (Optional), πληκτρολογήστε το όνοµα αρχείου της σελίδας που θέλετε να 

εµφανίζεται στη θέση του συστατικού (ή κάντε κλικ στο κουµπί Browse και διαλέξτε το αρχείο της επιθυµητής 

σελίδας από το παράθυρο διαλόγου που εµφανίζεται), 

 

7. Κάντε κλικ στο ΟΚ. Το παράθυρο διαλόγου θα κλείσει κι εσείς θα επιστρέψετε προβολή σελίδας. Εάν η 

τρέχουσα ηµεροµηνία εµπίπτει µέσα στο προσδιοριζόµενο από εσάς χρονικό διάστηµα, θα δείτε τη σελίδα που 

καθορίσατε στο βήµα 3 παραπάνω ενσωµατωµένη µέσα στην τρέχουσα ανοικτή σελίδα. 

Εάν όχι, η περιοχή στην οποία εισάγατε το συστατικό Scheduled Include Page θα είναι κενή. 

 

Μπορείτε να χρησιµοποιείτε την ίδια διαδικασία για οποιαδήποτε σελίδα η οποία θέλετε να περιλαµβάνεται 

για ένα πεπερασµένο χρονικό διάστηµα µέσα σε µία άλλη ιστοσελίδα. Καλές υποψήφιες γι' αυτή την τεχνική 

είναι οι σελίδες µε αναγγελίες για ένα συµβάν ή µία εκδήλωση, καθώς και οι σελίδες µε διαφηµιστικό υλικό το 

οποίο πρέπει να δηµοσιευτεί για ένα συγκεκριµένο χρονικό διάστηµα. Καθορίστε την ηµεροµηνία λήξης του 

συµβάντος ή του υλικού σας. ∆ε χρειάζεται να καθορίσετε προαιρετική εναλλακτική σελίδα η σελίδα µε την 

αναγγελία θα εξαφανιστεί απλώς τη σωστή χρονική στιγµή. 

 

 
 

Aυτό το -παράρτηµα παρουσιάζει µε συνοπτικό τρόπο τα tags και τις ιδιότητες της γλώσσας HTML. 
Οι πληροφορίες έχουν ταξινοµηθεί" αλφαβητικά για ευκολία αναφοράς. 
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Τags και Ιδιότητες της HTML 

 
Tag Ιδιότητες Περιγραφή 

<!-...-> Σχόλιο της SGML 

<!DOCTYPE> 
 

 
 

∆ηµόσια (public) δήλωση 
 

 HTML PUBLIC... Συµµόρφωση µε DTD 

<Α>... </Α> 
 

∆εσµός (anchor) 
 

 ACCESSKEY= Συντόµευση πληκτρολογίου

 
 

CHARSET= 
 

Κωδικοποίηση χαρακτήρων 
του συνδέσµου 

                                                   CLASS=ID=STYLE=TITLE= 
Κλάση (εις), κωδικός 
ταυτότητας, πληροφορίες 

 
 

COORDS= 
 

Συντεταγµένες αντικειµένου 
του δεσµού 

                                                   DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

 
 

HREF= 
 

∆εσµός υπερκειµένου 

 
 

NAME= 
 

Όνοµα δεσµού 
υπερκειµένου 

 REL= 

0 προορισµός του 
συνδέσµου έχει σχέση 
πατρικού/θυγατρικού µε το 
τρέχον έγγραφο 
 

 
 

REV= 
 

Το τρέχον έγγραφο είναι 
θυγατρικό του 
διασυνδεόµενου πόρου 
 

"rect! circle : poly 

 
 

TABINDEX= 
 

Σειρά του πλήκτρου tab 

 
 

TARGET= 
 

Όνοµα πλαισίου 
προορισµού 
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[events] 
 

Εσωτερικά συµβάντα 
 

<ACRONYM>... </ACRONYM> 
 

Περιεχόµενο ακρωνυµίου 
 

                                                   CLASS=ID=STYLE=TITLE 

Κλάση(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 

                  DIR= LANG= 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

 
 

 [events] 
 

Εσωτερικά συµβάντα 
 

<ADDRESS>... </ADDRESS> 
 

Περιεχόµενο διεύθυνσης 
 

ID= STYLE= TIT

 DIR= LANG 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

  [events] Εσωτερικά συµβάντα 

<APPLET>... </APPLET> 
 

Μίνι-εφαρµογή (applet) της 
Java 

 
 

ALIGN= 
 

Ευθυγράµµιση παραθύρου 
µίνι-εφαρµογής 

 
 

ALT= 
 

Εναλλακτική περιγραφή 
κειµένου 

 
 

CODE= 
 

Όνοµα µίνι-εφαρµογής της 
Java 

 CODEBASE= θέση µίνι-εφαρµογής 

 
 

DOWNLOAD= 
 

Σειρά µεταφοράς 
(download) της | µίνι-
εφαρµογής | 
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<APPLET>... </APPLET> 
 

HEIGHT= 
 

Ύψος αντικειµένου 
 

 
 

HSPACE= 
 

Οριζόντιο διάστηµα 
 

 
 

NAME= 
 

Όνοµα µίνι-εφαρµογής 
 

 
 

VSPACE= 
 

Κατακόρυφο διάστηµα 
 

 
 

WIDTH = 
 

Πλάτος αντικειµένου 
 

<AREA> 
 

 
 

Περιοχή περιγραφής image 
map εικόνας που λειτουργεί 
στην πλευρά του client 
συστήµατος 
 

 
 

ALT= 
 

Εναλλακτική περιγραφή 
κειµένου 
 

 
 

COORDS= 
 

Συντεταγµένες 
 

 
 

HREF= 
 

Σύνδεσµος υπερκειµένου 

 
 

NOHREF 
 

Απουσία συνδέσµου 
υπερκειµένου 

 
 

SHAPE="rect: circle ; poly ; 
default" 
 

Σχήµα περιγραφόµενης 
περιοχής 

 
 

TABINDEX= 
 

Σειρά του πλήκτρου tab 

 
 

TARGET= 
 

Όνοµα πλαισίου προορισµού 
 

 
 

[events] 
 

Εσωτερικά συµβάντα 
 

<B>... </B> 
 

Κείµενο µε έντονη γραφή 
 

 
 

CLASS=ID=SIYLE=TITLE= 
 

Κλάοη(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
 

 
 

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσαο 
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[events] 
 

Εσωτερικά συµβάντα 
 

<BASE> 
 

 
 

URL βάσης 
 

 
 

HREF= 
 

Σύνδεσµος υπερκειµένου 
 

 
 

TARGET= 
 

Όνοµα πλαισίου προορισµού 
 

 
<CENTER>... </CENTER> 

          
 

CLASS = ID = STYLE = TITLE = 
 
 
DIR= LANG=  
[events] 

 

Κεντράρισµα κειµένου 
Κλάση(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Εσωτερικά συµβάντα 

<CITE>... </CITE> 
          

 
 
CLASS = ID = STYLE = TITLE = 
 
 
DIR= LANG= 
[events] 

Περιεχόµενο 
περικοπής 
Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Εσωτερικά συµβάντα 

 

<CODE>... </CODE>  
          

 
 
 
 
CLASS=ID=STYLE=TITLE= 
 
DIR= LANG= 
 [events] 

Μορφοποίηση 
περιεχοµένου σαν 
κώδικα γλώσσας 
προγραµµατισµού 
Κλάση (εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος  
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Εσωτερικά συµβάντα 
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<COL>... </COL>  
 

 
ALIGN= 
CLASS=ID=STYLE=TITLE= 
 
 
DIR=  LANG= SPAN= 
 
VALIGN= 
WIDTH = 
[events] 

Στήλη 
Στοίχιση στήλης 
Κλάση(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
 ∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Αριθµός στηλών 
Κατακόρυφη στοίχιση 
Πλάτος στήλης 
Εσωτερικά συµβάντα

<COLGROUP> 
          

 
ALIGN =  
CLASS=ID=STYLE=TITLE= 
 
 
SPAN= 
VALIGN=  
WIDTH= 

Οµάδα στηλών  
Στοίχιση οµάδας 
στηλών Κλάση(εις), 
κωδικός ταυτότητας, 
πληροφορίες στυλ, 
τίτλος  
Πλήθος στηλών 
Κατακόρυφη στοίχιση 
Πλάτος οµάδας στηλών
 

<DD>  
         

 
ALIGN = 
CLASS=ID=STYLE=TITLE= 
 
DIR= LANG= 
 
[events] 

 

∆εδοµένα ενός ορισµού 
Στοίχιση δεδοµένων 
Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
 ∆ιεύθυνση κειµένου 
και κωδικός γλώσσα ο 
Εσωτερικά συµβάντα 
 

 

 
 

DIR= LANG= 
 
[events] 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
Εσωτερικά συµβάντα 
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:DFN>...<DFN> 
 

 

CLASS=ID=STYLE=TITLE= 
 
 
DIR= LANG=  
 
[events] 
 

Περιεχόµεν
ο ορισµού 
Κλάοη(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 
 

DIR>... <DIR> 
 

 
CLASS= ID= STYLE= TITLE= 
 
 
COMPACT = 
 
DIR= LANG= 
  
 
 
[events] 
 

Λίστα καταλόγου 
Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
Συµπαγής 
αναπαράσταση λίστας  
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 
 

DIV> 
 

 
ALIGN = 
 
CLASS= ID= STYLE= TITLE= 
 
 
DIR= LANG=  
[events] 
 

Υποδιαίρεση εγγράφου 
Στοίχιση ενότητας 
κειµένου 
 Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
Εσωτερικά συµβάντα 
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DL>... </DL> 
 

ALIGN =  
 
CLASS= ID= STYLE= TITLE= 
 
 
CLEAR= COMPACT DIR=  
 
LANG= 
 
 [events] 
 

Λίστα ορισµών Στοίχιση 
λίστας 
Κλάση (εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
Απαλοιφή λίστας 
Συµπαγής 
αναπαράσταση λίστας 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Εσωτερικά συµβάντα 
 

:)T> 
 

ALIGN = 
 
 
 CLASS= ID= STYLE= TITLE= 
 
DIR=LANG= 
 
 [events] 
 

Όρος που αντιστοιχεί 
στον ορισµό Στοίχιση 
όρου 
Κλάση (εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Εσωτερικά συµβάντα 
 

;M>...</EM> 
 

 
CLASS=1D=STYLE=TITLE= 
 
 
DIR= LANG=  
[events] 
 

Κείµενο µε έµφαση 
Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Εσωτερικά συµβάντα 
 

iMBED>... </EMBED> 
 

 
 
ALIGN =  
 
HEIGHT=  
HIDDEN=  
PALETTE= 
 

Ενσωµατωµένο 
αντικείµενο 
Στοίχιση/ευθυγράµµιση 
αντικειµένου  
Ύψος αντικειµένου  
Απόκρυψη 
αντικειµένου  
Ορισµός παλέτας 
χρωµάτων 
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SRG= 
 

θέση προέλευσης 
αντικειµένου 
 

 
 

WIDTH = 
 

Πλάτος αντικειµένου 
 

 
 

[events] Εσωτερικά συµβάντα 

<FIELDSET>... </FIELDSET> 
 

Οµάδα πεδίων φόρµας 

 
 

CLASS= ID= STYLE= TITLE= 
 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 

 
 

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

 
 

[events] Εσωτερικά συµβάντα 

<FONT>...</FONT> 
 

Γραµµατοσειρά 

 
 

COLOR= Χρώµα 
γραµµατοσειράς 

 
 

FACE= 
 

Οικογένεια 
χαρακτήρων 
γραµµατοσειράς 

 
 

SIZE= 
 

Μέγεθος 
γραµµατοσειράς 

<FORM>...</FORM> 
 

Φόρµα 

 
 

ACCEPT-CHARSET= 
 

Λίστα 
υποστηριζόµενων σετ 
χαρακτήρων 

 
 

ACTION = 
 

Ρουτίνα χειρισµού 
φόρµας η οποία τρέχει 
στην πλευρά του 
διακοµιστή 
 

 
 

CLASS=ID=STYLE=TITLE= 
 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
 

 DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

 
 

ENCTYPE= 
 

Τύπος 
κρυπτογράφησης 
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METHOD="get [ post" 
 

Μέθοδος αποστολής 
των δεδοµένων της 
φόρµας στον 
διακοµιστή 

 
 

NAME= Όνοµα φόρµας 

 TARGET= Όνοµα πλαισίου 
προορισµού 

 
[events] onsubmit, onreset Εσωτερικά συµβάντα 

<FRAME>... </FRAME> 
 

Πλαίσιο µέσα σε οµάδα 
πλαισίων 

 
 

BORDERCOLOR= Χρώµα περιγράµµατος 

 
 

FRAMEBORDER= Πάχος περιγράµµατος 

 
 

HEIGHT= 
 

Ύψος πλαισίου 
 

 
 

MARGINHEIGHT= Ύψος περιθωρίου 

 MARGINWIDTH= Πλάτος περιθωρίου 

 
 

NAME= 
 

Όνοµα πλαισίου 
 

 
 

NORESIZE 
 

Απαγορεύεται η αλλαγή 
µεγέθους 
 

 
 

SCROLLING ="yes ; no ! auto" 
 

Ενεργοποίηση/απενεργο
ποίηση γραµµών 
κύλισης 

 
 

SRC= 
 

Προέλευση 
περιεχοµένου του 
πλαισίου 
 

 
 

WIDTH = 
 

Πλάτος πλαισίου 
 

<FRAMESET>... </FRAMESET> 
 

Οµάδα πλαισίων 
 

 
 

BORDER= 
 

Μέγεθος 
περιγράµµατος 

 
 

BORDERCOLOR= 
 

Χρώµα περιγράµµατος 
 

 
 

COLS= 
 

Πλήθος στηλών 
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FRAMEBORDER= 
 

Πάχος περιγράµµατος 
 

 
 

FRAMESPACING= 
 

∆ιάστηµα µεταξύ 
πλαισίων 

 

 
 

ROWS= 
 

Πλήθος γραµµών 
 

 
 

[events] onload, onunload Εσωτερικά συµβάντα 

<HEAD>... </HEAD> 
 

Επικεφαλίδα εγγράφου 

 
 

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
 

 
 

PROFILE= 
 

URL διεύθυνση meta-
δεδοµένων 

<H1>...</H1> 
 

Heading 1 (επικεφαλίδα 
1) 
 

 
 

ALIGN= 
 

Στοίχιση επικεφαλίδας 
 

 
 

CLASS= ID= STYLE= TITLE= 
 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 

 
 

CLEAR= 
 

Οριστικοποίηση 
κειµένου δίπλα ή κάτω 
από εικόνα 

 
 

COLOR= Χρώµα κειµένου 

 
 

DINGBAT= 
 

Προσθήκη 
προσδιοριζόµενου 
χαρακτήρα συµβόλου 
(dingbat) 
 

 
 

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
 

<H2>,<H3>,<H4>, <H5>, 
<H6> 

Όµοια µε το <1-11> 
 

Επίπεδα επικεφαλίδων 
2 έως 6 

<HR> 
 

 
 

Οριζόντια γραµµή 
(γραφικό) 
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ALIGN = 
 

Ευθυγράµµιση γραµµής 
(γραφικού) 

 
 

CLASS= ID= STYLE= TITLE= 
 

Κλάοη(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 

 
 

CLEAR= 
 

Οριστικοποίηση δίπλα 
ή κάτω από εικόνα 

 
 

COLOR= Χρώµα γραµµής 

 
 

NOSHADE= 
 

Απαγορεύεται η σκίαση 
στη γραµµή 

 
 

NOWRAP 
 

Απαγορεύεται η 
αναδίπλωση της 
γραµµής 

 
 

SIZE= Ύψος γραµµής 

 
 

WIDTH = Πάχος γραµµής 

 
 

[events] Εσωτερικά συµβάντα 

<HTML>... </HTML> 
 

Περικλείει ολόκληρο το 
έγγραφο 

 
 

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
 

 
 

VERSION= 
 

Η στάνταρ 
χρησιµοποιούµενη 
έκδοση της HTML 
 

 

 
<ILAYER>...</ILAYER> 

 
(όµοιο µε το tag LAYER) 

 

 
Τοποθέτηση ένθετου επιπέδου 
(συµπεριφέρεται όµοια µε τα 
στοιχεία κειµένου) 

 

 
 <IMG> 
 

 
ALIGN= 
ALT= 
 
BORDER= 
 
CLASS=ID=STYLE=TITLE= 

 

Εικόνα 
Ευθυγράµµιση εικόνας 
Εναλλακτική περιγραφή 
κειµένου 
 Μέγεθος περιγράµµατος 
εικόνας 
 Κλάση(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
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DIR= LANG= 

 
DYNSRC= 
HEIGHT= 
HSPACE= 
ISMAP 

 

LOOP= 
LOWSRC= 
NAME= 
SRC= 
USEMAP= 

 

VSPACE= WIDTH =  

[events] 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
∆υναµική προέλευση 
Ύψος εικόνας Οριζόντιο 
διάστηµα 
Image map εικόνες που 
λειτουργούν στην πλευρά 
του διακοµιστή 
Πλήθος επαναλήψεων 
θέση εικόνας χαµηλής 
ανάλυσης 
 Όνοµα εικόνας 
θέση προέλευσης εικόνας 
Image map εικόνα που 
λειτουργεί στην πλευρά 
του συστήµατος-πελάτη 
Κατακόρυφο διάστηµα 
Πλάτος εικόνας 
Εσωτερικά συµβάντα 
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<INPUT>... </INPUT> 

 

 ACCEPT= 
 
 ALT= 
  
 CHECKED 

 

CLASS=ID=STYLE=TITLE= 
 
DIR= LANG=  
 
DISABLED 
 
 
 
ΜΑΧ= 

    

   MAXLENGTH= 
ΝΑΜΕ= 
SIZE= 
SRC= 
TABINDEX= 
TYPE=" button ! checkbox ! file 
] hidden ! image! password 
! radio ! reset! submit! text" 
USEMAP= 

 

VALUE= 
 
[events] onfocus, onblur, onselect, 
onchange 
 

Είσοδος δεδοµένων σε 
φόρµα  
Αποδοχή εισόδου 
δεδοµένων  
Εναλλακτική περιγραφή 
κειµένου 
Φόρτωση εξαρχής 
µαρκαρισµένων πλαισίων 
ελέγχου 

Κλάση(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Απενεργοποίηση εισόδου 
δεδοµένων 

Μέγιστο επιτρεπόµενο 
πλήθος εισαγόµενων 
χαρακτήρων 
 
Μέγιστο µήκος πεδίου 
Όνοµα φόρµας  
Μέγεθος πεδίου θέση 
προστιθέµενων εικόνων 
Σειρά του πλήκτρου tab 
Μέθοδος εισόδου 
δεδοµένων (τύπος µη-
χανισµού) 
Image map εικόνα που 
λειτουργεί στην πλευρά 
του συστήµατος-πελάτη 
Ορισµός προεπιλεγµένης 
τιµής  
 
Εσωτερικά συµβάντα 
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<INS>...</INS>  
 
CITE=  
  
 
 

   CLASS= ID= STYLE= TITLE= 
DATETIME= 
 

    DIR= LANG=  
    
     [events] 

Παρεµβαλλόµενο 
κείµενο 
 Αλλαγή 
δεδοµένων 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
Αλλαγή ηµεροµηνίας 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Εσωτερικά συµβάντα 

 
<ISINDEX> 

 
 
 
 

 
ACTION=  
 
CLASS=ID=STYLE=TITLE= 
 
 
 
DIR= LANG= 
 
PROMPT= 

To έγγραφο είναι ένα 
ευρετήριο µε δυνα-
τότητα διεξαγωγής 
αναζητήσεων - παρω-
χηµένη µορφή, 
χρησιµοποιήστε αντ' 
αυτής το tag < FORM 
>  
 
∆ιεύθυνση URL 
 
Κλάση(εις), κωδικός 
ταυτότητος, πληρο-
φορίες στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Κείµενο προτροπής 

 
<KBD>... </KBD> 

 
 
 
 

CLASS=ID=STYLE=TITLE= 
 
 
DIR= LANG= 
 
 
 [events] 

Μορφή εισαγωγής 
 δεδοµένων από το 
 πληκτρολόγιο 
 
Κλάοη(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<KEYGEN>...</KEYGEN> 

 
 
 
 
ΝΑΜΕ= 
 
CHALLENGE= 

Κλειδί ασφάλειας 
παραγόµενο από φόρµα 
 
Απαιτούµενο 
 
Αλφαριθµητικό  
"πρόκλησης" δηµόσιου 
κλειδιού 
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<LABEL>... </LABEL> 

 
 
ACCESSKEY= 
 
 
CLASS= ID= STYLE= TITLE= 
 

Ετικέτα πεδίου φόρµας 

 Πλήκτρο συντόµευσης 

Κλάοη(εις), κωδικός 
ταυτότητας, πληρο-
φορίες         στυλ, τίτλος

 
<LEGEND> 

 
 
 
 
ACCESSKEY= 
 
ALIGN = 
 
 
CLASS= ID= STYLE= TITLE= 
 
 
DIR= LANG=  
 
 
[events] 

Υπόµνηµα οµάδας πεδίων 
φόρµας 
 
Πλήκτρο συντόµευσης  
 
Ευθυγράµµιση 
υποµνήµατος 
 
Κλάση(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<L1>... </LI> 

 
 
 
ALIGN=  
 
 
CLASS= ID= STYLE= TITLE= 

 

 DIR= LANG= TYPE= 
 
 
 
VALUE="number"  
 
 
[events] 

Στοιχείο (καταχώριση) 
λίστας 
 
 Ευθυγράµµιση 
στοιχείων λίστας  
 
Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας Στυλ 
αρίθµησης ή κουκκίδας  
 
Επανεκκίνηση της 
αρίθµησης 
 
 Εσωτερικά συµβάντα 
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<ΜΑΡ>... </ΜΑΡ>  

 CLASS= ID= STYLE= TITLE= 
 
 
 
NAME= 

Image map εικόνα που 
λειτουργεί στην πλευρά 
του συστήµατος-πελάτη  
 
Κλάοη(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος  
 
Όνοµα image map 
εικόνας 

 
 
 
 

 
<MENU>... </MENU> 
 

 
 

  COMPACT 

  

 

CLASS= ID= STYLE= TITLE= 

 
 
 
DIR= LANG= 
 

Λίστα µενού  
 
Συµπαγής αναπαράσταση 
λίστας  
 
Κλάση (εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
 
 ∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<ΜΕΤΑ> 

 
 

 
 
CONTENT=  
 
DIR= LANG= 
 
HTTP-EQUIV=  
 
NAME=  
 
TITLE = URL= 
 

Meta-δεδοµένα  
 
Περιγραφή περιεχοµένου 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
Απάντηση του 
διακοµιστή  
 
Όνοµα εγγράφου  
 
Τίτλος εγγράφου URL 
διεύθυνση εγγράφου

<NOBR>... </NOBR> 
 

 
 

Απαγορεύει τον 
διαχωρισµό γραµµών 

<NOEMBED> 
 

 
 

Απαγορεύει την 
ενσωµάτωση 

έ
<NOFRAMES>... </NOFRAMES> 
 

Απαγορεύει εναλλακτικές 
λύσεις για τα πλαίσια 
στον κορµό του εγγράφου
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<NOLAYER>... </NOLAYER> 
 

Απαγορεύει τα επίπεδα 
 

<NOSCRIPT>... </NOSCRIPT> Μη-script δεδοµένα 

<OBJECT>... </OBJECT> 
 

 
 
ALIGN =  
 
 
BORDER= 

Αντικείµενο  
 
Ευθυγράµµιση 
αντικειµένου 
 
 Πάχος περιγράµµατος 

 
 

<PARAM>... </PARAM> 
 

Παράµετρος 

NAME= Όνοµα παραµέτρου 

TYPE= 
 

Τύπος µέσου του 
Internet 

VALUE= 
 

Ορισµός τιµής 

VALUETYPE= 
 

∆ιερµήνευση τιµής 

<PRE>... </PRE> 
 

Προ-µορφοποιηµένο 
κείµενο 

Q>... </Q> Ένθετο απόσπασµα 
CLASS=ID=STYLE=TITLE= 
 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

[events] Εσωτερικά συµβάντα 

<S>... </S> 
 

Κείµενο µε διακριτή 
διαγραφή 

CLASS=ID=S7YLE=TITLE= 
 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

[events] Εσωτερικά συµβάντα 

<SAMP>... <SAMP> 
 

Μορφοποίηση κειµένου 
σαν "δείγµα" 

CLASS= 10= STYLE= TITLE= 
 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
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DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

[events] Εσωτερικά συµβάντα 

<SCRIPT>... </SCRIPT> ∆εδοµένα script 

LANGUAGE= Γλώσσα script 

SRC= 
 

∆ιεύθυνση URL της 
προέλευσης του script 

TYPE= 
 

Τύπος περιεχοµένου του 
Internet 

[events] Εσωτερικά συµβάντα
<SELECT>... </SELECT> 
 

Λίστα επιλογών σε 
φόρµα 

ALIGN = 
 

Ευθυγράµµιση λίστας 
 

CLASS= ID= STYLE= TITLE= 
 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος

DIR= LANG= 
 

∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 

DISABLED 
 

Απενεργοποίηση λίστας 

HEIGHT= Ύψος αντικειµένου 

NAME= Όνοµα αντικειµένου 

SIZE= Μέγεθος αντικειµένου Η

TABINDEX= Σειρά του πλήκτρου tab 
ΒWIDTH = 

 
Πλάτος αντικειµένου 

[events] onfocus, onblur, onselect, 
onchange 

Εσωτερικά συµβάντα 
 

 
<SMALL>... </SMALL> 

 
 
CLASS=ID=STYLE=TITLE= 
 
 
 
DIR= LANG=  
 
 
[events] 

Μικρό κείµενο 
 
Κλάση (εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 
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<SPAN>... </SPAN> 

 
 
 
ALIGN=  
 
 
CLASS=ID=STYLE= TITLE = 
 
 
DIR= LANG=  
 
 
[events] 

Γενικευµένος 
µηχανισµός ο οποίος 
µπορεί να περιέχει 
κείµενο 
Ευθυγράµµιση του 
µηχανισµού 
 
Κλάση (εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<STRIKE>... </STRIKE> 

 
 
 
 
CLASS= ID= STYLE= TITLE= 
 
 
 
DIR= LANG=  
 
 
[events] 

Κείµενο µε διακριτή 
διαγραφή  
 
Κλάση(εις), κωδικός 
ταυτότητος, πληρο-
φορίες στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<STRONG>...</STRONG> 

 
 
 
CLASS= ID= STYLE= TITLE= 
 
 
DIR= LANG=  
 
 
 
[events] 

Κείµενο µε µορφοποίηση 
"ισχυρής έµφασης" 

Κλάση(εις), κωδικός 
ταυτότητας, πληρο-
φορίες στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<STYLE>... </STYLE> 

 
 
DIR= LANG= 
 
 
MEDIA= 
 
 
TYPE= 

Ορισµός φύλλου στυλ 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας 
 
Λίστα υποστηριζόµενων 
µέσων 
 
Τύπος περιεχοµένου του 
Internet 
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<SUB>...</SUB> 

 

CLASS= ID= STYLE= TITLE= 
 
 
DIR= LANG=  
 
 
[events] 

Κείµενο σε µορφή δείκτη  
 
Κλάση (εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<SUP>... </SUP> 

 
 
CLASS= ID= STYLE= TITLE= 
 
 
DIR= LANG=  
 
 
 
[events] 

Κείµενο σε µορφή εκθέτη  
 
Κλάοη(εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Εσωτερικά συµβάντα 

 
<ΤΑΒ> 

 
 
ALIGN= 
 
INDENT= 

Τιµή στηλοθέτη 
 
 Στοίχιση στηλοθέτη 

 
<TFOOT>... </TFOOT> 

 
 
 
ALIGN = 
 
BGCOLOR= 
 
CLASS= ID= STYLE= TITLE= 
 

      DIR= LANG= 

 
VALIGN= 
 
[events] 

Υποσέλιδο πίνακα  
 
Στοίχιση υποσέλιδου 
 
Χρώµα φόντου 
 

Κλάση (εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Κατακόρυφη στοίχιση  
 
Εσωτερικά συµβάντα 
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<ΤΗ>... </ΤΗ> 

 
 
ALIGN= 
 
AXIS= 
 
AXES= 
 
BACKGROUND= 
 
BGCOLOR= 
 
BORDERCOLOR= 
 
BORDERCOLORDARK= 
 
 
BORDERCOLORLIGHT= 
 
CLASS = ID= STYLE = TITLE = 
 

COLSPAN= 

 
DIR= LANG= 
 
HEIGHT= 
 
 
NOWRAP 
 
 
ROWSPAN= 
 
VALIGN= 

Επικεφαλίδα κελιού 
πίνακα 

Στοίχιση επικεφαλίδας 
Συντοµευµένο όνοµα 
κελιού 
 
Τιµές AXIS 
 
θέση εικόνας φόντου 
 
Χρώµα φόντου 
 
Χρώµα περιγράµµατος 
 
Σκούρο χρώµα για 
τρισδιάστατο περίγραµµα 
 
Φωτεινό χρώµα για 
τρισδιάστατο περίγραµµα 
 
Κλάση (εις), κωδικός 
ταυτότητας, πληροφορίες 
στυλ, τίτλος 
 
Πλήθος στηλών 
 
∆ιεύθυνση κειµένου και 
κωδικός γλώσσας  
 
Ύψος κελιού πίνακα 
 
Απαγορεύεται η 
αναδίπλωση κειµένου 
Πλήθος γραµµών  
 
Πλήθος γραµµών 
 
Κατακόρυφη στοίχιση 
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ΠΕΡΙΕΧΟΜΕΝΑ 

 

1. Εισαγωγή 

 

1.1    Τι Μπορείτε και Τι ∆εν Μπορείτε να Κάνετε Κατά τη Σχεδίαση Ιστοσελίδων 

1.2       Σύντοµη Ξενάγηση σε Επιτυχηµένες Ιστοσελίδες 

 

2. Εισαγωγή στο FrontPage 

 

2.1             Τα Βασικά των Ιστοσελίδων 

2.2    Τι Είναι το Frontpage; 

2.3    Ένα Εργαλείο ∆ηµιουργίας Τοποθεσιών στο Web 

2.4    To Frontpage Ευνοεί τη Συνεργασία 

2.5    Εισαγωγή στη ∆ηµιουργία Ιστοσελίδων µε το Frontpage 

2.6    Εκκίνηση του Frontpage 

2.7    ∆ηµιουργία Τοποθεσίας µε Πρότυπα 

2.8    ∆ηµιουργία Τοποθεσίας µε Οδηγούς 

2.9    ∆ηµιουργία Νέας Σελίδας "Έκτου Μηδενός" 

2.10   Εισαγωγή Υπάρχουσας Τοποθεσίας στο Frontpage 

2.11   Οι Προβολές του Frontpage 

2.12   Η Προβολή Σελίδας 

2.13   Η Προβολή Φακέλων 

2.14   Η Προβολή Αναφορών 

2.15   Η Προβολή Πλοήγησης 

2.16   Προβολή ∆εσµών Υπερκειµένου 

2.17   Η Προβολή Εργασιών 

2.18   Προσθήκη Σελίδων σε έναν Ιστό του Frontpage 

2.19   ∆ηµιουργία Νέας Ιστοσελίδας 

2.20   Εισαγωγή Υπαρχουσών Ιστοσελίδων 

2.21   Άνοιγµα Υπάρχοντος Ιστού του Frontpage 

2.22   ∆ιαγραφή ενός Ιστού του Frontpage 

2.23   Έξοδος από το FrontPage 
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3. Προβολή Σελίδας 

 
3.1 Ξεκινώντας 

3.2 ∆ηµιουργία Νέας Σελίδας στην Προβολή Σελίδας 

3.3 Άνοιγµα Ιστοσελίδας σε Προβολή Σελίδας 

3.4  Εάν η Σελίδα Ανήκει στον Τρέχοντα Ιστό του Frontpage... 

3.5 Εάν η Σελίδα Είναι Αποθηκευµένη στον Υπολογιστή ή στο Τοπικό ∆ίκτυο σας..  

3.6 Εισαγωγή στις Ιδιότητες 

3.7 Τα Εργαλεία Επεξεργασίας Κειµένου 

3.8 Μετακίνηση Κειµένου σε ∆ιαφορετικές θέσεις της Σελίδας 

3.9 Έλεγχος Ορθογραφίας 

3.10Χρησιµοποιώντας τον θησαυρό Λέξεων  

3.11Εύρεση Κειµένου 

3.12Αντικατάσταση Κειµένου 

3.13Αποθήκευση Σελίδων 

3.14Αποθήκευση Σελίδας στον Τρέχοντα Ιστό του Frontpage 

3.15Αποθήκευση Σελίδας σαν Αρχείο 

3.16Αποθήκευση Ιστοσελίδας σαν Πρότυπο 

3.17Προεπισκόπηση Σελίδας 

3.18Προεπισκόπηση Σελίδας µε την Καρτέλα Preview 

3.19Εξέταση Σελίδας µε µία Εφαρµογή Browser 

 

 

4. ∆ηµιουργία Σελίδων 
 

4.1 Άνοιγµα Υπάρχουσας Ιστοσελίδας 

4.2 ∆ηµιουργία Νέας Σελίδας 

4.3 Εξέταση του HTML Κώδικα που Κρύβεται Πίσω από τη Σελίδα σας 

4.4 Προσθήκη Κειµένου σε µία Σελίδα 

4.5 Παράγραφοι Κειµένου 

4.6 Εισαγωγή Αλλαγών Παραγράφων 
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4.7 Χρήση Ειδικών Χαρακτήρων 

4.8 ∆ουλεύοντας µε Εικόνες 

4.9 H Συλλογή Έτοιµων Εικόνων Clip Art του Frontpage 

4.10Εισαγωγή Εικόνων σε Έναν Ιστό του Frontpage 

4.11Τοποθέτηση Εικόνων σε Ιστοσελίδες 

4.12Χρήση Ειδικών Εικόνων στο Φόντο 

4.13Επιλογή Χρώµατος Φόντου 

4.14Eπιλογή Εικόνας Φόντου 

4.15Προσθήκη Συνδέσµων (∆εσµών Υπερκειµένου) 

4.16∆ιασύνδεση µε µία Σελίδα του Τρέχοντος Ιστού του Frontpage 

 

 

5. Πολυµέσα 
 

5.1 Χρήση Εικόνας Βίντεο σε Ιστούς του Frontpage 

5.2 Μορφές Αρχείων Βίντεο 

5.3 Τοποθέτηση Εικόνας Βίντεο σε µία Ιστοσελίδα 

5.4 Ενσωµάτωση Εικόνας Βίντεο για Αναπαραγωγή µέσω του Internet Explorer και του Netscape 

Navigator 

5.5 Ενσωµάτωση Βίντεο για Αναπαραγωγή Μόνο Μέσω του Internet Explorer 

5.6 ∆ιασύνδεση µε ένα Αρχείο Βίντεο 

5.7 Χρήση Ήχου και Μουσικής σε Ιστούς του Frontpage 

5.8 Μορφές Αρχείων Ήχου 

5.9 Χρήση Ήχων σε µία Ιστοσελίδα 

5.10Επιλογή Ήχου Παρασκηνίου για Χρήστες του Internet Explorer και του Netscape Navigator 

5.11Επιλογή Ήχου Παρασκηνίου Μόνο για τους Χρήστες του Internet Explorer 

 

 

6.  Πίνακες 

 

6.1 Τι Είναι οι Πίνακες; 

6.2 ∆ηµιουργία Ενός Απλού Πίνακα 

6.3 Ο Πρώτος Τρόπος ∆ηµιουργίας Πίνακα 

6.4 Ένας ∆εύτερος Τρόπος ∆ηµιουργίας Πίνακα 

6.5 Τοποθέτηση Κειµένου και Εικόνων στα Κελιά ενός Πίνακα 
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6.6 Ευθυγράµµιση Κειµένου και Εικόνων στα Κελιά ενός Πίνακα 

6.7 Προσθήκη Μεµονωµένων Κελιών σε Έναν Πίνακα 

6.8 ∆ιαίρεση Κελιών 

 

 

7.   Πλαίσια 
 

7.1 Πώς Λειτουργούν τα Πλαίσια; 

7.2 Οι Καλύτερες Χρήσεις των Πλαισίων 

7.3 ∆ηµιουργία Σελίδων Πλαισίων από Ένα Πρότυπο 

7.4 Επεξεργασία Πλαισίων και Σελίδων Πλαισίων 

7.5 Αντιστοίχιση µιας Σελίδας σε ένα Πλαίσιο 

7.6 Αντιστοίχηση Νέας Σελίδας σε ένα Πλαίσιο               

7.7 Αποθήκευση ενός Συνόλου Πλαισίων 

7.8 Τροποποίηση Σελίδων µέσα στη Σελίδα Πλαισίων 

7.9 Προσαρµογή των Ιδιοτήτων των Πλαισίων 

7.10Επιλογές για την Αλλαγή του Μεγέθους 

7.11Γραµµές Κύλισης 

7.12Περιθώρια Πλαισίων 

7.13Το Παράθυρο ∆ιαλόγου Frame Properties 

7.14Προεπιλεγµένες Ρυθµίσεις Προορισµών 

 

 

8.   Ειδικά Εφέ 
 
8.1 ∆ηµιουργία Μεταβαλλόµενων Κουµπιών 

8.2 Προσθήκη Πλαισίων Κυλιόµενου Κειµένου 

8.3 Ενσωµάτωση µιας Ιστοσελίδας Μέσα σε µία Άλλη Ιστοσελίδα 

8.4 Προγραµµατισµός της Ενσωµάτωσης Σελίδων 
 

9.   HTML 
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